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Greetings!

Welcome to the amazing world of FoxPro. In your
hands is one of the best database management
system we’ve ever created for the personal
computer!
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Greetings!

Greetings!

G1-2

This book teaches you how to access the major features of FoxPro.
In-depth explanations of the features are provided throughout the
FoxPro documentation set.

Your first step is to install FoxPro. Installation instructions are located
in the Installing FoxPro chapter of the FoxPro Installation and Con-
figuration manual.

Using this manual, you will learn to create your own database, change
it, retrieve information from it, combine that information in new ways,
report on your data and design custom input screens — all with ease.
You will also learn to create your own applications.

The Quick Tour chapter in this manual showcases FoxPro’s features.
During this tour, you will see many of FoxPro’s tools for creating and
manipulating data, and for quickly finding the information you need.

The Groundwork chapter begins a tutorial, which is designed for new
FoxPro users as well as experienced users who want an introduction to
the amazing new features of FoxPro.

The tutorial is divided, by chapter, into several short sessions. Each
session focuses on one major topic and leads you through it step-by-step.
The tutorial is designed to be easy to follow and, as you gain expertise,
to act as a reference guide.

As you use FoxPro, remember these pointers:

¢ The context-sensitive online help system is at your fingertips — just
press F1. Online help contains the most current information about
FoxPro.

e If you have any problems, refer to the Product Support chapter in the
FoxPro Installation and Configuration manual.

Introduction
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Taking a Quick Tour

Take a look at the features that make FoxPro one
of the most useful software packages.

® Interface . . .............. page 2

® Browse Window . . ... ... .... page 4

®* RQBEWindow. ... ......... page 6

® ReportWriter . .. ... ....... page 8

® ScreenBuilder. . .......... page 10

® MenuBuilder . ........... page 11

® TextEditor . . . ........... page 12

® Trace and Debug Windows . . . . . page 13

® ProjectManager . . ... ... ... page 14

® WrappingltUp . .......... page 15

Quick Tour G2-1



Interface

— |J8W Edit Database Record Program Windou
Neu. ..
Open. . .
Close
Open:
Menu System Save
Save as... .. Drive
Revert [GOODIES]
[TUTORIAL]
Printer Setup... FOXHELP. DBF
Print... FOXUSER. DBF Directory
INSTALL. DBF
_— Quit
« Open »

[ 1 All Files < New >

Dialog —— e Come

Welcome to a quick tour of FoxPro! During this tour you will see
many of FoxPro’s tools for managing your data. The tools help
you easily create and manipulate your data, and quickly extract
useful information.

Explanations of the features shown in the Quick Tour are
provided throughout the FoxPro documentation.

You can communicate with FoxPro using a mouse or the keyboard,
whichever you prefer. You tell FoxPro what to do by selecting
items from the menu system. More specific information is com-
municated to FoxPro via dialogs that may contain check boxes,
lists, popups, push buttons and radio buttons.

Most actions in FoxPro take place in windows. FoxPro windows
can be opened, closed, moved, resized and scrolled.

G2-2 Quick Tour




System File Edit Database Record Program UWindou

Help for
—a Dialog

« Topics » “ Open File 'l

< Next > | When you choose Open... from the File menu popup, the
Open File dialog appears so you can open existing files.

< Previous > Variations of this dialog appear at other times in the
product when you need to open a file. For example, uhen

< Look Up > | you need to open a report, an Open Report File dialog
appears. The Open File dialog displays all files of a

[ ticular type. File types are categorized by their

Command ensions.
Label Layout
Menu Design

Pro ject [T4PICS] M « Open
Report Layout

ROBE [ 1Al11 Files < Neu > Dial
Screen Design «—1alog

Setup Database Type < Cancel >
Text Editing
N t

Related Topics

Have you ever had a question and no one was around to answer
it? With FoxPro, help is always close at hand.

FoxPro provides help based on what you are doing. For example,
if you ask for help while looking at a dialog, FoxPro tells you all
about that particular dialog. Context-sensitive help is available
for menu options and system windows as well.

FoxPro even provides a handy list of related help topics.
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Records

G2-4

||MI||-I
Wal

56 Robert Watters
175 |Doris Dupuy 28283.99 HR
180 |T Staziola Tounsend 7798.34 MA
248 | John Hodge 182797.63 PA
271 |Houward Schneider 42181.43 PA
281 |Jay Kennedy 568521.98 NY
294 |Tom Caravello 69118.59 NJ
322 |E. Faulkner 160804. 70 SC
328 |Keith Sutherland 34088. 44 NC
353 |Jim Surbrook 27282. FL
360 |Ned Hicks 49292. GA
366 |Robert Angelo 26737. FL

Fall Riuer
Burlington
Hermitage
Allentoun
Neu York
Mahuah
Columbia
Concord
Gainesville
Savanah
Boca Raton

Neno
memo
Memo
Memo
Memo
Memo
Memo
Memo
Memo
Memo
Memo

The Browse window is a wonderful tool for viewing and editing
your data.

The Browse window usually displays your data in a tabular form
called Browse mode. Each row is called a record and each column
is called a field. Don’t worry if you can’t see every field or every
record — it’s easy to scroll the window until you can see the data
you desire.

The fields in a Browse window can be resized and rearranged to
suit your needs. After you get everything where you want it, don’t
be afraid to close the Browse window. FoxPro remembers where
everything was so that when you open the Browse window again,
everything is just as you left it.

Quick Tour



Left Partition Right Partition
in Browse Mode in Change Mode

- Janet A. McCarthy w Notes

Robert Watters City
Doris Dupuy State

T Staziola Tounsend Ytdsales
John Hodge Phone
Howard Schneider Address
Jay Kennedy

Tom Caravello

Y| Browse

Robert Watters 43 24762.85|617/834-4332 Window
Doris Dupuy 1 28203.39|617/679-4871 6

Burlington 617/273-2904

Hermitage . 412/981-7562

Allentoun 2481. 215/432-3822

Q8] 212/246-5348
2

SALESMAN. NOTES

Janet has been salesperson of the month for one consecutive month! IV[eIIIO
Window

The Browse window allows you to view your data in Browse mode
(tabular form) or in Change mode.

The Browse window can also be divided into two partitions. One
partition can show one portion of your data while the other
partition displays another part of your data. The partitions can
even be in different display modes.

The Browse windows above show a special type of field called a
memo field. Memo fields can hold data of any size and type. This
makes memo fields especially well-suited for storing information
that varies in size, such as descriptions, comments, letters,
programs, and even binary data like pictures and digitized sounds.

If your memo field contains text, you can view it in a separate
window while you browse through your data. You can also see the
ASCII representation of pictures and sounds.
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RQBE Window

Databases Output Fields Output To

11t NAME [X] Select Fields...
21 ITOTAL

COMPANY [X] Order By...
CONTACT [ 1 Options...
PHONE [ 1 Group By...
< Add > [ 1 Having... < See SQL >
< Clear > « Do Query »

CUSTOMER
INVOICES
»SALESMAN

3
3
ks
ks
$
ks

Field Name NOT Example Options Select
Criteria

3] INUOICES. CNO [ 1 Like CUSTOMER. CNO
3] SALESMAN. ONO [ 1 Like CUSTOMER. ONO <Insert>
3 INUOICES. ITOTAL [ 1 More Than 2508
<Remove>

< Or >

RQBE stands for Relational Query By Example. RQBE allows you
to look at your data from many different angles. Its ease of use
and quick response time make RQBE an excellent tool for “what if”
analysis.

Using the same simple interface that you've seen so far, FoxPro
allows you to choose databases from which to retrieve information.
You can then select the fields you want to display. You can
specify the order of the fields and organize them in groups. You
can even create conditions that records must meet to be displayed.
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SAMPLE. QPR
SELECT SALESMAN.NAME, INUOICES. ITOTAL,
CUSTOMER. CONTACT, CUSTOMER. PHONE:

CUSTOMER. COMPANY, :

FROM CUSTOMER, INUOICES, SALESMAN: 84/25/91 Top Sales by Saleswan Page 1
WHERE INUOICES.CNO = CUSTOMER.CNO; ;
Sal N Total C Contact Ph
AND SALESMAN.ONO = CUSTOMER.ONO; || S2\°=er'= Mere  Tots onpany o ore |
AND INUOICES. ITOTAL > 2508: Bill Diaddigo 3321.66 Vaultec Studies Ken Bott 614/382-3493
ORDER BY SALESMAN. NAME INUOICES. ITOTA 2615.58 Mixing Systems & Larry Locey 219/865-6818
. f .
INTO CURSOR SAMPLE 5937.24
REPORT FORM SQHPLE.FRX PREVIEUW Bob Wubben 3168.93 Univ Diego Corp Dave Mccarthy 415/573-5167
3824.57 0il & Gallery Paul Schuartz 415/426-8117
2827.62 Hammerman Systems Paul Dixon 213/532-2286
2721.19 Atec Data Service Randy Keji 488/246-5353
11734.31
Carolyn Macioce 2538.18 The Automated Ann Casey 214/631-8458
2525.89 Herring Inc. Bruce Smith 585/842-9776
5863. 27
Daniel Small 3168.93 Univ Diego Corp Dave Mccarthy 415/573-5167
3824.57 0il & Gallery Paul Schuartz 415/426-8117
2827.62 Hammerman Systems Paul Dixon 213/532-2286
e Randy Keji 488/246-5353
Name Itotal |[Company Contact
en Bott 613 36,540y | LENTER R E e

Bill Diaddigo
Bob Wubben

Bob Wubben

Bob Wubben

Bob Wubben
Carolyn Macioce
Carolyn Macioce
Daniel Small

2615.58
3160.93
3024.57
2827.62
2721.19
2538. 18
2525.089
3160.93
3024.57
2827.62
2721.19
2726.63
2538.18
2525.89
3168.93
3824.57
2827.62
2721.19

Mixing Systems & Company
Univ Diego Corp

0il & Gallery

Hammerman Systems

Atec Data Seruvice

The Automated Associates
Herring Inc.

Univ Diego Corp

0il & Gallery

Hammerman Systems

Atec Data Service

Comsof State DSSD

The Automated Associates
Herring Inc.

Univ Diego Corp

0il & Gallery

Hammerman Systems

Atec Data Service

Daniel Small
Daniel Small
Daniel Small
E. Faulkner
Fuji Retell
Fuji Retell

Buoniconti
Buoniconti
Jan Buoniconti
Jan Buoniconti

Jan
Jan

Jim Surbrook 2726.63| Consof State DSSD

219/865-60818
415/573-5167
415/426-8117
213/532-2286
4088/246-5353
214/631-8458
5085/842-9778
415/573-5167

Larry Locey
Dave Mccarthy
Paul Schuartz
Paul Dixon
Randy Kegji
Ann Casey
Bruce Smith
Dave Mccarthy

Ann Casey
Bruce Smith

Dave Hccarthy
Paul Schuartz

214/631-8458
585/842-9770

415/573-5167
415/426-8117

415/426-8117
213/532-2286
488/246-5353
385/444-7594
214/631-8458
565/842-3770
415/573-5167
415/426-8117
213/532-2286
4088/246-5353
385/444-7594

Paul Schuartz
Paul Dixon
Randy Keji
Mike Murray
Ann Casey
Bruce Smith
Dave Mccarthy
Paul Schuartz
Paul Dixon
Randy Kegji
Mike Murray

You can choose to send data from RQBE to a Browse window. This
allows you to use all of the powerful features available with

Browse windows.

You can also choose to send your data to a report. The report can
be modified using FoxPro’s Report Writer, which you will see on

the next stop of this tour.

Programmers will be interested to know that, behind the scenes,
RQBE actually creates a SQL SELECT command containing all of the
items you specified. This command can be copied and used in

your programs if you desire.

Quick Tour
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leport Writer

R: 9¢C: 7 Page Footer

PgHead

PgHead Top Sales by Salesman
PgHead
PgHead [7Salesnan's Name Total Company Contact

Report Total

FoxPro’s Report Writer allows you to design professional reports
quickly and easily. You can place text, fields, lines and boxes
anywhere in your report. This allows you to produce an infinite
variety of reports.

You can use both database fields and calculated fields in reports.

Data in a report can be grouped so that totals, counts, averages,
standard deviations, variances and other calculations can be com-
puted.

A page preview option allows you to view your report on the
screen before you actually print it, saving you both time and
paper.

Naturally, the reports that you design can be saved, modified and
used again.
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084/25/91 Customer Phone List Page 1
Company Phone Contact City St
Ist Computers 617/232-5053 Jeff W. Culbertson Brookline MA
Ist Data Reductions 5084/524-3966 Dennis Johnson Neu Orleans LA
Ist Softuare Systems Ltd. 713/723-1288 Rance Siuren Houston TX
Ist Survey 214/243-7247 Robert Hepuorth Dallas TX
R Beck Pertamina 617/643-6920 Jim Ansarti Arlington MA
A. Arts Computers 617/662-8157 Darryl Roudebush Melrose MA
. Bloomington Biz 904/222-9457 Phil Putnam Tallahassee FL
EZ Inc 617/823-5180 Tom Totah Taunton MA
bbymark Uelonex 214/922-4927 Isador Sueet Dallas X
fcres Tree Solutions 2081/786-8785 Russell Kmickle Sparta NJ
Rdd Associates 415/897-2818 Len Silverman Novato CA
hdd Inc 303/499-2086 Bert Crauford Boulder co
Rdder Incorporated 313/573-5873 Brenda Carturight Warren MI
fdv. Softuare 617/646-7974 Barbara H. Martin Arlington MA
Rdvantage Computer School 488/946-1317 Duane Marshall San Jose CcA
Rerial Inc. 281/696-7378 Lynn Williams Wayne NJ
Rlex County Community 381/453-4484 Rance Hayden Lanham MD
Rerial Inc. 201/696-7378 Lynn Williams Wayne NJ
Alex County Community 301/459-4484 Rance Hayden Lanham MD
Rlex Systewms 814/838-3116 Nancy Uright Erie PA
American Computer Company 886/799-7786 Dick W Guyton Lubbock TX
AMerican Forum 8085/682-5588 Gui Dupuy Santa Barbara cA
AMerican Innovations 201/245-?7517 Garret Hill Roselle NJ
pnsari Data Soft| g4,/25,/91 Top Sales by Salesman Page 1
Ansari Produce
::;l;‘eg;:rl:z:on Salesman’s Name Total Company Contact Phone
Aspen Technolog
Aissoc American § Bill Diaddigo 3321.66 Vaultec Studies Ken Bott 614/382-9493
issoc Strong 2615.58 Mixing Systems & Larry Locey 219/865-6816
Aitec Data Servig
Automated Mayo M
Auard Ammonia G| 5937.24
Azimuth Bavis &
Azimuth Corp Bob Wubben 31608.93 Univ Diego Corp Dave Mccarthy 415/573-5167
B-J Astra . 3024.57 Oil & Gallery Paul Schuartz 415/7426-8117
Balance Computin 2827.62 Hammerman Systems Paul Dixon 213/532-2286
pattery Ueaver 2721.19 Atec Data Service Randy Keji 488/246-5353
11734.31
Carolyn Macioce 2538.18 The Automated Ann Casey 214/631-8458
2525.089 Herring Inc. Bruce Smith 585/842-9778
5863. 27
Daniel Small 3160.93 Univ Diego Corp Dave Mccarthy 415/573-5167
3824.57 0il & Gallery Paul Schuartz 415/426-8117
2827.62 Hammerman Systems Paul Dixon 213/532-2286
2721.19 Atec Data Service Randy Keji 488/246-5353
11734.31
E. Faulkner 2726.63 Comsof State DSSD Mike Murray 385/444-7594
2726.63
Fuji Retell 2538.18 The Automated Ann Casey 214/631-8458
2525.83 Herring Inc. Bruce Smith 5085/842-3778
5863. 27
Jan Buoniconti 3168.93 Univ Diego Corp Dave Mccarthy 415/573-5167
3824.57 0il & Gallery Paul Schuartz 415/426-8117
2827.62 Hammerman Systems Paul Dixon 213/532-2286
2721.19 Atec Data Service Randy Ke.ji 488/246-5353

Quick Tour
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creen Builder

Laserdisk Library

Title 1908 - A Film By Bernardo Be Deleted: No Record#t 393
Catalog# LU8884-3

Price 49.95 Comments

Acquired 18/11/798 Sides 5 This is a good movie.
U.Quality 8 Duration 255

Critics 7 Year 1977

NC-17 “ Rating
[X1 Digital transfer [ 1 CAU format
[ 1 Digital audio [ 1 Black and uhite
Paramount u Studio [ 1 Stereo [ 1 Subtitled
[ 1 Surround sound [ 1 Dubbed
[X1 CX encoded [ 1 Silent
Title “ Order [ 1 Closed captioned [ 1 Commentary
[ 1 Letterboxed [ 1 Supplements

< Top > < Prior > < Next > < Bottom > < Quit >

FoxPro’s Screen Builder allows you to design screens for entering
and editing your data.

Your screens can contain the same controls used in FoxPro’s inter-
face. These controls include push buttons, radio buttons, invisible
buttons, check boxes, popups, lists, text edit regions, text, lines
and boxes.

FoxPro takes the information supplied by the Screen Builder and
generates a program.

Quick Tour



LASERM. MNX

Prompt Result

% \<Systen Subvenu < Edit » Menu Bar ﬂ
t \<Edit Subvenu < Edit »

$ \<Database Submenu < Edit »
$ EN<nvironment Subvenu < Edit » < Try it >

Item
< Insert
< Delete >

Designing custom menu systems is a snap with FoxPro’s Menu
Builder. You can create menus that include your own options as
well as some or all of the options from FoxPro’s menus.

FoxPro uses information you specify in the Menu Builder to
generate a program.

You can coordinate screens and menus in applications that you
write.
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ext Editor

PICTURE. PRG

if *C PICTLOW $dbf(>>
close all
use pictlou
endif
set library to imagelib
define window picture from
title "Press F2 to Disp
float grou close zoom s
color scheme 8
on key label f2 do disppic
brouse nowait windouw pictul

ROBE. TXT

1 In the command window type CLOSE ALL

2. From the File menu popup select Neu...

3. From the Neu dialog select Query

4. Select the Cust database from the Open file
dialog

5. In the ROBE windou select the Select
Fields... check box.

6. In the Select Fields dialog Remouve All the

fields and add the fields cust.cno,

0UT4. TXT

?
04/07/91 Invoice Report Pa

Phone

Contact Date

Company

Atec Data Service 408/246-5353 Randy Keji 8571773908

05-88/90 M

Automated Mayo Miley 714/540-60862 Bill Hopkins

FoxPro’s built-in text editor does more than just allow you to type
and modify text. You can also cut, copy, and paste both within a
file and between files. FoxPro’s text editor includes search and
replace, word wrap, auto indentation, justification, undo/redo and
a handy status line.
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Trace & Debug

Program Resume Out Over Step
53 dimension £1ds(256), query(5@>, tags(256), dbfs(25)

54

55 dbc = @

56 for i =1 to 25

57 if len(dbf(id)> # @

58 dbc = dbc + 1

59 dbfs(dbe)> = alias(i)

608 endif

61 (T,

62

63 if dbc = @

64 x = getfile("DBF","Pick database to BROWSE')
- BROWSER. SPR

FoxPro’s Trace window allows you to watch program code as it
executes. You can let your program execute normally, step
through the code one line at a time, or set breakpoints to stop
execution on certain lines.

The Debug window allows you to monitor the values of variables
and expressions while your program is executing. You can set
breakpoints based on specific variable values.

The Text Editor, Trace and Debug windows are an unbeatable
team for program development.
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APP1.PJX
Name Type

FeoT0. . Screen set | IRGRITI
LASER # Database
LASER Report < Info >
LASER - Screen Set
LASERM Menu < Add >
LREPORT Screen Set

< Remove >

< Build >

To help you keep track of your databases, queries, reports,
screens, menus and programs, FoxPro provides the Project
Manager. The Project Manager unifies and coordinates the ele-

. ments of a FoxPro application.

G2-14

The Project Manager remembers the location and current version
of every file it contains. It also allows easy access to prewritten
programs and interface components.

Distribution of both application files and executable (.EXE) files is
highly streamlined when you use the Project Manager.

Quick Tour



rain It Up

As you can see, FoxPro is a database management system of
remarkable breadth and depth. Beginners can simply and swiftly
tap FoxPro’s facilities to interactively create ad-hoc queries,
reports, data input screens and even entire applications.

Yet FoxPro has the depth to satisfy the most demanding developer
or corporate power-user. FoxPro has the speed to outrun
mainframe databases and handle millions of records.

With FoxPro, you'll never lack room to grow.

Quick Tour G2-15






Groundwork

Starting FoxPro and using the interface is a snap.
In this chapter, you'll learn the basics.

® Welcome . .............. page 2
e StartingFoxPro . . . . ... .. ... page 3
® Mouse Techniques . . . ... .. .. page 4
® MenuSystem . . ... ........ page 5
® Windows . .. ............ page 6
® Dialogs . ............... page 8
® OnlineHelp . . .. .......... page 10
® TextEditing . ............. page 12

Groundwork
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Welcome

Welcome

G3-2

This chapter familiarizes you with the FoxPro interface. If you need

more information about the interface, refer to the Interface Basics chap-

ter in the FoxPro User’s Guide. The chapters following Groundwork

zhow you how to use FoxPro’s tools to enter, manipulate and report your
ata.

Groundwork



Starting FoxPro

Starting FoxPro

Starting FoxPro
1. Turn on your computer.

2. If you have not installed FoxPro, follow the instructions
in the Installing FoxPro chapter of the FoxPro
Installation and Configuration manual.

3. Go to the directory in which you installed FoxPro.
Although FoxPro can be installed on any drive, this
tutorial assumes that FoxPro is installed on the C
drive.

4. Type FOX, then press Enter. The FoxPro sign-on screen
appears with the Command window open.

System File Edit Database Record Program Windou

Groundwork G3-3



Starting FoxPro

Mouse Techniques

Here are some common mouse techniques. For additional information
about mouse use, refer to the Interface Basics chapter in the FoxPro
User’s Guide.

Point — Position the pointer at a
specific location on the screen. When
you move the mouse, the pointer
moves in a similar manner.

@ Click — Point to an object then press and
release the left mouse button once.
I

B Double-click — Point to an object then press and
Q release the left mouse button twice in rapid
succession.

E\/ j‘“/ Drag — Hold the left mouse button

\ Q 7 down, roll the mouse until the pointer

is in the desired location, then release
the left mouse button.

G3-4 Groundwork



Menu System

Menu System

The menu system makes it easy for you to communicate with FoxPro
without programming. The parts of the menu system are shown below,
along with steps for choosing menu options.

Menu Pad

|

|—> [ System QNSEW Edit Database Record Program Windou

Menu Bar

—

Menu
Option

Neu

Close

Save
Save as...
Revert

Printer Setup...
Print...

Quit

—

— Menu

Groundwork

Choosing Menu Options
With the keyboard:

2. Press Enter to display the menu.

1. Press the Alt key to select the first menu pad, then press
the Right Arrow or Left Arrow key to select other
menu pads on the menu bar.

3. Press the Up or Down Arrow keys to select an option,
then press Enter to choose the option.

With the mouse:

1. Point to the menu pad and press the left mouse button to
display the menu.

2. Point to the desired option and press the left mouse
button.

G3-5



Windows

Windows

FoxPro windows display text files, programs, data, help information and
many other kinds of information. You can manipulate windows in a

variety of ways.

Close Box Title Zoom Control

|

Command

Scroll Bar

Moving a Window
With the keyboard:

1. Choose Move from the Window menu. The window
border flashes.

2. Press the arrow keys, PgUp, PgDn, Home and End
keys to move the window, then press Enter.

With the mouse:

Point to the window title, then drag the window to
the desired location.

G3-6 Groundwork



Windows

Sizing a Window
With the keyboard:

* Choose Size from the Window menu. Press the
Left, Right, Up and Down Arrow keys to move the
border of the window. When the window is the size you
want, press Enter.

* To enlarge the window to full size, choose Zoom T from the
Window menu. Choose Zoom T again to return the
window to its previous size.

With the mouse:

* Point to the size control and drag until the window is the
desired size.

* To enlarge the window to full size, click on the window’s
zoom control. Click again to return the window to its
previous size.

Scrolling a Window
With the keyboard:

* Press the Down Arrow key to scroll down or press the Up
Arrow key to scroll toward the top of the window.

* To scroll rapidly, press the PgUp key to display the pre-
vious screen and the PgDn key to display the next
screen of text.

With the mouse:

* Click on the up or down arrow on the scroll bar to move
through the text a line at a time. Click on the Page
Up or Page Down region to move through the text a
screen at a time. Click and hold the mouse button
down on the arrow to scroll continuously.

¢ To scroll rapidly, point to the thumb and drag it up or
down.

Closing a Window

Choose Close from the File menu or click on the window’s
close box or press the Escape key.
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Dialogs

Dialogs are special boxes that allow you to make choices concerning an
action about to take place. Following are some example dialogs with
various controls.

Open:

Popup Control

[..1
CUSTOMER. DBF
CUS_COM. DBF
INUOICE. DBF
ITEMS. DBF

LINEITMS. DBF
PAYMENTS. DBF
SALES. DBF

Directory | TUTORIAL

« Open »

List

Check Box — [ 1ALl Files < Neu

Database Type < Cancel >

v

Neu:

Database
Program
File Default

Index « 0K » Push Button
Report

Label < Cancel > Push Button
Screen
Menu
Query
Pro ject

Radio
Buttons =]

AAAAAAAAAN
.
W W W W W W W W

Scrolling a List
With the keyboard:

Tab (forward) or Shift+Tab (backward) to the list, then
use the Up and Down Arrow keys to scroll through
the list.

With the mouse:

Click on the up or down arrow on the scroll bar. If you
hold the mouse button down, scrolling will continue
until you release the mouse button.

To scroll rapidly, point to the thumb and drag it up
or down.
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Choosing an Option on a Popup
With the keyboard:

1. Tab or Shift+Tab to the popup control, then press Enter
to display the popup.

2. Press the Up or Down Arrow keys to select the option
then press Enter.

With the mouse:

1. Point to the popup control and press the left mouse button
to display the popup.

2. Drag to the desired option.

Choosing a Check Box, Radio Button, Push Button
With the keyboard:

Tab or Shift+Tab to the check box, radio button or push
button, then press Enter. To choose the default push
button (button enclosed in double angle brackets) from
anywhere in the dialog, press Ctrl+Enter.

With the mouse:

Point to the check box, radio button or push button and
click.

Moving a Dialog
With the keyboard:

1. Press Ctrl+F7 then use the arrow keys, PgUp, PgDn,
Home and End keys to move the dialog in any direc-
tion.

2. When the dialog is where you want it, press Enter.

With the mouse:

Point to the top border of the dialog, drag the dialog to
the desired location.

Groundwork G3-9



Online Help

Online Help

With FoxPro, help information is at your fingertips. FoxPro provides
context-sensitive help so that you can get help information about any
system window, dialog or menu option while you are using that feature.

Accessing Context-Sensitive Help
With the keyboard:

When the window or dialog is frontmost or the menu is
displayed, press the F1 key.

With the mouse:

Hold down the Alt key, point to the window, dialog or
menu option and click the left mouse button.

If you prefer, you can scroll through the topics list in the Help window
and get help on a topic.

Getting Help Details for a Topic
1. Choose Help... from the System menu or press F1.

2. Select the topic from the Help window that you want help
information about.

3. Choose the Help push button at the bottom of the Help
window.
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== The FoxPro Interface ==
1 1-To-Many

» ASCII Chart

s About FoxPro

m Add File

n Add Screen

n fAlerts

n fAppend

« Help »

Topics Level of the Help Window

« Topics » “ Brouse “

< Next > | Examines and makes changes to a database.

< Previous > | The Brouse menu popup contains these
options:

< Look Up >

Change/Brouse

Displays database in Brouse windou in
See Also ﬂ Change mode. Toggles betueen Change
and Brouse depending on mode of
Brouse windou.

Details Level of the Help Window
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Text

Editing

G3-12

Editing text in FoxPro is done with a mouse or eight basic cursor move-
ment keys, two modifier keys and two delete keys.

You can use these techniques whenever you type information with the

keyboard.
Cursor Movement
Right Arrow Move one character to the right
Left Arrow Move one character to the left
Up Arrow Move up one line

Down Arrow

Move down one line

Home Move to the start of the line

End Move to the end of the line

PgUp Move up one window-full of text
PgDn Move down one window-full of text
Ctrl+Right Arrow Move one word right

Ctrl+Left Arrow Move one word left

Ctrl+Home Move to the beginning of text
Ctrl+End Move to the end of text

Select Text with Keyboard

Shift Arrow Keys

Select a range of characters

Shift+Ctrl Arrow Keys Select a range of words
Shift+Ctrl+Home Select from cursor to beginning of text
Shift+Ctrl+End Select from cursor to end of text
Ctrl+A (a menu shortcut) Select entire document

Groundwork
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Select Text with Mouse

Drag Select a range of characters
Double-click Select a word

Double-click and drag Select a range of words
Triple-click Select a line

Triple-click and drag Select a range of lines

Delete and Replace

Place cursor to the right of
the character and press
Backspace, or place cursor | Delete a character
at the character and press
Delete

Place cursor anywhere in
word, press Ctrl+Backspace

Delete a word

Select the text, and press

Backspace Delete a selection

Select the text, type new

text (or Paste) Replace existing text

Cut, Copy and Paste

Select the text, press Ctrl+X
or use Cut on the Edit menu

Select the text, press Ctrl+C
or use Copy on the Edit | Copy text
menu

Cut text

Press Ctrl+V or use Paste

on the Edit menu Paste at cursor

Select text, press Ctrl+V or

use Paste on the Edit menu Replace text with clipboard content
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-

Exiting FoxPro

When you are ready to exit FoxPro, choose Quit from
the File menu. You are back to the system prompt.
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Looking at Your Data

In this session you’ll see how easy it is to open a
database and look at its information using
FoxPro’s multi-faceted Browse window.

® OpeningaDatabase . . . .. ... .. page 2
® Browsing a Database ... ... ... page 2
® Modifying the Browse Window . . . . . page 6
® OpeningaMemo Field. . . .. ... page 20

Viewing Data
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Now that you can navigate in the FoxPro interface, let’s use those skills.

We have provided several databases for your use when learning FoxPro.
A database is a file that contains a collection of information. These files
are sometimes referred to as .DBF files or tables.

One of the databases provided, CUSTOMER.DBF, contains information
regarding a set of fictitious customers. This is one of six sample
databases provided that relate to the operations of an imaginary busi-
ness.

FoxPro contains a very powerful tool for viewing and editing database
information called a Browse window. Let’s open CUSTOMER.DBF and look
at the customer information in a Browse window.

Opening and Browsing a Database

1. Choose Open... from the File menu. The Open File dialog
appears. If you've installed FoxPro on the C drive,
make sure that C shows on the Drive popup control.
Be sure that TUTORIAL shows on the
Directory popup control. (Figure 1)

2. Make sure Database appears on the Type popup control
then select CUSTOMER.DBF.

3. Choose the Open push button.

4. Choose Browse from the Database menu. The Browse
window appears as in Figure 2.

As you can see in Figure 3, the Browse window displays information in
rows and columns. The rows are called records and the columns are
called fields:

e Fields contain a certain type of information. For instance,
CUSTOMER.DBF has a field called CNO that contains the customer
number for each customer.

e A record is a set of fields that define a specific person, place or thing.
In CUSTOMER.DBF, each record contains information for one customer.

A database file is simply a collection of records.
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Open:
[..] Drive C "
CUSTOMER. DBF
DETAIL.DBF
. INUOICES. DBF
Database Files OFFICES. DBF Directory |TUTORIAL |l
PARTS. DBF
SALESMAN. DBF
«  QOpen »
[ 1Al11 Files < Neu >
Database H Type < Cancel >

Figure 1: Open File Dialog

CUSTOMER
Cno Company

3021 ISt Computers o |PeIT U. Culbert
18232]1st Data Reductions Dennis Johnson
12082] 1st Softuare Systems Ltd. Rance Sivuren
12848] 1st Survey Robert Hepuorth
A8872|A Beck Pertamina Jim Ansarti
A8818]A. Arts Computers Darryl Roudebus
A6459]A. Bloomington Biz Phil Putnam
A6188|AZ Inc Tom Totah

A5181] Abbymark Uelonex Isador Sueet
A3964| Acres Tree Solutions Russell Kmickle)
A3882| Add Associates Len Silverman
A1846|Add Inc Bert Crauwford
A7249| Adder Incorporated Brenda Carturig
A3835|Adv. Softuare Barbara H. Martj

Figure 2: Browse Window for CUSTOMER.DBF
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A Browse window isn’t normally big enough to enable you to see all the
fields and records in a database at once. Think of the Browse window as
a viewport to the entire database file, as demonstrated in Figure 3.

You can scroll the Browse window horizontally and vertically to see
different portions of the database.

The Browse window has the standard window controls described in
Groundwork. Note that the title of the Browse window is the name of
the database file that you are browsing. Try moving, sizing and scroll-
ing the Browse window.

Moving, Sizing and Scrolling the Browse Window
1. Move the Browse window down a few lines on the screen.

2. Size the Browse window so that it covers the entire
screen.

3. Scroll right to see the remaining fields in CUSTOMER.DBF.
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1 T Fields 1 1

Cno |[Company Contact Iﬁddress ICitg
— PiiT rarony ———————Frooktine ]

18232] ist Data Reductions Dennis Johnson 368 Rivervieu Farm Street Neu Orleans
12082] 1st Softuare Systems Ltd. Rance Siuren 23433 Chapel 121 Houston
12848 1st Survey Robert Hepuort| 733 Peeler 86th Dallas
A8872|A Beck Pertamina Jim Ansarti 4001 Ste Arlington
A8818|A. Arts Computers Darryl Roudebus] 3385 Plantation Avenue Helrose
AB453|A. Bloomington Biz Phil Putnam 6300 East Drive Talahase
AB188|AZ Inc Tom Totah 20841 UWilshire Blud Avenue Taunton
A5181| Abbymark Uelonex Isador Sueet 2139 Bridge Sciller Dallas

A3964| Acres Tree Solutions Russell Kmickle] 621 Ferndale Ste Park Sparta
A3882|Add Associates Len Silverman 318 N Sante Fe Ave Officell Novato
A1846|Add Inc Bert Crauford 253 Mitchell St Boulder
A7249]| Adder Incorporated Brenda Carturig 1237 Bering Bellevieu Warren
A3835|Adu. Softuare Barbara H. Mart 608 114th Ave Se Ste Ala Arlington

<o 3784 Van Dyke Suite Street San Jose
AB163|Aerial Inc. Lynn Williams 903 Highland Drive Wayne

ABI98Z| Alex County Community Corp Rance Hayden 75 Briar Ave Langham

Records AZ418|Alex Systems Nancy UWright 2416 Idaho Place S. Erie

AB887| American Computer Company Dick W Guyton 199 E Main fAla Lubbock
A8B39| AMerican Forum Gui Dupuy Second Motor Seuard Santa Barbara
A9489| American Innovations Garret Hill UWoodland Houe Ave Zussman Roselle
A4268| Ansari Data Software Uallace Campanelli |Black Touwer Drive Ste Court Pittsburg
A6992| Ansari Produce Oliver Mossangan 648401 Hunting Ridge Ave Spring Valley
AB516]Applied Telephone Realtors Michael Cumming 2232 Carlton Hills Place Neuton Square
A4862| Aspen Planning & Inc. Gary Erickson 148 Charleston Avenue Tulsa

ABB48| Aspen Technology Mel Colby 381 Broaduay Suite Place Delitt

ABB48| Assoc American Chiminey Survey Elizebeth Pitts 121 Lady Ellen 1267 Excelsior
A7319|Assoc Strong Dick Nay 11438 St Belleville
A2695| Atec Data Service Randy Keji 4286 S Hardy Drive Ave Santa Clara
| A9541|Automated Mayo Miley Bill Hopkins 521 Uhitney 415 Orange

A6294| Auard AmMmonia Greenhouses Tony Lee Box South Court Boston

L | n6223|Azimuth Bavis & Systems Chuck Heitmeier 17618 Conesus Lake Avenue San Francisco

Figure 3: Browse Window Displaying a Portion of the Database
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You can also adjust the way data is displayed in the Browse window.
For instance, individual fields in a Browse window can be resized. Let’s
try making the COMPANY field smaller so that you can see more of the
other fields.

Sizing a Field
With the keyboard:

1. If the COMPANY field isn’t selected, Tab to it. A field is
selected when it is highlighted or when the cursor
appears in that field. Choose Size Field from the
Browse menu.

2. Use the Left Arrow key to shorten the field, then press
Enter.

With the mouse:

Point to the line between the CONTACT field and the
COMPANY field, press the mouse button and drag.
Release the mouse when the field is the width you
want.

Figure 4 shows the resized COMPANY field.

It is important to note that you are just changing the way the data
appears. You are in no way affecting the way data is stored in the
database file.
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CUSTOMER
Contact

1402115t Computers Jef‘f‘ W. Culbertson

18232
120882
12840
AB8872
A8818
AB459
A6188
A5181
A3964
A3882
A1846
A7249
A3835

ist Data Reductions
ist Softuare Systems Ltd.
1st Survey

A Beck Pertamina

A. Arts Computers

A. Bloomington Biz
AZ Inc

Abbymark Uelonex
Acres Tree Solutions
Add Associates

Add Inc

Adder Incorporated
Adv. Softuare

Resized Field

Company

Dennis Johnson
Rance Siuren
Robert Hepuorth
Jim Ansarti
Darryl Roudebush
Phil Putnam
Tom Totah
Isador Sueet
Russell Kmickle
Len Siluerman
Bert Crauford
Brenda Carturight
Barbara H. Martin

5111 Parkuay
368 Rivervieu

253 Mitchell
1237 Bering Be

CUSTOMER
Contact

14821llst Computers IJEFf W. Culbertson

18232
120882
12840
A8872
A8818
AB459
AB6188
A5181
A3964
A3882
A1046
A7249

A3835

i1st Data Reductions
ist Softuare Systems Ltd.
1st Survey

A Beck Pertamina

A. Arts Computers

A. Bloomington Biz
AZ Inc

Abbymark Uelonex
Acres Tree Solutions
Add Associates

Add Inc

Adder Incorporated
Adv. Softuare

Dennis Johnson
Rance Sivuren
Robert Hepuorth
Jim Ansarti
Darryl Roudebush
Phil Putnam

Tom Totah

Isador Sueet
Russell Kmickle
Len Siluerman
Bert Crauford
Brenda Carturight
Barbara H. Martin

5111 Parkuay

368 Rivervieu Farm Stree
23433 Chapel 121

733 Peeler 86th

4081 Roued Rd

3305 Plantation Avenue
6308 East Drive

2041 UWilshire Blud

2139 Bridge Sciller

621 Ferndale Ste Park
318 N Sante Fe Ave Offic]
253 Mitchell St

1237 Bering Bellevieu
608 114th Ave Se Ala

Figure 4: Browse Window with Field Resized

Viewing Data
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Another way to change the way your data is displayed is to rearrange
the order of the fields. Why don’t you move some of the fields around so
you can see some important information?

Moving Fields
With the keyboard:

1. If the CNO field isn’t selected, Tab to it. You can use
Shift+Tab to move from field to field in reverse order.
Choose Move Field from the Browse menu.

2. Press the Right Arrow key until CNO appears between
COMPANY and CONTACT, then press Enter.

With the mouse:

Point to CNO, press the mouse button and drag CNO until
it is located between COMPANY and CONTACT.

Figure 5 shows the relocated CNO field.
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CUSTOMER
Contact

Looking at Your Data

14821llst Computers lJeff WU. Culbertson

18232
12882
12840
A8872
A8818
AB459
A6188
A5181
A3964
A3882
A1846
A7249
A3835

ist Data Reductions
ist Software Systems Ltd.
ist Survey

A Beck Pertamina

A. Arts Computers

A. Bloomington Biz
AZ Inc

Abbymark Uelonex
Acres Tree Solutions
Add Associates

Add Inc

Adder Incorporated
Adv. Softuare

Moved Field

Company Cno

Dennis Johnson
Rance Sivren
Robert Hepuorth
Jim Ansarti
Darryl Roudebush
Phil Putnam

Tom Totah

Isador Sueet
Russell Kmickle
Len Silverman
Bert Crauford
Brenda Carturight
Barbara H. Martin

CUSTOMER
Contact

5111 Parkuay

368 Rivervieuw Farm Stree
23433 Chapel 121

733 Peeler 86th

4001 Roued Rd

3385 Plantation Avenue
6380 East Drive

20841 UWilshire Blud

2139 Bridge Sciller

621 Ferndale Ste Park
318 N Sante Fe Ave Offig
253 Mitchell St

1237 Bering Bellevieu
600 114th Ave Se Ala

1st Computers |14621|Jeff W. Culbertson |5111 Parkuay

ist Data Reductions
ist Softuare Systems Ltd.
1st Survey

A Beck Pertamina

A. Arts Computers

A. Bloomington Biz
AZ Inc

Abbymark Uelonex
Acres Tree Solutions
Add Associates

Add Inc

Adder Incorporated
Adv. Softuare

18232
12882
12840
AB872
A8818
A6459
A6188
A5181
A3964
A3882
A1846
A7249
A3835

Dennis Johnson
Rance Siuren
Robert Hepuorth
Jim Ansarti
Darryl Roudebush
Phil Putnam

Tom Totah

Isador Sueet
Russell Kwmickle
Len Silverman
Bert Crauford
Brenda Carturight
Barbara H. Martin

368 Rivervieu Farm Streeg
23433 Chapel 121

733 Peeler 86th

4801 Rouwed Rd

3385 Plantation Avenue
6388 East Drive

2841 UWilshire Blud

2139 Bridge Sciller

621 Ferndale Ste Park
318 N Sante Fe Ave OFfic|
253 Mitchell St

1237 Bering Bellevieuw
680 114th Ave Se Ala

Figure 5: Browse Window with Field Moved
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G4-9



Looking at Your Data

We want to see all of the fields at the same time. With FoxPro, it’s no
problem! Just switch the Browse window to Change mode.

Viewing Data in Change Mode

1. Choose Change from the Browse menu. The Browse
window appears in Change mode. (Figure 6)

2. Scroll through some records.

In Change mode, you can see all of the fields in CUSTOMER.DBF at once.
You can toggle back and forth between Browse and Change modes at
will. Exercise your will and return to Browse mode.

,;eturning to Browse Mode

Choose Browse from the Browse menu.
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CUSTOMER
Company IESANTMIRIES
Cno
(N ETI M el U, Culbertson
LGV 5111 Parkuay
City Brookline
State
Zip
Phone
Ono
Ytdpurch
Lat
Long

Company 1st Data Reductions
Cno 18232
Contact Dennis Johnson

Figure 6: Browse Window in Change Mode
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Another useful way to look at data is to split the Browse window into
two partitions. Now you can use the control in the lower left corner of
the Browse window that you’ve been wondering about since the begin-
ning of this session. This control is called the window splitter.

Splitting the Browse Window
With the keyboard:

1. Choose Resize Partitions from the Browse menu, then
press the Right Arrow key until you see two
COMPANY fields then a second CNO field. When the
window appears as shown in Figure 7, press Enter.

2. In the right partition, scroll to the right to see more
fields. (Figure 8)

With the mouse:

1. Point to the window splitter and drag it to the right until
you see two COMPANY fields then a second CNO field.
Release the mouse button. (Figure 7)

2. In the right partition, scroll to the right to see more
fields. (Figure 8)
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Company
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CUSTOMER
Cno Company

1st Computers

i1st Data Reductions

ist Softuare Systems Ltd.
1st Survey

A Beck Pertamina

A. Arts Computers

A. Bloomington Biz
AZ Inc

Abbymark Uelonex
Acres Tree Solutions
Add Associates

Add Inc

Adder Incorporated
Adv. Softuware

I 1st Computers

18232 ist Data Reductions
12882 i1st Softuware Systems Ltd.
12840 1st Survey

A887Z|l A Beck Pertamina
AS818| M A. Arts Computers
A6459| 8 A. Bloomington Biz
AG188| R AZ Inc

AS181| @ Abbymark Uelonex
A3964| 8 Acres Tree Solutions
A3882| W Add Associates

A1846 Add Inc

A7249|Q Adder Incorporated
A3835| W Adv. Softuare

Figure 7: Browse Window Split into Two Partitions

Company

CUSTOMER
City

1st Computers
1st Data Reductions

1st Softuare Systems Ltd.

ist Survey

A Beck Pertamina
A. Arts Computers
A. Bloomington Biz
AZ Inc

Abbymark Uelonex
Acres Tree Solutions
Add Associates

Add Inc

Adder Incorporated
Advu. Softuare

I— Left Partition

A
TR | | aeErm

Neu Orleans 78113]|584/524-3966
Houston TX 77035 713/723-1288]
Dallas TX 75234|214-243-724
Arlington MA 82174]1617/643-6920
Melrose MA 82176|617/662-8157|
Tallahassee FL 32301)9684-222-945
Taunton MA 827808|617/823-5184
Dallas TX ?75201|214-922-492
Sparta NJ 87871|201-786-878
Novato (o] 94947 415/837-2818
Boulder co 80303| 383-499-2086
Warren MI 48093| 313-573-587

Arlington MA 82174 617/646-7974

I L Right Partition ——I

Figure 8: Browse Window with Right Partition Scrolled

Viewing Data
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Perhaps you're wondering why you would want to split the Browse
window. Wonder no longer! In a split Browse window, you can:

e Scroll through the fields in one partition without moving the fields in
the other partition.

¢ Change the mode of one partition to Change mode while leaving the
other partition in Browse mode.

Selecting a Partition and Changing its Mode
With the keyboard:

1. If the right partition is not selected, choose Change
Partition from the Browse menu.

2. Choose Change from the Browse menu, then scroll
through records with the Up and Down Arrow keys.
(Figure 9)

With the mouse:
1. Point to the right partition and click.

2. Choose Change from the Browse menu, then scroll
through records with the Up and Down Arrow keys.
(Figure 9)

Notice that the same record is selected in both partitions as you scroll
because the partitions are linked.
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Right Partition in Change Mode

Company

CUSTOMER
Company

1st Computers

1st Data Reductions
i1st Softuare Systems Ltd.
ist Survey

A Beck Pertamina

A. Arts Computers

A. Bloomington Biz
AZ Inc

Abbymark Uelonex
Acres Tree Solutions
Add Associates

Add Inc

Adder Incorporated
Adv. Softuare

Cno

[N ETS Al Jeff U. Culbertson
Address IENENEYS TE
City Brookline
State

Zip

Phone

Ono

Ytdpurch

Lat

Long

Company 1st Data Reductions
Cno 18232
M Contact Dennis Johnson

Figure 9: Browse Window with Partitions in Different Modes

Viewing Data
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Now you’ll see how versatile the Browse window is. Unlink the parti-
tions and scroll through the records in one partition, leaving records in
the other partition unchanged.

Unlinking Partitions

Choose Unlink Partitions from the Browse menu, then
scroll through some records.

Remember that everything you have done to this Browse window is for
display purposes only. You have not changed the way the information is
actually stored.
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Left Partition in Browse Mode
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Right Partition in Change Mode
(viewing different records)

Company

122.5647

[2621

18232
12082
12840
A8872
A8818
AB459
A6188
A5181
A3964
A3882
A1846
A7249
A3835

1st Computers

ist Data Reductions
ist Softuare Systems Ltd.
1st Survey

A Beck Pertamina

A. Arts Computers

A. Bloomington Biz
AZ Inc

Abbymark Uelonex
Acres Tree Solutions
Add Associates

Add Inc

Adder Incorporated
Adv. Softuare

Company
Cno
Contact
Address
City
State
Zip
Phone
Ono
Ytdpurch
Lat
Long

Add Inc
A1046
Bert Crauford
253 Mitchell St
Boulder
co
88303
3837499-20886
5

161.78
48. 08233
185. 2741

Adder Incorporated

Figure 10: Browse Window with Partitions Unlinked
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Closing the Browse Window

Click on the close box or choose Close from the File
menu.

Notice that the Command window is slightly different than when you
first opened the Browse window. When you choose options from the
interface, FoxPro generates commands in the Command window.
Figure 11 shows two commands that FoxPro has generated. You will
learn more about the Command window as you proceed.

The CUSTOMER database is only one of the .DBF files provided. Another
file included is SALESMAN.DBF. This database contains data about the
salespeople at our sample business.

Let’s look at SALESMAN.DBF in a Browse window.

Browsing SALESMAN.DBF

1. Choose Open... from the File menu. Make sure
TUTORIAL appears on the Directory popup.

9. Select SALESMAN.DBF, then choose the Open push
button.

3. Choose Browse from the Database menu. The Browse
window appears as in Figure 12.

The Browse window displays salesman information in a familiar fashion.
Each record represents a salesman, with each field containing informa-
tion about that salesman.
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Command

USE C:\FOXPROZS\TUTORIﬁL\CUSTOHER.DBF
BROUWSE LAST

Salesman

Figure 11:

Ono|Notes

Commands Executed For You

SALESMAN
Name

1508
175
188
240
271

281
294
322
328
353

WWWWWWNNNNRE R =

Janet A. McCarthy I

Robert UWatters
Doris Dupuy

T Staziola Tounsend
John Hodge
Howard Schneider
Jay Kennedy

Tom Caravello

E. Faulkner
Keith Sutherland
Jim Surbrook

Ned Hicks

Robert Angelo
Kim Baer

21427.
24762.
2020e3.
7798.
162797.
42181.
58521.
69118.
16004.
34688.
27282.
49292.
26737.
122186.

Figure 12: Browse Window for SALESMAN.DBF
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In SALESMAN.DBF, you'll notice an unusual NOTES field between the ONO
and NAME fields. This field contains the word “Memo” or “memo.” A
memo is a type of field that can hold any amount or kind of information.
Because this information can be several pages long, it would be difficult
to display it in the standard Browse format. Instead, you can open a
memo window to view the information contained in a memo field.

Because a memo window is like other windows, you can move it and
resize it to make it easier to see both the memo field information and
the Browse window at the same time. Give it a try.

Opening, Resizing and Moving a Memo Window
With the keyboard:

1. Select the word Memo next to Janet A. McCarthy and
press Ctrl+PgDn.

2. Resize the memo window, then move it so that it appears
below the Browse window on your screen. (Figure 13)

3. From the Window menu, choose the name of the Browse
window, SALESMAN, to make the Browse window ac-
tive.

4. Position the cursor on the top record in the Browse
window then scroll with the Up and Down Arrow keys.

With the mouse:

1. Point to the word Memo next to Janet A. McCarthy and
double-click.

2. Resize the memo window, then move it so that it appears
below the Browse window on your screen. (Figure 13)

3. Position the cursor on the top record in the Browse
window then scroll with the Up and Down Arrow keys.

In a memo field, the difference in capitalization tells you at a glance
whether a particular memo field contains information. A capital “M”
indicates that the memo field contains information and a lower-case “m”
indicates that the memo field is empty.

As you scrolled through the records with the arrow keys, you probably
noticed that the information in the memo window changed to match the
current record in the Browse window. You probably also jumped up and
said, “That’s fantastic!”
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L.

Notes

Name

Ytdsales

Looking at Your Data

Phone

Address

Memo
Memo
Memo
MEMO
MEeMo
memo
MeMo
MeMo
MEMO

anet A. McCarthy

Doris Duptry

T Staziola Toun
John Hodge
Houward Schneider
Jay Kennedy

Tom Caravello

E. Faulkner

21427.27
24762.85
20203. 99
7798.34
'ngzgz;gg
421817
568521.98
69118.59

16004. 78

SALESMAN. NOTES
Janet has been salesperson of the month for one consecutive month?

203/5639-1163
617/894-4332
617/679-4071
617/273-2904
412/981-7562
2157432-3822
2127846-5348
201/529-728

883/776-8662

1417 § Dearborn Ci
1225 Church St.
336 N.E. 23rd St
1812 C Renault St
621 Industrial Wa
7089 South Broad A
748 Summer Ave
4821 U. Lunt Ave.
Sherman UWay

Active Memo Window with Controls Showing

Figure 13

Active Browse Window with Controls Showing and Record Selected

Sale|Ono|Notes|Name Ytdsales |Phone Address

117 |1 |Memo |Janet A. McCarthy 21427.27|283/569-1163] 1417 S Dearborn Ci

150 |1 |Memo |Robert UWatters 24762.85|617/894-4332| 1225 Church St.

75 | [ 26263596 17-679-4071|[336 ;

188 |1 /Imemo |T xziala Townsend 7798.34|617/273-2984| 1612 C Renault St

248 memo |John Hodge 182797.63|4127981-7562] 621 Industrial UWa

271 memo |Howard Schneider ~421§%;;§ 2157432-3822| 709 South Broad A

281/]12 |memo |Jay Kennedy 5852T: 12/246-5348| 748 Summer Ave

294 |2 |memo |Tom Caravello 69118.59| 20 =2831]14821 U. Lunt Ave.
Z |3 |memo |E. Faulkner 16004. 78] 883/776-86 Sherman Uay

Doris was promoted to team leader in January.

=

Inactive Memo Window

Viewing Data

Figure 14
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You can see why we said at the start of this session that the Browse
window is a very powerful tool for viewing and editing your information.

“Wait,” you say, “you haven’t said a thing about editing my information.”

Let’s talk a minute about editing your information. Whenever you are in
a standard Browse window, you can scroll to a particular record and
change the content of that record. It’s as simple as that.

You will work with changing information later on. You can also add and
delete records while you are in a Browse window, but you will learn
about that later, too.

Let’s clean up now and take a short break.

Closing the Browse and Memo Windows
With the keyboard:

Choose Close from the File menu.
With the mouse:

Click on the close box of the Browse window.

Exiting FoxPro

Choose Quit from the File menu.

Viewing Data
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In this session, you'll learn to use the powerful
RQBE window to query databases and gather
specific information.

® Opening the RQBE Window . . . . . page 2
® BrowsingaQuery. . ... ...... page 4
® ModifyingaQuery . ... .. .. ..

Querying

O

buiAian
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Retrieving Your Data

In the last session you learned about viewing data. This is an important
subject, but the primary reason to store data on a computer is so you can
quickly extract certain pieces of that data.

The process of extracting information is called querying. FoxPro has an
incredibly powerful, yet simple, querying facility called RQBE. RQBE
stands for Relational Query By Example:

Relational refers to FoxPro’s ability to relate the database files
needed to perform the query.

Query means to question or inquire.

By Example is the way that you naturally ask questions, such as,
“Can you tell me how many companies are located in CA?”

RQBE allows you to look at your data this way and that, or the other way
if you prefer, with speed and simplicity. If you can imagine it, FoxPro’s
RQBE can show it to you.

Let’s explore FoxPro’s RQBE facility.

Opening the RQBE Window

1. If you exited FoxPro, start FoxPro again. Otherwise,

hold down Shift and choose Close All from the File
menu.

. Choose New... from the File menu.

. In the New File dialog, choose the Query radio button

(Figure 1), then choose OK.

Notice that some of the letters in the New File dialog are
highlighted. These letters are called hot keys. You

can press the corresponding hot key instead of choos-

ing a control. (For step 3, you could have pressed Q.)
Hot keys are available all throughout the FoxPro in-
terface.

. In the Open File dialog, make sure TUTORIAL is showing
on the Directory popup, select CUSTOMER.DBF

The RQBE window appears as in Figure 3.

G5-2
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z
1]
£

Database
Program
File
Index «
Report
Label
Screen
Menu
Query
Pro ject

OK »

< Cancel >

AAAAAAAAAN
.
W W W W W

Figure 1: New File Dialog

Select database:

[..1]
DETAIL. DBF
INVOICES. DBF

Drive

]

OFFICES. DBF
PARTS. DBF
SALESMAN. DBF

Directory

TUTORIAL ﬂ

[ 1 All Files

« Open »

< Cancel >

Databases

Figure 2: Open File Dialog

Output Fields

»CUSTOMER

< Add >
< Clear >

L XXX X

CNO
COMPANY
CONTACT
ADDRESS
CITY
STATE

Select Fields...
Order By...

Group By...

Output To

L 1 Options...

Having. ..

< See SQL >
<« Do Query »

Field Name

NOT

Example

U~L Select

Criteria
<Insert>
<Remoue>

< Or >

Querying

Figure 3:

RQBE Window

Do Query
Push Buttor
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When you perform a query, FoxPro keeps you posted about its progress.
You will see status messages as the query progresses. When the query
is complete, FoxPro shows you the number of records selected and the
amount of time it took to answer your query.

You'll output the results of your query to a Browse window. You can
manipulate the Browse window just as you did in Chapter 4.

Doing a Query

1. Choose the Do Query push button in the RQBE window.
Figure 4 shows the status message.

2. The Browse window appears as in Figure 5. Scroll
through some records in the Browse window.

Note that what you are looking at is just a copy of the actual data — you
cannot use this Browse window to modify the data in any way. But it
does provide you with an excellent way to view the requested data.

The Browse window takes its fields from the Output Fields list in the
RQBE window. The default for a newly opened database is to display all
fields.

Querying
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Company

Selected 5680 records in 1.54 seconds

I 1st Computers

18232
120882
12840
A8872
A8818
AB459
A6188
A5181
A3964
A3882
A1046
A7249

ist Data Reductions

ist Softuware Systems Ltd.
1st Survey

A Beck Pertamina

A. ‘Arts Computers

A. Bloomington Biz

AZ Inc

Abbymark Uelonex

Acres Tree Solutions

Add Associates

Add Inc

Adder Incorporated

Adv. Softuare

[[Jeff U. Culbert
Dennis Johnson
Rance Siuren
Robert Hepuorth
Jim Ansarti
Darryl Roudebu
Phil Putnam

Tom Totah

Isador Sueet
Russell Kmickle
Len Siluerman
Bert Crauford
Brenda Carturig
. Martl

Barbara H

Figure 4: Query Output with Status Message

Querying

Company

[Lst Computers

i1st Data Reductions
1st Softuare Systems Ltd.
1st Survey

A Beck Pertamina

A. Arts Computers

A. Bloomington Biz
AZ Inc

Abbymark Uelonex
Acres Tree Solutions
Add Associates

Add Inc

Adder Incorporated
Advu. Softuare

|Jeff W. Culbert

Dennis Johnson
Rance Sivuren
Robert Hepuorth
Jim Ansarti
Darryl Roudebu
Phil Putnam

Tom Totah
Isador Sueet
Russell Kmickle)
Len Silverman
Bert Crauford
Brenda Carturig
Barbara H. Mar

Figure 5: Query Results in a Browse Window
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You can also tell RQBE that you want to include only certain fields.

Let’s say that you don’t need to see the CNO, ADDRESS, ZIP and ONO
fields. You can return to the RQBE window and specify the fields that
you do want to include in your output.

Specifying Fields in a Query
1. Close the Browse window.

2. In the RQBE window, choose the Select Fields... check box
to display the RQBE Select Fields dialog. (Figure 6)

3. Choose the Remove All push button to clear the Selected
Output list.

4. Select the CUSTOMER.COMPANY field in the Database
Fields list and choose the Move — push button.

You can double-click on the COMPANY field or press Enter
when COMPANY is selected. They have the same effect
as selecting the field and choosing Move —.

5. Repeat step four for the following fields: CONTACT,
PHONE, CITY, STATE and YTDPURCH.

Each field above is listed on your screen with the
“CUSTOMER.” prefix. We often refer to fields without
the database prefix.

6. When the RQBE Select Fields dialog appears as in Figure
7, choose OK. The selected fields appear in the
Output Fields list in the RQBE window.

You may have wondered why we told you to select the fields in the order
we did. The order that you select the fields will be the order that they’ll
appear in the Browse window after you do the query.

Querying
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ROBE — UNTITLED
Databases Output Fields Output To

|
»CUSTOMER CNO Select Fields... Brouse
COMPANY

CONTACT Order By...
ADDRESS [ 1 Options...
CITY Group By...
< Add > STATE Having. .. < See SQL >
< Clear > « Do Query »

Field Name NOT Example U~L Select
Criteria

<Insert>

<Remove>

< Or >

Figure 6: RQBE Window

Database Fields Selected Output
CUSTOMER.CITY c < Move » > |3 CUSTOMER. COMPANY
CUSTOMER. STATE c k3 CUSTOMER. CONTACT
CUSTOMER. ZIP c < A1l + > |3 CUSTOMER. PHONE
CUSTOMER. PHONE c 3 CUSTOMER.CITY
CUSTOMER. ONO c 4 CUSTOMER. STATE
CUSTOMER. YTDPURCH N < Remove > |3 CUSTOMER. YTDPURCH
CUSTOMER. LAT N 3
CUSTOMER. LONG N <Remove All> |3

]
— Functions/Expressions [ 1 No Duplicates
[ 1 Cross Tabulate
« OK »
< Cancel >

Figure 7: RQBE Select Fields Dialog
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rDoing the Query

1. Choose the Do Query push button in the RQBE window.

9. Size the Browse window so that it appears as shown in
Figure 8. Figure 8 also shows the COMPANY field

resized.

The Browse window now includes only those fields that you selected.
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Company

Contact
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1st Computers
i1st Data Reductions

ist Softuare Systems Ltd.

1st Survey

A Beck Pertamina
A. Arts Computers
A. Bloomington Biz
AZ Inc

Abbymark Uelonex
Acres Tree Solutions
Add Associates

Add Inc

Adder Incorporated
Adv. Softuare

| T |

Dennis Johnson
Rance Siuren
Robert Hepuorth
Jim Ansarti
Darryl Roudebush
Phil Putnam

Tom Totah

Isador Sueet
Russell Kmickle
Len Silverman
Bert Crauford
Brenda Carturight
Barbara H. Martin

584/524-3966
713/723-1288
214/243—?24?L
617/643-6928

617/662-8157
984/222-9457
617/823-5180
214/922-4927
281/786-8785
415/897-2818
383/499-2086
313/573-5873
617/646-7974

Houston
Dallas
Arlington
Melrose
Talahase
Taunton
Dallas
Sparta
Novato
Boulder
Warren
Arlington

Figure 8: Browse Window Showing Specific Fields

G5-9



Retrieving Your Data

After studying the Browse window, you may decide that you do not need
to see the CONTACT field. Try removing CONTACT and see how the query
output looks.

Removing Fields from a Query
1. Close the Browse window.
2. Choose the Select Fields... check box.

3. Select the CONTACT field in the Selected Output list, then
choose Remove.

4. Choose OK. Notice that CONTACT no longer appears in
the Output Fields list. (Figure 9)

5. Choose Do Query.

6. Size the Browse window so it appears as shown in
Figure 10 then scroll through some records.
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ROBE
Output Fields

»CUSTOMER

< Add >
< Clear >

COMPANY
PHONE
CITY
STATE
YTDPURCH

— UNTITLED

Select Fields...
Order By...

Group By...

Retrieving Your Data

Output To

QUERY
L 1 Options...

Having. ..

< See SQL >
<« Do Query »

Field Name

Example

U~L Select

Criteria

<Insert>

<Remove>

< Or >

Output Fields List
Figure 9: RQBE Window

Company

1st Computers
ist Data Reductions

i1st Softuware Systems Ltd.

ist Suruvey

A Beck Pertamina
A. Arts Computers
A. Bloomington Biz
AZ Inc

Abbymark Uelonex
Acres Tree Solutions
Add Associates

Add Inc

Adder Incorporated
Adv. Softuare

|||EE-|

5084/524-3966
713/723-1288
214/243-7247
617/643-69260
617/662-0157
904/222-9457
617/823-5180
214r922-4927
201/786-8785
415/897-2810
383-499-20886
313/573-5873
617/646-7974

Neu Orleans
Houston
Dallas
Arlington
Melrose
Talahase
Taunton
Dallas
Sparta
Novato
Boulder
Warren
Arlington

Figure 10: Query Results without CONTACT Field

Querying

22?2.
754.
3991.
3922.
684.
37e.
1398.
272.
5487.
161.
722.
4828.
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G5-12

Now that you have selected the fields, you can specify the order you
want the data presented. For instance, try displaying the data alpha-
betically by city.

Ordering Fields in a Query
1.
2.

Close the Browse window.

Choose the Order By... check box in the RQBE window.
(Figure 11)

In the RQBE Order By dialog, select CUSTOMER.CITY then
choose Move —. (Figure 12)

Choose OK. Notice that a 1 and T appear next to CITY
in the Output Fields list. The 1 indicates that CITY is
the first priority when ordering the data and the T in-
dicates that the data will be displayed in ascending
order.

Choose Do Query. The Browse window appears.
You may need to resize the COMPANY field to see all
of its information. (Figure 13)

Scroll through some records in the Browse window.
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ROBE — UNTITLED

Output Fields

»CUSTOMER

COMPANY
PHONE
CITY
STATE

< Add >
< Clear >

YTDPURCH

[X] Select Fields...
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Output To

Brouse

I
[ 1 Order By...

[ 1 Group By...
[ 1 Having...

QUERY
[ 1 Options...

< See SQL >
<« Do Query »

Field Name

Example

U~L Select

Criteria
<Insert>
<Remove>

< Or >

Figure 11: RQBE Window
Selected Output Ordering Criteria
CUSTOMER. COMPANY < Move + > t CUSTOMER.CITY

CUSTOMER. PHONE
CUSTOMER. CITY
CUSTOMER. STATE

< Remove >

CUSTOMER. YTDPURCH

|

Order Options
(+> Ascending
C > Descending

<«

OK »

< Cancel >

3
3
3
3
3
3
3
o k3
$
2
3
3

Figure 12: RQBE Order By Dialog

Company

Phone

City

Thinfilm Computer Inc l818/889—2?1?

The Circle Distributing Shop
Herring Inc.

Business State Computers
Crescent Computer Source
Posna Associates

Data White Truck Steel
Baptist Im—pak
Soltis & Inc.

Sueet County

Min/Max Resource Systewms
Control Communication & Compu
A Beck Pertamina

Adv. Softuare

518/869-8738
585/842-9770
215/481-8653
886/372-7291
617,/475-9321
313/668-2612
313/769-3038
313/769-9760
4157439-3581
414/733-1643
818/796-5398
617/643-6920
617/646-7974

Rgoura ||

Albany
Albuquerque
Allentoun
Amarillo
Andover
Ann Arbor
Ann Arbor
Ann Arbor
Antioch
Appleton
Arcadia
Arlington

Arlington

cA— [ 6852, 47
NY 1858. 88
NM 56819.53
PA
TX
MA
MI
MI
MI
CA
I
[of:]
MA
MA

Figure 13: Query Results in Order by CITY
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You can order your data any way you want. For instance, suppose you
want your data ordered by state, and by city within each state. Now
change the order of the information to match. ‘

Ordering by Multiple Fields in a Query
1. Close the Browse window.
2. Choose the Order By... check box.

3. In the RQBE Order By dialog, select CUSTOMER.STATE
then choose Move —.

4. Adjust the order of the fields in the Ordering Criteria list:

e With the keyboard, Tab to the Ordering Criteria list
and use the Down Arrow key to select STATE then
press Ctrl+PgUp so that STATE appears above CITY
in the list.

e With the mouse, point to the double-headed arrow
preceding STATE in the Ordering Criteria list and
drag it until STATE appears above CITY in the list.

5. When the Order By dialog appears as in Figure 14, choose
OK.

Observe how the Output Fields list reflects your changes. The 1 preced-
ing STATE indicates the data is ordered first by STATE. The 2 in front of
CITY indicates that the data is ordered second by city within each state.
The arrows indicate that the data will be displayed in ascending order.

Doing the Query
Choose the Do Query push button in the RQBE window.

Figure 15 displays the results of the query.

The data in the Browse window is ordered just as you desired.

G5-14 Querying



Retrieving Your Data

Selected Output

CUSTOMER. COMPANY
CUSTOMER. PHONE
CUSTOMER. CITY
CUSTOMER. STATE
CUSTOMER. YTDPURCH [

< Move -+ >
< Remove >

Order Options

(+) Ascending
C > Descending

Ordering Criteria

1t CUSTOMER. STATE
t CUSTOMER.CITY

« OK »

< Cancel >

3
3
$
3
$
3
$
ok
$
$
$
$

Figure 14: RQBE Order By Dialog

Company

Phone

City

III-I

1829?.

Steuen Computers
Walker Business Gallery
Harpoon Store

Great Form

Goods For The Masses
Harpoon PCA

Pro and Pouer

Raybank Services & Computin
Quik Assistance

SC Co.

Thralls Senski

Weichert Comp.

Thinfilm Computer Inc

2857881-2245
2085/749-9881
5081/663-3706
682,892-8572
6082/276-5827
60827943-5882
6082/276-6239
60827943-4609
682/353-8869
6827991-1558
682/894-9367
6084-381-2591
818,889-2717

Huntsville
Opelika
Little Rock
Mesa
Phoenix
Phoenix
Phoenix
Phoenix
Scottsdale
Scottsdale
TEMPE
Victoria
Agoura

ﬂL
AR
AZ
Az
AZ

Figure 15: Query Results in Order by STATE and CITY
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A

G5-15



Retrieving Your Data

Until now, you have been looking at all of the records in the CUSTOMER
database.

Now you can start asking questions — of your database, that is.

Suppose you ask, “What companies are located in Ohio?” Using the
RQBE window, this question is answered almost immediately.

Specifying Selection Conditions
1. Close the Browse window.

2. Choose CUSTOMER.STATE from the Field Name popup
located in the bottom portion of the RQBE window.
(Figure 16)

The Field Name and comparison popup controls are
unusual because they look like text boxes. However,
you cannot type in them because they are popup con-
trols.

Note: Each row in the bottom area of the RQBE win-
dow contains a Field Name and comparison popup
control. This allows multiple selection conditions.

Like appears by default on the comparison popup
control. (Figure 16)

3. Type OH in the text box below Example. (Figure 17)
Be sure both letters are capitalized.

Doing the Query

1. Choose Do Query. The Browse window appears.
(Figure 18)

2. Scroll through some records in the Browse window.

The Browse window now displays the data for only those companies
located in Ohio. Like specifies that CUSTOMER.STATE must match OH to
be included in the output.
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Choose the
Field Name
Popup Control

Comparison
Popup
Control

Field Name
Popup

Databases

RQBE - UNTITLED

Output Fields

»CUSTOMER

< Add >
< Clear >

COMPANY

t STATE
YTDPURCH

[X1 Select Fields...

[X1 Order By...

[ 1 Group By...
[ 1 Having...
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Output To

Brouse

I
[ 1 Options...

< See SQL >
« Do Query »

Field Name

Example

Select
Criteria

Up~Lo

~ I

<Insert>

<Remove>

Figure 16:

Databases

Output Fields

»CUSTOMER

< Add >
< Clear >

COMPANY
PHONE

t STATE
YTDPURCH

[X1 Select Fields...

[X]1 Order By...

[ 1 Group By...
[ 1 Having...

Output To

[ 1 Options...

< See SQL >
« Do Query »

NOT

CUSTOMER.
CUSTOMER.
CUSTOMER.
CUSTOMER.
CUSTOMER.
CUSTOMER.
CUSTOMER.
CUSTOMER.
CUSTOMER.
CUSTOMER.

CNO

Example

UxL Select
Criteria

COMPANY
CONTACT
ADDRESS
CITY
STATE
ZIP
PHONE
ONO

R Like |

[1

<{Insert>

<Remove>

< Or >

YTDPURCH

Company

Figure 17: RQBE Window

System County Medical Health

Legal Corp.
Micro Time Corp
Polytron Business Machines

216/285-12681| Chardon

513/731-8895|Cincinnati
5137381-5929|Cincinnati

513/231-4793|Cincinnati

Figure 18: Browse Window with Companies in Ohio

Querying
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Use the same simple procedure to display those companies located in
both Ohio and Michigan.

Specifying More Selection Conditions
1. Close the Browse window.

2. Select In from the comparison popup (between the Field
Name popup and the Example text box). (Figure 19)

3. In the Example text box, after OH type ,MI
(Figure 19)

4. Choose Do Query. The Browse window appears as in
Figure 20.

5. Size the Browse window and scroll through some records.

FoxPro displays only companies located in Ohio or Michigan because In
specifies that, to be included in the output, CUSTOMER.STATE must be
one of the items in the Example text box.
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ROBE - UNTITLED
Output Fields

»CUSTOMER

COMPANY
PHONE
2t CITY

YTDPURCH

<

< Clear >

k2
3
k2
$ 1t STATE
3
3

Add >

[X]1 Select Fields...
[X]1 Order By...

[ 1 Group By...
[ 1 Having...
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Output To

Brouse

QUERY
[ 1 Options...

< See SQL >
« Do Query »

Field Name

NOT

Example

U~L Select

% CUSTOMER. STATE

Like

More Than

Less Than
Betueen
In

OH, MI

Exactly Like

Criteria
L1
<{Insert>
<Remove>

< Or >

Figure 19: RQBE Window

Comparison Popup

Querying

Company

III-II

Baptist Im-pak

Soltis & Inc.

Hennekee House World

Legal Inc

Calif Beauty Inc.

Johnson Specialties
Computer Logic Hurdman
California Alarm

Adder Incorporated

System County Medical Health
Legal Corp.

Micro Time Corp

Polytron Business Machines

313/769-3038

313/769-9760
517/351-6073
313/624-3487
616/241-3767
517/784-5590
517/393-9837
313/356-5421
313/573-5873
216/285-12081
513/731-88395
513/381-5929
513/231-4733

8| Ann Arbor
Ann Arbor

East Lansing
Farmington Hill
Grand Rapids

Jackson
Lansing
Southfield
Warren
Chardon
Cincinnati
Cincinnati
Cincinnati

848.88

Figure 20: Browse Window with Companies in Michigan and Ohio
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Perhaps it would be better to see the data ordered by company name
within each state, instead of by city. Give it a try.

Specifying and Ordering Selection Conditions
1.
2.
3.

Close the Browse window.
Choose the Order By... check box.

Select CUSTOMER.CITY from the Ordering Criteria list then
choose Remove.

Select CUSTOMER.COMPANY from the Selected Output list
then choose Move —.

Choose OK. The RQBE window appears as in Figure 21.

Choose Do Query. The Browse window appears as in
Figure 22.

The companies are now ordered alphabetically by company name within
each state. Because you haven’t changed the selection criteria, only com-
panies located in Ohio or Michigan are displayed.
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»CUSTOMER

< fAdd >
< Clear >

$ 2t COMPANY
3 PHONE

3 CITY

$ 1t STATE

3 YTDPURCH
3

— UNTITLED

[X1 Select Fields...

[X]1 Order By...

[ 1 Group By...
[ 1 Having...
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Output To

Brouse

QUERY
L 1 Options...

< See SQL >
« Do Query »

Field Name

Example

U~L

CUSTOMER. STATE

OH, MI

L1

Figure 21:

Company

RQBE Window

Phone

City

Select
Criteria

<Insert>
<Remove>

< Or >

T T N 77| (TN |

Baptlst In-pak

Calif Beauty Inc.

California Alarm

Computer Logic Hurdman

Data White Truck Steel
Hennekee House World
Johnson Specialties

Legal Inc

Soltis & Inc.

DPCS Produce

Financial Stamps Of Builders
Legal Corp.

Maximal Computing Prosthesis

313/769-3038

6167241-3767
313/356-5421
517,393-9837
3137668-2612
517/351-6879
517,784-55908
313/624-3487
313/769-9768
6086/323-6350
5137434-5836
513-731-8835
614/261-4356

Ann Arbor
Grand Rapids
Southfield
Lansing

Ann Arbor
East Lansing
Jackson
Farmington Hill
Ann Arbor
Ironton
Dayton
Cincinnati
Hilliard

2384.
1982.
3132.
8876.
1921.

358.
9521.

848.

136.
1915.
3743.
1656.

Figure 22: Browse Window with Companies Ordered
Alphabetically by State

Querying
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RQBE allows you to specify multiple selection conditions.

Suppose you want to look at only those companies in Ohio or Michigan
whose year-to-date purchases are more than $1,000.00.

By now, you know how easy it is to specify this using the RQBE window.

Specifying More Selection Conditions
1. Close the Browse window.

2. Place the cursor in the row below CUSTOMER.STATE and
click or press Enter to display the Field Name popup
then choose CUSTOMER.YTDPURCH.

3. Choose More Than from the comparison popup.

4. In the Example text box, type 1000.

5. When the RQBE window appears as in Figure 23, choose
Do Query. The Browse window appears. (Figure 24)

As expected, all of the records displayed match the conditions that you
specified.

With RQBE, just a few keystrokes allow you to retrieve and combine in-
formation from your database.

Querying
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Databases Output Fields Output To
»CUSTOMER 3 COMPANY [X]1 Select Fields...
3 PHONE
$ 2t CITY [X1 Order By...
$ 1t STATE [ 1 Options...
k2 YTDPURCH [ 1 Group By...
< Add > 3 [ 1 Having... < See SQL >
< Clear > « Do Query »
Field Name NOT Example U~L Select
Criteria
3 CUSTOMER. STATE [ 1 In OH, MI L1
£4 CUSTOMER. YTDPURCH [ G [ 1} <Insert>

Querying

Figure 23: RQBE Window

Company

<Remove>

< Or >

Baptist Impak [B137765-3035 [onn Arbor |

Calif Beauty Inc.

California Alarm

Computer Logic Hurdman

Data White Truck Steel
Hennekee House World

Legal Inc

Financial Stamps Of Builders
Legal Corp.

Maximal Computing Prosthesis
PC Bogg Center

Raymond Computing

Sacred City Steel Inc.
Steven Softuare Solutions

616/241-3767
313/356-5421
517,393-9037
3137/668-2612
517/351-60873
31376243487
5137434-5036
513,731-8835
614/261-4356
419/629-6499
513,2293-20846
2167292-4892

614/445-1107

Grand Rapids
Southfield
Lansing

Ann Arbor
East Lansing
Farmington Hill
Dayton
Cincinnati
Hilliard

Neu Bremen
Dayton
Cleveland
Columbus

| |
MI 2384.88
1982.
3132.
8876.
1921.
9521.
1915.
3743.
1656.
5419.

12
42
77

Figure 24: Companies in Michigan or Ohio with
Year-to-Date Purchases > $1000
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Consider this scenario. You spoke to a man on a plane about an order
and you entered his information into your CUSTOMER database file.
Nine months later he calls and says, “I talked to you on the plane from
Denver and if you can tell me my name, I will give you a one million
dollar order.”

Unfortunately, you don’t remember anything about him except that his
company’s name begins with “T'r”. Aren’t you glad that you have RQBE?

Gathering Specific Information With RQBE
1. Close the Browse window.

2. Check the Select Fields... check box then select
CUSTOMER.CONTACT and choose Move —. Rearrange
the fields so that CONTACT is below COMPANY in the
Selected Output list. Choose OK.

3. Select CUSTOMER.YTDPURCH from the Field Name popup,
then choose the Remove push button under Select
Criteria.

4. Change CUSTOMER.STATE to CUSTOMER.COMPANY on the
Field Name popup control.

5. Select Like from the comparison popup.

6. Type Tr in the Example text box.

7. When the RQBE window appears as in Figure 25, choose
Do Query. The Browse window appears.

Query output lists only companies beginning with “Tr” so you can size
the Browse window then scroll until you find the right name. See
Figure 26.

“Mr. Kieckheser, how could I forget you. How are things at Triad Resort
Computers?” ’

Querying
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Databases Output Fields

»CUSTOMER $ 2t COMPANY
CONTACT
PHONE

3
3
3 CITY
3
3

1t STATE
YTDPURCH

< Add >
< Clear >

[X]1 Select Fields..

[X1 Order By...

[ 1 Group By...
[ 1 Having...

Retrieving Your Data

Output To

QUERY
[ 1 Options...

< See SQL >
« Do Query »

Field Name NOT

Example

U~L Select

$ CUSTOMER. COMPANY [ 1 Like

Tr

Criteria
L1
<Insert>
<Remove>

< Or >

Figure 25: RQBE Window

Contact

Phone

Tri—-Chem Systems
True Computer
Triad Systems

Tri-3 Latent Softuare
True DSSD
Tri-8 Data Data—Corp

Triad Resort Computers

Charlie Dobos
Bill Olsen
Marion Albright
Jeff Lund

Bill Griffin
Paul Hedgepath

Frank Kieckheser

Figure 26: Query Results

Querying

415/941-2488
415/943-08436
389/734-6280
212/689-2370
5167231-5288
215/868-7225
2157328-80870
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When you close the RQBE window, FoxPro asks if you want to save your
changes. This allows you to use a specific RQBE window many times
without re-entering all of the same information. Go ahead and save this
RQBE window — you will use it again.

Closing the RQBE Window
1. Close the Browse window.

2. Close the RQBE window then choose Yes from the Save
Changes alert. The Save As dialog appears.

3. Make sure TUTORIAL appears on the Directory popup
control, type GSCHAPS in the text box as shown in
Figure 28, then choose Save.

Gb5-26 Querying
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Do you want to save changes to
C :NFOXPROZ5M\TUTORIALMUNT ITLED . QPR?

« Yes » < No > < Cancel >

Figure 27: Save Changes Alert

Save Current Document As:

»[..1] Drive c “
STEP1. QPR

STEPZ. QPR
STEP3. QPR

STEP4. QPR Directory | TUTORIAL ﬂ
STEPS. QPR

« Save >

[ 1 All Files < Cancel >

GSCHAPS

Figure 28: Save As Dialog
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Reporting on Your Data

In this session, you'll learn how to use the RQBE
window to quickly design and generate reports
using your data.

® Opening an Existing Query . . . . .. page 2
® GeneratingaReport . . . .. ... .. page 6
® ModifyingaReport. . . . .. .. .. page 10
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Reporting on Your Data

In the last session you used RQBE to display information in a Browse
window. Another way to present information is in a printed report.

You can use the RQBE facility to create reports for every situation. You
can then customize the report using FoxPro’s powerful Report Writer.

The first report you'll create is a phone list of all of the customers
located in California. You’ll begin with the query that you created in
Chapter 5.

Opening an Existing Query
1. Close the Command window.
2. Choose Open... from the File menu. Make sure
TUTORIAL is showing on the Directory popup control

and Query is showing on the Type popup control in
the Open File dialog. (Figure 1)

3. Select GSCHAP5.QPR, then choose Open.

You'll include the following fields in your phone list: COMPANY, PHONE,
CONTACT, CITY and STATE. The information should be presented in al-
phabetical order by company.

Generating a Report with RQBE
1. Choose the Select Fields... check box.

2. Select CUSTOMER.YTDPURCH from the Selected Output
list and choose Remove.

3. Rearrange the order of your fields in the Selected Output
list so that CONTACT is below PHONE and choose OK.

4. Change CUSTOMER.COMPANY to CUSTOMER.STATE on the
Field Name popup.

5. Type Ca in the text box below Example.
6. Choose Report/Label on the Output To popup.

7. When the RQBE window appears as in Figure 2, choose
Do Query.

G6-2 RQBE Reporting
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Open:

[..1
GSCHAPS . QPR
STEP1.QPR
STEPZ. QPR
STEP3. QPR
STEP4. QPR
STEPS. QPR

[ 1 All Files

Query ﬂ Type

|

Drive c "
Directory | TUTORIAL "

« Open »

< Neu >

< Cancel >

|

Figure 1: Open File Dialog

Type Popup Control

Databases

Output To Popup Control

RQBE — GSCHAPS

Output Fields

»CUSTOMER

< Add >
< Clear >

$ 2t COMPANY
k2 PHONE

3 CONTACT
3 CITY

$ 1t STATE

3

Output To

[X]1 Select Fields... Report/Labelﬂ

[X1 Order By...

[ 1 Options...
[ 1 Group By...
[ 1 Having... < See SQL >
« Do Query »

Field Name

NOT

Example U~L Select

t+ CUSTOMER. STATE [ 1 Like

Criteria

(o] [1]
{Insert>

<Remove>

< Or >

RQBE Reporting

Figure 2: RQBE Window
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Take a look at the report that is generated from these settings as shown
in Figure 3.

This initial report includes all of the correct information, but a clearer
layout will enhance its effectiveness.

Viewing the Report and Returning to RQBE
To scroll through the entire report:

e Continue to press any key until you return to the
RQBE window.

To return immediately to the RQBE window:

e Press Escape.

RQBE Reporting
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a )
Add Associates 4157897
cA Press any key to continue ...
Advantage Computer School 488/946 se
cA
American Forum 885/682-5588 Gui Dupuy Santa Bar
bara CA
Atec Data Service 488/246-5353 Randy Keji Santa Cla
ra ca
Automated Mayo Miley 714/548-6862 Bill Hopkins Orange
CA
Azimuth Bavis & Systems 415/7983-1683 Chuck Heitmeier San Franc
isco CA
Azimuth Corp 619/271-8518 Al Reetz San Diego
ca
Battery UWeaver 415/952-7761 Brian Case S.San Fra
ncisco CA
Belmar Fishing Systems 415/323-2469 Mike Ozer Menlo Par
k cA
Belmar Tronixs Computer 2137452-39369 Andy Rigney Santa Mon
ica cA
Big Incorporated 818/762-5886 Bert Dalgleish N. Hollyu
ood (o]
Blake Inc. 4157992-8718 Bob Dot Daly City
cA
\_ J
Figure 3: Initial Report Displayed on Screen
RQBE Reporting G6-5
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You can create a custom layout by making a few selections in the RQBE
Display Options dialog.

This is done by telling FoxPro what report form to use to display the
data. RQBE can also automatically create a report form for you based on
the information that you specify in the RQBE window.

For example, your GSCHAP6 report will include the fields you select, in
the order you specify.

Generating a Report with RQBE

1. Choose the Options... check box in the RQBE window.
(Figure 4)

2. Choose the Report radio button in the RQBE Display
Options dialog and check the Quick Report... check
box. (Figure 5)

3. In the RQBE Quick Report dialog, type
TUTORIAL\GSCHAP6 .FRX in the Save As text box.
Simply type over the name that already appears in
the text box (Figure 6), then choose OK.

4. Notice that the Preview Report/Label check box is auto-
matically checked. Choose OK in the RQBE Display
Options dialog.

RQBE Reporting
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Output Fields

— GSCHAPS

Reporting on Your Data

Output To

»CUSTOMER $ 2t COMPANY [X] Select Fields...
k2 PHONE
3 CONTACT [X1 Order By...
3 CITY [ 1 Options...
$ 1t STATE [ 1 Group By...
< Add > 3 [ 1 Having... < See SQL >
< Clear > <« Do Query »
Field Name NOT Example U~L Select
Criteria
$ CUSTOMER. STATE [ 1 Like cA L1
<{Insert>
<Remove>

< Or >

Figure 4: RQBE Window

Report
Radio
Button

ROBE Displ

[X1

e lalalalal
e e

Yl
.
e

— Formatting Options
C > Screen Display
C+> Report

C > Label

ay Options:

Report/Label Form Name
GSCHAP6

Quick Report... [ 1 Overurite
Previeu Report/Label

Shou Summary Info Only

Eject Page Before Report
Report Heading

Suppress Column Headings
Console On C > Console Off
[ 1 Pause Betueen Screens

Output Destinations
[ 1 To Printer
[ 1 To File
[ 1 Overurite File
[ 1 Use Printer Setup
in Report-Label Form

« oK »

< Cancel >

Figure 5: RQBE Display Options Dialog

ROBE Quick Report:

(<> Column Layout
C > Form Layout

Report Width

Fieldl Field2
XXXXXX XXXXXX
XXXKXX XXXKXX
XXXXXX XXXXXX

<< OK » <

Clear

>

LEUVEEE TUTOR IALNGSCHAPG . FRX

RQBE Reporting

Figure 6: Quick Report Dialog
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Doing the Query

Choose Do Query.

Remember the Preview Report/Label check box that was automatically
checked? Although output fills the entire screen as it did before, the
output now appears in a Page Preview window. The Page Preview
window has many of the features discussed in the Groundwork chapter,
including a horizontal scroll bar and a close box. See Figure 7.

RQBE Reporting
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Bob Leuis Walker & Jackson

Bulldog Inc.

Business M. Business
& S Computing & Systems
« Done » < More >

415/897-2818
408/946-1317
805/682-5580
488/246-5353
714/548-60862
415/9839-1603
619/271-8518
415/952-7761
415/323-2469
2137452-9369
818/762-5886
415/992-8718
213/533-7332
415/864-7557
613/564-2809
415/325-43085

Column:

Contact

Len Siluerman
Duane Marshall
Gui Dupuy
Randy Keji
Bill Hopkins
Chuck Heitmeier
Al Reetz

Brian Case
Mike Ozer

Andy Rigney
Bert Dalgleish

Bob Dot

Dan Tillotson
Bill Kane

Larry Van Lockern
Parky Kmickle

Novato

San Jose
Santa Barbara
Santa Clara
Orange

San Francisco
San Diego
S.S8an Francisco
Menlo Park
Santa Monica
N. Hollyuood
Daly City
Long Beach
San Francisco
San Diego
Menlo Park

Figure 7: GSCHAP6 Report in the Page Preview Window

RQBE Reporting
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Let’s look at the report form you've just created and spruce it up in the
Report Layout window.

Opening a Report Form

1. Choose the Done push button at the bottom of the Page
Preview window to return to the RQBE window.

2. Choose Open... from the File menu then make sure
Report shows on the Type popup control and
TUTORIAL shows on the Directory popup control.
(Figure 8)

3. Select GSCHAP6.FRX, then choose Open.

A report form appears as in Figure 9. The report form is divided into
three sections or bands:

e The PgHead band contains information that appears at the top of
each page in the report.

¢ The Detail band is printed once for each record that meets the
selection criteria.

e The PgFoot band contains information that appears at the bottom of
each page in the report.

The overall appearance of the report form matches the appearance of
the printed report.
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Open:

[..1 Drive C H
GSCHAPG .FRX |

Directory | TUTORIAL "

« Open »

[ 1All Files < New >

Report n Type < Cancel >

[X]1 Restore Environment

Figure 8: Open File Dialog

GSCHAPG6 . FRX
R: @8C: @ Page Header
PgHead Company Contact
PgHead
PgHead
PgHead
Detail phone
PgFoot
PgFoot
PgFoot

PgFoot [LIVI®)

Figure 9: GSCHAP6 Report Form
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You can change the appearance of the report by adding, moving or delet-
ing items from the report form. These items can be plain text, fields
from databases, expressions, functions and graphic objects. For now,
you'll experiment with the text and fields.

Moving Field Headings in a Report Form
With the keyboard:

1. Place the cursor on each field heading and press the
Spacebar to select it. Press the arrow keys to move
each field heading down to the third PgHead band
then center each heading over the appropriate field.
Be sure to scroll right to see all of the headings.

2. Press Enter to confirm the move.

With the mouse:

Point to each field heading and click to select it. Drag
the heading down to the third PgHead band then
center it over the appropriate field. Be sure to scroll
right to see all of the headings.

Creating and Centering Titles in a Report Form

1. Place the cursor on the top line of the PgHead band,
type Customer Phone List then press Enter.

9. To center the title, select it and choose Center from the
Report menu. (Figure 10)

You'll notice a status bar at the top of the report. The status bar lets
you know which report band, row, and column you are in. There is also
an area in the status bar that tells you whether you are in Move or Text
mode.

In Move mode you can move objects around the report using the arrow
keys, Home, End, Ctrl+Home, Ctrl+End or the mouse. Typing a charac-
ter or the Ctrl+arrow keys will put you into Text mode. You can also get
into Text mode by choosing Text from the Report menu. In Text mode,
all keys apply to word processing type operations. If you can’t move an
object, look at the status bar to see what mode you are in. To exit Text
mode, press Enter.

RQBE Reporting
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GSCHAPG .FRX
Detail
Customer Phone List

Phone Contact

Figure 10: GSCHAP6 Report Form Showing Centered Headings
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Doing the Query
1. Choose RQBE - GSCHAPS5 from the Window menu.

2. Choose Do Query.

Notice that the report now reflects the changes that you made to the
GSCHAP6 report form. See Figure 11.
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Windouw ROBE

Company

Add Associates

Advantage Computer School

American Forum
Atec Data Service

Automated Mayo Miley
Azimuth Bavis & Systems

Azimuth Corp
Battery Weaver

Belmar Fishing Systems

Belmar Tronixs Computer
Big Incorporated
Blake Inc.

Bob Leuis Walker & Jackson

& S Computing & Systems
< More >

« Done »

Customer Phone List

Phone

415/837-2816
4088/946-1317
8685/682-5580
488/246-5353
714/548-60862
415/989-16083
619/271-8518
415/952-7761
415/323-2469
2137452-9369
818/762-5886
4157992-08710
213/533-7332
415/864-7557
619/564-2889
415/325-4385

Column: a

Contact

Len Silverman
Duane Marshall
Gui Dupuy

Randy Keji

Bill Hopkins
Chuck Heitmeier
Al Reetz

Brian Case

Mike Ozer

Andy Rigney
Bert Dalgleish
Bob Dot

Dan Tillotson
Bill Kane

Larry Uan Lockern
Parky Kmickle

City

Novato

San Jose
Santa Barbara
Santa Clara
Orange

San Francisco
San Diego
S.San Francisco
Menlo Park
Santa Monica
N. Hollyuocod
Daly City
Long Beach
San Francisco
San Diego
Menlo Park

Figure 11: Page Preview Window Showing Centered Headings
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Try making a few changes to achieve a more polished look.

Placing and Sizing a Box in a Report Form

1. Choose Done from the bottom of the Page Preview win-
dow then choose GSCHAP6.FRX from the Window
menu.

2. Position the cursor in the Report Layout window where
you want the upper left corner of the box to appear.

3. Choose Box from the Report menu.

4. Size the blinking box so that it frames the field headings:
(Figure 12)

e With the keyboard, press the Right and Down
Arrow keys to stretch the box, then press Enter.

e With the mouse, point to the lower right corner of
the box and drag, then release the mouse button.

Moving Fields in a Report Form

1. Move the DATE() field to the top left corner of the PgHead
band. (Figure 12) DATE() is a FoxPro function that
returns the current system date when you run your
report:

e With the keyboard, position the cursor on DATE(),
press the Spacebar to select it, then press the
arrow keys to move DATE() to the top left corner of
the PgHead band. Press Enter to confirm the
move.

e With the mouse, point to DATE( ), then drag DATE( )
to the top left corner of the PgHead band.

2. Repeat the above steps to move PAGE and _PAGENO to the
top right corner of the PgHead band. You’'ll need to
scroll right to see these fields — the system memory
variable _PAGENO appears as _PAG on your screen be-
cause its display width is defined as 4. For informa-
tion on changing field widths refer to the Report
Writer chapter of the FoxPro User’s Guide.
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GSCHAP6
Page Footer
Customer Phone List

Company Phone Contact

Figure 12: Report Layout Window with Box and Moved DATE( ) Field
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Doing the Query

Choose RQBE - GSCHAPS5 from the bottom of the Window
menu then choose Do Query.

Again, the changes you made to the GSCHAP6 report form are reflected in
the report that is displayed. See Figure 13.
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Program Windou

ROBE

84/84/91

Customer

Phone List

Page

Company

Phone

Contact

City

jAdd Associates

JAdvantage Computer School

iAmerican Forum
jAtec Data Service
jAutomated Mayo Miley

Azimuth Bavis & Systems

jAzimuth Corp
Battery Weaver

Belmar Fishing Systems
Belmar Tronixs Computer

Big Incorporated
Blake Inc.

Bob Leuis Walker &
Bulldog Inc.

[Business M. Business

415/897-2818
408/946-1317
805/682-5580
408-/246-5353
714/540-60862
415/989-1603
619/271-8518
415/952-7761
415/323-2469
2137452-9369
818/762-5886
415/992-8718
213/533-7332
415/864-7557
619/564-2809

& S Computing & Systems 415/325-4385

« Done » < More >

Column: %]

Len Silverman
Duane Marshall
Gui Dupuy

Randy Keji

Bill Hopkins
Chuck Heitmeier
Al Reetz

Brian Case

Mike Ozer

Andy Rigney
Bert Dalgleish
Bob Dot

Dan Tillotson
Bill Kane

Larry Uan Lockern
Parky Kmickle

Novato

San Jose
Santa Barbara
Santa Clara
Orange

San Francisco
San Diego
S.San Francisco
Menlo Park
Santa Monica
N. Hollyuood
Daly City
Long Beach
San Francisco
San Diego
Menlo Park

Figure 13: Page Preview Showing Box and Moved Fields
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Once the report looks exactly the way that you want it to, you can
change the output destination so the report is actually sent to the
printer, if you have one available. If you don’t have a printer, choose
Done to return to the RQBE window then skip to the last step box on this

page.

Changing the Output Destination
1. Choose Done to return to the RQBE window.
2. Check the Options... check box.
3. Deselect the Preview Report/Label check box.
4

. Check the To Printer check box in the Output Destinations
area of the RQBE Display Options dialog (Figure 14)
then choose OK.

5. Make sure your printer is ready. If not, nothing will hap-
pen.

. Choose Do Query. Figure 15 shows the printed report.

Save this report and query for later use.

Closing RQBE and the Report Layout Window
1. Choose Save as... from the File menu.

2. Make sure TUTORIAL is showing on the Directory popup
control. Type GSCHAP6 in the text box then choose
Save.

3. Close the RQBE window.

4. Close the report window then choose Yes when FoxPro
asks about saving changes.
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ROBE Display Options: ()lltpllt
— Formatting Options —m8 — Output Destinations Destinations
C > Screen Display [X1 To Printer
C+> Report [ 1 To File Area
< > Label L 1 Overurite File
[X1 ReportsLabel Form Name [ 1 Use Printer Setup
GSCHAP6 in Report/Label Form
[X] Quick Report... [X] Ouverurite

[ 1 Previeu Report/Label
[ 1 Shou Summary Info Only
[X1 Eject Page Before Report « OK »
[ 1 Report Heading
< Cancel >
[ 1 Suppress Column Headings
C > Console On (-> Console Off
[ 1 Pause Betueen Screens

Figure 14: RQBE Display Options Dialog

84/84/91 Customer Phone List Page 1

@ @

Company Phone Contact City St]

Add Associates 415/897-2818 Len Silverman Novato cAa

@ Advantage Computer School 488/946-1317 Duane Marshall San Jose ch @
American Forum 885/682-5588 Gui Dupuy Santa Barbara cA
Atec Data Service 488/246-5353 Randy Keji Santa Clara caA
Automated Mayo Miley 714/548-6862 Bill Hopkins Orange Ca

@ Azimuth Bavis & Systems  415/989-1683 Chuck Heitmeier San Francisco CA 0
Azimuth Corp 619/271-8518 Al Reetz San Diego ca |
Battery Ueaver 415/952-7761 Brian Case S.San Francisco CA

[ ) Belmar Fishing Systems 415/323-2469 Mike Ozer Menlo Park cA @
Belmar Tronixs Computer 213/452-9369 Andy Rigney Santa Monica ca
Big Incorporated 818/762-5886 Bert Dalgleish N. Hollyuwoad cA
Blake Inc. 415/992-8718 Bob Dot Daly City CA

Q Bob Lewis Walker & 2137533-7332 Dan Tillotson Long Beach CA @
Bulldog Inc. 415/864-7557 Bill Kane San Francisco cA
Business M. Business 619/564-2889 Larry Uan Lockern San Diego CA
C & S Computing & Systems 415/325-4385 Parky Kmickle Menlo Park cA

@ | C. Graph Systems 415/229-1488 Cindy Summerley Martinez A | @
Cameron Design Vogeltanz 714/858-4656 John Wigal Huntington Bch CA
Canadian International 415/781-4564 Jerry Aluiston San Francisco ca
Carolina Systems 6197481-4894 Rich Schuartz Solano Beach cA

@ Carsonville W. B. 415/283-7568 David Reiss Lafayette th | @
Cascade Rumberg & 415/863-8219 Greg Gubboney San Francisco ca
Cezar Beach Services 619/265-5983 Zarina Marshall San Diego cA

® Clover Data Inc. 415/651-8696 Bob Kieckheser Fremont cA &
Coleman Ltd 787/444-3358 Adam H. UWeinsaft Eureka cA
Computeach 415/881-2383 George Hedgepath Hayuward cA
Computer Bud 415/825-7484 Phil Linak Concord cA

@ Computer Technologies 415/276-7868 John Mouery San Leandro cA @
Control Communication & 818/796-5398 Robert Totah Arcadia cA
Corporate Romtec 714/544-2134 Kevin Driemeir Tustin CA
Designer Greenhouses 714/553-5985 Bill Mostou Irvine |

\ Designer Komputers Group 289/477-5675 Alan Au Stockton

213/865- d Steven: erritos

Figure 15: Printed Report
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Reporting with Multiple
Databases

In this session, you'll see how easy it is to use the
RQBE window to design and generate reports
from multiple databases.

¢ Connecting Multiple Databases . . . . page 4
® Grouping YourData . . . ... ... page 12
® Changing Band Size .. ... ... page 14
® Creating a Computed Field . . . . . page 16
® Suppressing Repeated Values . . . page 20
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Reporting with Multiple Databases

In the last chapter you created a phone list report using one database
and RQBE. In this chapter you will gather information from two
databases to create a report.

Begin with the query that you saved at the end of the last chapter.

Opening an Existing Query

1. Choose Open... from the File menu. Make sure
TUTORIAL is showing on the Directory popup control
and Query is showing on the Type popup control.

2. Open GSCHAP6.QPR. (Figure 1)
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Databases Output Fields Output To

21 COMPANY [X1 Select Fields... Report/Label
PHONE

k4
k4
3 CONTACT [X] Order By...
k4
3
k4

»CUSTOMER

CITY [X] Options...
1t STATE [ 1 Group By...
[ 1 Having... < See SQL >

< Add >

< Clear > « Do Query »

Field Name Example Up~Lo Select
Criteria

$ CUSTOMER. STATE 'cA" [1
<Insert>

<Remove>

< Or >

Figure 1: GSCHAP6.QPR
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You'll send the output to a Browse window first so that you can scroll
through the data, then you’ll add the INVOICES database.

To report on multiple databases, the databases must have something in
common. CUSTOMER.DBF and INVOICES.DBF both have CNO, a customer
number, in common. CNO is a link between CUSTOMER.DBF and IN-
VOICES.DBF that is sometimes called the join condition.

Your report will list invoices for each company in California.

Connecting Multiple Databases
1. Choose Browse from the Output To popup.

2. Choose the Add push button below the Databases list,
then choose INVOICES.DBF. The RQBE Join Condition
dialog appears.

3. Select INVOICES.CNO from the left popup. Like appears
on the center popup by default. Select
CUSTOMER.CNO from the right popup. (Figure 2)

4. Choose OK. The solid bar next to INVOICES.CNO
indicates that CUSTOMER.DBF and INVOICES.DBF are
linked. (Figure 3)

5. Choose the Select Fields... check box in the RQBE win-
dow.

6. Remove CUSTOMER.CITY and CUSTOMER.STATE from the
Selected Output list.

7. Select INVOICES.IDATE and INVOICES.ITOTAL from the
Database Fields list and choose Move —. You'll
have to scroll to see these fields.

8. Choose OK. The RQBE window appears as in Figure 3.

9. Choose Do Query. The results appear in a Browse win-
dow as in Figure 4.
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ROBE Join Condition:

INUOICES. CNO “ [ 1 NOT Like “ CUSTOMER. CNO 4“
[ 1 Ignore Upper/Louer Case « 0K » —_—
< Cancel >

Figure 2: RQBE Join Condition Dialog

Databases Output Fields Output To
CUSTOMER $ 1t COMPANY [X] Select Fields...
»INUOICES 3 PHONE
3 CONTACT [X1 Order By... SESSION3
3 IDATE [ 1 Options...
3 ITOTAL [ 1 Group By...
< Add > k3 [ 1 Having... < See SQL >
< Clear > « Do Query »
Field Name NOT Example Up~Lo Select
Criteria
$] INUOICES. CNO [ 1 Like CUSTOMER. CNO [1
% CUSTOMER. STATE [ 1 Like 'ca" [ 1] <Insert>
<Remove>
< Or >

Figure 3: RQBE Window

GSCHAP6
Company Phone Contact

Atec Data Service 488/246—5353Randy Ke ji |

Atec Data Service 488/246-5353| Randy Keji

Atec Data Service 488/246-5353| Randy Keji

Atec Data Service 488/246-5353| Randy Keji

Atec Data Service 488/246-5353| Randy Ke,ji
Automated Mayo Miley 714/540-60862|Bill Hopkins
Azimuth Corp 619/271-8518| A1 Reetz

Belmar Tronixs Computer 2137452-9369]| Andy Rigney

C. Graph Systems 415/223-14088| Cindy Summerley
Carsonville W. B. Associates 415/283-7568| David Reiss
Computeach 415/881-2383| George Hedgepath
Computer Technologies 415/276-7868| John Mouery
Designer Greenhouses 714/553-5985|Bill Mostov
Designer Greenhouses 714/553-5905|Bill Mostov
Designer Komputers Group 289/477-5675|Alan Au

Dr. Micro Consulting 488/733-1479|0liver Ansarti

Figure 4: Query Results
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The fields look fine but if a company has more than one invoice, the
invoices are not in any particular order.

Let’s order the invoices according to company and invoice date and do
the query again.

Ordering Fields
1. Close the Browse window.
2. Choose the Order By... check box.

3. Select INVOICES.IDATE in the Selected Output list and
choose Move —.

4. Choose OK. The RQBE window appears. (Figure 5)

5. Choose Do Query. The data appears in a Browse win-
dow. (Figure 6)
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Output Fields

CUSTOMER $ 11 COMPANY
»INUOICES £ 3 PHONE
: CONTACT
$ 2t IDATE
3 ITOTAL

< Add > k3

< Clear >

Reporting with Multiple Databases

[X1 Select Fields..
[X1 Order By...

[ 1 Group By...
[ 1 Having...

Output To

. Brouse

SESSION3
[ 1 Options...

< See SQL D>
« Do Query »

Field Name

Example

Up~Lo Select

$] INVOICES. CNO
$ CUSTOMER. STATE

CUSTOMER. CNO
llcnll

Criteria
[1
[ 1] <Insert>
<Remove>

< Or >

Figure 5: RQBE Window

Company

GSCHAPG
Phone

Contact

Atec Data Service 488-246-5353

Atec Data Service

Atec Data Service

Atec Data Service

Atec Data Service
Automated Mayo Miley
Azimuth Corp

Belmar Tronixs Computer
C. Graph Systems

Carsonville W. B. Associates

Computeach

Computer Technologies
Designer Greenhouses
Designer Greenhouses
Designer Komputers Group
Dr. Micro Consulting

408/246-5353
408/246-5353
4087246-5353
40887246-5353
714/548-6862
619/271-8518
2137452-9369
415/229-14088
415/283-7568
415/881-2383
415/276-7868
714/553-53085
714/553-59085
2897477-5675
4088/733-1479

Randy Keji

Randy Keji
Randy Keji
Randy Keji
Randy Keji

Bill Hopkins

Al Reetz

Andy Rigney
Cindy Summerley
David Reiss
George Hedgepath
John Mouery
Bill Mostov
Bill Mostou
Alan Au

Oliver Ansarti

Figure 6: Query Results
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Now that the information is well organized, let RQBE build a report for
you.

Generating a Report with RQBE
1. Close the Browse window.

2. Choose Report/Label on the Output To popup in the RQBE
window.

3. Check the Options... check box in the RQBE window.

4. Choose the Report radio button in the RQBE Display
Options dialog.

5. Choose the Quick Report... check box.

6. In the RQBE Quick Report dialog, type
TUTORIAL\GSCHAP7.FRX in the Save as text box.
Simply type over the name that’s already in the text
box (Figure 7) then choose OK.

7. Choose OK in the RQBE Display Options dialog.

8. Choose Do Query. The Page Preview window appears.
(Figure 8)

G7-8 Relating Data



Reporting with Multiple Databases

ROBE Quick Report:

(+) Column Layout
C > Form Layout

Report Width

S VEENS TUTOR IALNGSCHAP? . FRX

« 0K »

Fieldl FieldZ
XXXXXX XXXXXX
XXXXXX XXXXXX
XXXXXX XXXXXX

< Clear

>

Figure 7: RQBE Quick Report Dialog

System File Edit Database

Record Program

Windou

RQBE

Service
Service
Service
Service
I Service
Automated Mayo Miley
jAzimuth Corp
Belmar Tronixs Computer
C. Graph Systems
Carsonville W. B. Associates
Computeach
Computer Technologies
Designer Greenhouses
Designer Greenhouses
Designer Komputers Group
Dr. Micro Consulting

« Done » < More > Column:

Figure 8: GSCHAP7 Report Form

Relating Data

408/246-5353
4087246-5353
408-246-5353
408-246-5353
488/246-5353
714/548-6062
619-/271-8518
2137452-9369
415/229-1488
415/283-7568
415/881-2383
415/276-7860
714/553-5985
714/553-59085
289/477-5675
488,733-1479
3]

Contact

Randy Keji
Randy Keji
Randy Keji
Randy Keji
Randy Keji
Bill Hopkins
Al Reetz
Andy Rigney

Cindy Summerley

David Reiss

George Hedgepath

John Mouery
Bill Mostou
Bill Mostou
Alan Au
Oliver fAnsarti

in the Page Preview Window

Idate

85717730
085726790
85/28/98
85738-98
85731/38
8570830
8570838
85/18-90
85712798
85/87/98
857187398
85711798
857089730
85719798
85/12/390
8571573908
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G7-10

Now try some cosmetic work.

Moving Fields and Placing a Box in a Report
1. Choose Done in the Page Preview window.

2. Choose Open... from the File menu. Make sure
TUTORIAL is showing on the Directory popup control
and Report is showing on the Type popup control.

3. Select GSCHAP7.FRX then choose Open. The Report
Layout window appears. (Figure 9)

4. Move the field headings down to the third PgHead band
over the appropriate fields.

5. Move the DATE() field to the top left corner of the PgHead
band. Scroll right to see the _PAGENO field. Move
_PAGENO to the top right corner of the PgHead band.
Move the word “Page” also.

6. Type Invoice Report on the top line of the PgHead
band and press Enter.

7. Center the title.

8. Place and size a box so that it frames the field headings.
Your screen should look like Figure 10.
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PgFoot
PgFoot
PgFoot
PgFoot

Figure 9: GSCHAP7 Report Form

Invoice Report

Phone Contact

Figure 10: GSCHAP7 Report Form with Title, Centered Headings and
Box
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GT7-12

When your data is ordered by a field, such as COMPANY, you can use the
Report Writer to group all the information about each company.

In these next few steps you will create a data grouping for the COMPANY
field. Let’s do it now.

Grouping Your Data

1. Choose Data Grouping... from the Report menu. The
Group dialog appears.

2. Choose the Add push button in the Group dialog. The
Group Info dialog appears.

3. Type company in the Group... text box. (Figure 11)

4. Choose OK in the Group Info dialog. The Group dialog
appears. (Figure 12)

5. Choose OK in the Group dialog.
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Group Info:
< Group... >
Options:
« OK »
Neu Page
Suap Page Header < Cancel >

Suap Page Footer
Reprint Header
Reset Page Number

[N N N N
e bd bd b bd

# of rous follouwing header: [

Figure 11: Group Info Dialog

Group:

« Q0K »
ooy |
?
!
$ < pdd >
!
t < Change >
!
! < Delete >

Figure 12: Group Dialog
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When you grouped the data, the Report Writer added two bands to the
report form:

e The group header band, just above the detail band, is printed each
time the group changes.

e The group footer band, just below the detail band, is printed each
time the group changes.

In the current example, the group header and group footer will be
printed each time COMPANY changes.

Changing Band Size and Copying a Field
1. Change the size of the group footer band:

e With the keyboard, place the cursor in the group
footer area of the report form and choose Add
Line from the Report menu.

e With the mouse, point to “1-company” in the
group footer band and drag the mouse down.

2. Select field ITOTAL and choose Copy from the Edit menu.
Place the cursor in the bottom line of the group footer
band under field ITOTAL and choose Paste from the
Edit menu. (Figure 13)

Once information is grouped, you can perform calculations on each
group, put headers and footers on each group, and so on.
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Group Header Band

GSCHAP? .FRX
Page Header
PgHead Invoice Report
PgHead

Phone Contact Idate Itotal

Figure 13: GSCHAP7 Report Form

Group Footer Band with Added Line Copied ITOTAL Field
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The group footer is also used to do calculations on the information that
appears in the details for the group.

In the group footer for ITOTAL, let’s add the data in all the ITOTAL fields
in the group.

Creating a Computed Field

1. In the group footer, choose ITOTAL to display the Report
Expression dialog:

e With the keyboard, place the cursor on ITOTAL
and double-click with the Spacebar.

e With the mouse, point to ITOTAL and double-click.

2. Choose the Calculate... check box to display the Calcu-
late Field dialog. (Figure 14)

3. Choose the Sum radio button then choose OK. The
Report Expression dialog reappears. (Figure 15)

4. Choose OK.
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Reset: company

Calculate: Nothing

Count

Sum

Average
Louest

Highest

Std. Deviation

Variance

AAAAAAAN
W W W W W W W W

< Cancel >

Figure 14: Calculate Field Dialog

Report Expression:

< Expr... > ETEVSNSSS

< Fornat... > N idth: WE

[ 1 Style... [ 1 Suppress...

[X1 Calculate...
[ 1 Comment...

« QOK » < Cancel >

Figure 15: Report Expression Dialog
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Place a line between the two ITOTAL fields, then do the query to see the
results of your change.

Drawing a Line
1. Place the cursor below the “i” in the top ITOTAL field.
2. Choose Box from the Report menu.
3. Turn the blinking box into a line: (Figure 16)

e With the keyboard, use the arrow keys to shrink
the box to a line, press the Right Arrow until the
line is the desired length then press Enter.

e With the mouse, click on the box and drag until
the box has no depth and the line is the desired
length, then release the mouse button.
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GSCHAP? .FRX
Page Header
Invoice Report

Phone Contact Idate Itotal

Figure 16: GSCHAP7 Report Form
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Doing the Query
1.
2.

Choose RQBE — GSCHAP®6 from the Window menu.

Choose Do Query. The Page Preview window appears.
(Figure 17)

The report looks very good, but let’s make it even better.

When a company has more than one invoice, the company information is
repeated for each invoice.

Your report will be easier to read if this information is not repeated for
each invoice.

G7-20

Suppressing Repeated Values in a Report
1.
2.
3.

Choose Done in the Page Preview window.
Choose GSCHAP7.FRX from the Window menu.

Choose the COMPANY field to display the Report Expres-
sion dialog:

e With the keyboard, place the cursor on COMPANY
and double-click with the Spacebar.

e With the mouse, point to COMPANY and double-
click.

Check the Suppress... check box. The Suppress Repeated
Values dialog appears.

Choose the On radio button in the Suppress Repeated
Values dialog (Figure 18) then choose OK.

. Choose OK in the Report Expression dialog.
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System File Edit Database Record Program Windouw ROBE

B4/38/91 Invoice Report

Company Phone Contact Idate

Data Service 4887/246-5353 Randy Keji 857177908
Data Service 4887246-5353 Randy Keji 85726798
Data Service 488/246-5353 Randy Kegji 85728798
Data Service 4887/246-5353 Randy Keji 85-/38/90
Data Service 488/246-5353 Randy Keji 85731798

jAutomated Mayo Miley 714/540-60862 Bill Hopkins 85/08/90

jAzimuth Corp 619/271-8518 Al Reetz 85/088/90

Belmar Tronixs Computer 2137452-9369 Andy Rigney 857108/98

« Done » < More > Column: 4

Figure 17: GSCHAP7 Report in Page Preview Window

Suppress Repeated Ualues:

(+> On C ) Off

<« 0K »

Reset: < Cancel >

company n

Figure 18: Suppress Repeated Values Dialog
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This report will look better with a blank line between the invoices for
each different company.

Add a group footer band to place a space between groups.

Changing the Size of a Band
1. Add another group footer band. (Figure 19)

2. If necessary, move ITOTAL back up to the second group
footer band, under the line. (Figure 19)

3. Choose RQBE — GSCHAPS6 from the Window menu.

4. Choose Do Query. Your report should appear as in
Figure 20.
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GSCHAP? .FRX

Page Header

Invoice Report

Phone

Contact

Idate

Itotal

Group Footer Band with Added Line

Figure 19: GSCHAP7 Report Form

phone ——Joontact ———— Jidate |

Space Added by Group Footer Band

System File Edit Database Record Program UWindouw

RQBE

04/38-91

Invoice Report

Company

Phone

Contact

Idate

Itotal

Atec Data Service

« Done » < More >

488/246-5353
488/246-5353
488/246-5353
4088/246-5353
488/246-5353

714/540-6062

619/271-8518

Randy Keji
Randy Keji
Randy Keji
Randy Keji
Randy Keji

Bill Hopkins

Al Reetz

85717798
85726798
85728798
85738-90
85/31/98

85/08/908

08570830

2721.
441.
744.
163.
762.

Figure 20: GSCHAP7 Report with Repeated Values Suppressed
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Now that’s a polished report! Go ahead and send this report to the
printer, if you have one available. If you don’t have a printer, choose
Done from the Page Preview window then skip to the last step box.

Sending a Report to the Printer
1. Choose Done from the Page Preview window.
2. Choose the Options... check box in the RQBE window.

3. Uncheck the Preview Report/Label check box in the RQBE
Display Options dialog.

4. Choose the To Printer check box in the Output Destina-
tions area. (Figure 21)

5. Choose OK.

6. Choose Do Query. The printed report is represented in
Figure 22.

Save this report and query and take a break.

Saving a Report and Query
1. Choose Done from the Page Preview window.
2. Choose Save as... from the File menu.

3. Make sure TUTORIAL shows on the Directory popup
control, type GSCHAP7 in the text box then choose
Save.

4. Close the RQBE window.

5. Close the report window then choose Yes when FoxPro
asks about saving changes.
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ROBE Display Options:

— Formatting Options Output Destinations
C > Screen Display [X]1 To Printer
C+> Report [ 1 To File
C > Label [ 1 Overurite File
[X1 Report/Label Form Name

GSCHAP? . FRX

[X]1 Quick Report... [ 1 Overurite
[ 1 Previeuw Report/Label

[ 1 Shou Summary Info Only « OK »
[X]1 Eject Page Before Report
[ 1 Report Heading < Cancel >

[ 1 Suppress Column Headings
C ) Console On (<) Console Off
[ 1 Pause Betueen Screens

Figure 21: RQBE Display Options Dialog

85781791 Invoice Report Page 1

Company Phone Contact IDate ITotal @
Atec Data Service 488/246-5353 Randy Keji 85/17/98 2721.19
© 408/246-5353 Randy Keji 85726798  441.91
488/246-5353 Randy Keji 85728798 744.49
488/246-5353 Randy Keji 85738798  163.72

488/246-5353 Randy Keji 85/31/98  762.56 ®
4833.87

Automated Mayo Miley 714/548-6062 Bill Hopkins 85/88798 2336.34 @
2336.34

Azimuth Corp 619/271-8518 Al Reetz 085/08/98 20847.88 )
2047.88

Belmar Tronixs Computer 2137452-9369 Andy Rigney 85716798 2353.43 @
2353.43

C. Graph Systems 415/229-1488 Cindy Summerley 85712798 1642.85 @
1642.85

Carsonville W. B. Associates 415/283-7568 David Reiss 85/87/98 1108.24 @
1108.24
Computeach 415/881-2383 George Hedgepath 85/18798 1379.92

1379.92 %
Technologies uery 85/11/9

Figure 22: Printed Report
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In this session, you’ll learn to format fields in
reports, include totals, and add user functions to

More Reporting

your reports.

Including Functions in a Query . . . . page 4
GroupingData . . . ... ....... page 8
Ordering Data by Functions . . . . . page 10
FormattingData . . . . . ... ... page 18
Creating a Summary Band . . . . . page 24
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More Reporting

In the last session you used RQBE to design and generate a report using
information from two databases. In this session you’ll learn to include

functions and group the data in your query.

Begin by creating a new query.

Opening the RQBE Window

1. Choose New... from the File menu, choose the Query
radio button then choose OK.

2. Make sure TUTORIAL appears on the Directory popup
control then select CUSTOMER.DBF and choose Open.
The RQBE window appears as in Figure 1.
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ROBE — UNTITLED
Databases Output Fields Output To

»CUSTOMER CNO Select Fields...
COMPANY
CONTACT Order By...

ADDRESS [ 1 Options...
CITY Group By...
STATE Having. .. < See SQL >
<« Do Query »

LA X X X

< Add >
< Clear >

Field Name NOT Example U~L Select
Criteria

<Insert>
<Remove>

< Or >

Figure 1: RQBE Window
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Previously, you've specified fields to include in the query output. Youlll
now learn to include functions. The SUM() function is a function that
adds information in a field.

The results of a specified function appear as a column in your Browse
window or report. Try specifying a few functions.

Including Functions in a Query

1. Choose the Select Fields... check box, then choose
Remove All to clear the Selected Output list.

2. Choose CUSTOMER.STATE from the Database Fields list
and choose Move —.

3. For each bullet line below, select the first item from the
Functions popup and select the second item from the
corresponding submenu (Figure 2) then choose
Move —.

e AVG() and CUSTOMER.YTDPURCH
e COUNT() and *

e SUM() and CUSTOMER.YTDPURCH
e MIN() and CUSTOMER.YTDPURCH

e MAX() and CUSTOMER.YTDPURCH

4. When the RQBE Select Fields dialog appears as in Figure
3, choose OK.
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Database Fields Selected Output

CUSTOMER. CNO > D
CUSTOMER. COM|
CUSTOMER. CON|] CUSTOMER. CNO + D>
CUSTOMER. ADD] CUSTOMER. COMPANY
CUSTOMER.CIT| CUSTOMER.CONTACT
CUSTOMER. STA] CUSTOMER. ADDRESS e >
CUSTOMER. ZIP| CUSTOMER.CITY
CUSTOMER. PHO| CUSTOMER. STATE All>
CUSTOMER. ZIP
— Functions/| CUSTOMER.PHONE [ 1 No Duplicates
[ CUSTOMER. ONO

CUSTOMER. STATE

LA K X R X X X 7

COUNTO»| | CUSTOMER. YTDPURCH « OK »
SUMO
AUGCO
—] MINO

1 MAXO

CUSTOMER. LAT
CUSTOMER. LONG < Cancel >

YyYYyYVvVYyY

Submenu

Functions Popup

Figure 2: RQBE Select Fields Dialog

Database Fields Selected Output
CUSTOMER. CNO c < Move » > |3 CUSTOMER. STATE
CUSTOMER. COMPANY c 3 AUGCCUSTOMER. YTDPURCH
CUSTOMER. CONTACT c < All » > |¢ COUNT(Co
CUSTOMER. ADDRESS C k2 SUM(CUSTOMER. YTDPURCH
CUSTOMER. CITY c k2 MINCCUSTOMER. YTDPURCH
CUSTOMER. STATE c < Remove > |t MAXCCUSTOMER. YTDPURCH
CUSTOMER. ZIP c 3
CUSTOMER. PHONE c <Remove All> |3

—— Functions/Expressions [ 1 No Duplicates
[ 1 Cross Tabulate
« OK »
]
< Cancel >

Figure 3: RQBE Select Fields Dialog with Functions/Fields Selected
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Now that you have selected the fields, you can order them by state.

Ordering the Data by State
1. Choose the Order By... check box in the RQBE window.

2. Move CUSTOMER.STATE to the Ordering Criteria list
(Figure 4), then choose OK.
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Selected Output Ordering Criteria
CUSTOMER. STATE < Move » > ¥ 1t CUSTOMER. STATE
AUGCCUSTOMER. YTDPURCHD! k3
COUNTGo < Remove > ks
SUMCCUSTOMER. YTDPURCH> k2
MINCCUSTOMER. YTDPURCH> Order Options k3
MAXCCUSTOMER. YTDPURCH>| |<(-> Ascending k4

C ) Descending 3
k3
k2

« OK » 3
3
< Cancel > k2

Figure 4: RQBE Order By Dialog
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G8-8

Group By... is the next new feature that you'll use. Group By... takes
your data and groups it based on fields and functions that you specify.

In this report you want the information grouped by state. Go ahead and
group the data by state.

Grouping the Data by State

1. Choose the Group By... check box in the RQBE win-
dow.

2. Move CUSTOMER.STATE to the Group By Fields list
(Figure 5), then choose OK.

You are now ready to do the query and see the results.

Doing the Query
1. Choose Do Query.

2. Size the Browse window so that it stretches across your
screen. (Figure 6)
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Database Fields

Group By Fields

CUSTOMER. CNO < Move -+ > 3 CUSTOMER. STATE

CUSTOMER. COMPANY k3

CUSTOMER. CONTACT < Remove > kS

CUSTOMER. ADDRESS t

CUSTOMER. CITY t

CUSTOMER. STATE k3

CUSTOMER. ZIP 3

CUSTOMER. PHONE « OK » ks

CUSTOMER. ONO t

CUSTOMER. YTDPURCH < Cancel > £

Figure 5: RQBE Group By Dialog
! R 0

State|Avg_ytdpur Cnt Sum_ytdpur Min_ytdpur|Max_ytdpur
AK 14820.12 1 14828.12] 14820.12| 14828.12
AL 6271.24 2 12542.48 2244.58| 18297. 99|
AR 1688. 87 1 1688. 87 1688.087 1688.87
AZ 3918.37 8 31282.95 348.34| 17777.86
BC 2200.21 1 2208.21 2208. 21 22808.21
cA 3713.22 123H 456726. 45 18.16| 17623.25
co 2916.69 9 26250. 20| 161.78] 12995.31
CT 1843.28 9 16589. 55 80.04 3452.82
DC 44.581 1 44,50 44.58 44.50
DL 283.93 1 283.93 283.93 283.93
FL 3237.44 25 808936. 02 129.22| 16005.92
GA 3224.21 12 38690.51 285.14] 12277.45
HI 7296.18 3| 21888.29 2982.70 9829. 83|
IA 194?.91W 2 3895.81 335.37 3560. 44
1D 4399.12 1 4399.12 4399.12 4399.12
IL 3266.88 24 78386.02 58.89 7919.49
IN 2430.33 5 12151.66 1336.81 5311.38
KS 956.69 3 2870.07 247.88 2074.65

Figure 6: Browse Window with Functions

More Reporting
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That was pretty amazing, but the best is yet to come. How about or-
ganizing the data by average so that the company with the highest
average year-to-date purchases is displayed first, followed by the com-
pany with the next highest average, and so on.

Ordering the Data by Average Year-to-Date Purchases
1. Close the Browse window.

2. Choose the Order By... check box.

3. Remove CUSTOMER.STATE from the Ordering Criteria list.
4

. Choose the Descending radio button in the Order Options
area of the RQBE Order By dialog.

5. Move AVG(CUSTOMER.YTDPURCH) to the Ordering
Criteria list (Figure 7) then choose OK.

6. Choose Do Query. The Browse window appears.
(Figure 8)

You can order by functions as easily as by fields!
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Selected Output Ordering Criteria

CUSTOMER. STATE < Move + >
AUGCCUSTOMER. YTDPURCH>
COUNTC| < Remove >
SUMCCUSTOMER. YTDPURCH>

+ | AUGCCUSTOMER.YTDPU
t
t
t
. MINCCUSTOMER. YTDPURCH>| - Order Options — [$
Descending | | yaxccustoner. vtopuReH>| [¢ > Ascending t
Radio (+> Descending 3
Button i
t
t
t

<« 0K »

< Cancel >

Figure 7: RQBE Order By Dialog

State|Avg_ytdpur Sum_ytdpur Min_ytdpur|Max_ytdpur
e tssze Al Al tdsze. ol tdsze.1a| idsze- 12
WU 9558. 62 2 19117.23 4323.57 14793.66
7296. 21888. 2982. 9829.
6271. 12542. 2244. 18297.
5638. 5638. 5638. 5638.
5276. 31658. 1123. 11787.
50819. 5819. 5819. 5819.
4399. 4399. 4399, 4399.
4185. 58600. 59s. 11606.
4132. 28926. 1210. 11433.
40833. 24201. 1187. 12485.
3918. 31282. 348. 17777.
3838. 15354. 92Z6. 18974.
3713. 456726. 18. 17623.
3628. 58853. . 11174.
3628. 166896. 32. 17548.
3601. 3601. 36061. 3601.
3293. 32936. 350. 9521.

3
2
1
6
1
1
14
?
6
8
4

Figure 8: Browse Window with Companies Ordered By Average
Year-to-Date Purchases
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Now that you have the data you want, try putting it into a report form.

Generating a Report
1. Close the Browse window.
2. Select Report/Label from the Output To popup.

3. Choose the Options... check box to display the RQBE
Display Options dialog.

4. Choose the Report radio button.
5. Choose the Quick Report... check box.

6. Type TUTORIAL\GSCHAPS.FRX in the Save as text box in
the RQBE Quick Report dialog. Type over any name
that may already appear in the text box (Figure 9)
then choose OK.

7. Choose OK in the RQBE Display Options dialog.

8. Choose Do Query. The Page Preview window displays
your results. (Figure 10)
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ROBE Quick Report:

(> Column Layout
( > Form Layout Fieldl Field2
XXXXXX XXXXXX
Report Width XXXXXX XXXXXX

- UEREER TUTOR IALMNGSCHAPS . FRX

« 0K » < Clear >

Figure 9: RQBE Quick Report Dialog

State Avg_ytdpur Sum_ytdpur Min_ytdpur Max_ytdpur

14820.
19117.
21888.
12542.
5638.
31658.
5813.
4399.
58608.
28926.
24z01.
31282.
15354.
456726.
58053.
166896.

[

1
2
3
2
1
6
1
1
4
7’
6
8
4

Done » < More > Column:

Figure 10: Page Preview Window with GSCHAP8 Report
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Take a look at the report form you just created.

Opening a Report Form
1. Choose Done in the Page Preview window.

2. Choose Open... from the File menu popup. Make sure
TUTORIAL shows on the Directory popup control and
Report shows on the Type popup control.

3. Select GSCHAPS.FRX then choose Open. The report is
displayed. (Figure 11)

As you can see, Quick Report... places fields into the Report Layout win-
dow in a predictable way.

G8-14
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Sum_ytdpur Min_ytdpur Max_ytd

avg_ytdpur sum_ytdpur min_ytdp

Figure 11: GSCHAPS8 Report Form
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Take a moment to rearrange the header information as you’d like it to
appear. (Our example may look a little different than yours.)

Rearranging and Editing Fields in a Report Form
1. Edit the five abbreviated field headings:

o Select the Avg_ytdpur heading and choose Text from the
Report menu. You can now Backspace, Delete and
type just as you would in a word processor. Change
the heading to Avg and press Enter.

» Repeat the previous step for the Cnt, Sum_ytdpur,
Min_ytdpur and Max_ytdpur field headings so they ap-
pear as Count, Sum, Min and Max.

2. Move the field headings down to the third Page Header
band then center them over the appropriate fields.

3. Draw a box around the field headings. You may have to
move the fields and field headings to the right slightly
before you draw the box, as Figure 12 shows.

4. Move the DATE( ), PAGE and _PAGENO fields to the top line
in the Page Header.
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GSCHAPSB . FRX
Page Header
PgHead Page _PAG
PgHead
PgHead Count Sum Min Max
PgHead

betail § B DTNETIEENN U STRTETITEENN N TR

Figure 12: GSCHAPS8 Report Form with Edited and Rearranged
Headings and Box
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Because the numbers in this report represent dollar amounts, it would
be nice if they looked like dollar amounts in the report. To accomplish
this, you need to use formats.

When you specify a format, you tell FoxPro how the information in a
field should appear. In your report, you want the information to appear
like a dollar amount. Follow these steps, then we’ll discuss them in
more detail.

Formatting Data in a Report

1. Choose the AVG_YTDPUR field. Be sure to choose the
field and not the field heading:

e With the keyboard, position the cursor on the
field and press Enter.

e With the mouse, double-click on the field.

2. The Report Expression dialog appears with the field
automatically entered in the Expr... text box.
(Figure 13) Choose the Format... push button.

3. In the Format dialog, choose the Currency check box,
type 999,999,999.99 in the Format text box
(Figure 14) and choose OK.

4. When the Report Expression dialog appears as in Figure
15, choose OK.

5. Repeat the steps above for the SUM_YTDPURCH field.
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Report Expression:

< Expr... > avg_ytdpur
—— < Format... > Width: 16
[ 1 Style... [ 1 Suppress...
[ 1 Calculate... [ 1 Stretch Uertically
[ 1 Comment... [ 1 Float as Band Stretches

« 0K » < Cancel >

Figure 13: Report Expression Dialog

Format: Editing Options:
[ 1 Left Justify
C ) Character <(+) Numeric [ 1 Blank if Zero
C ) Date C ) Logical [ 1 (Negative)
[ 1 Edit “SET" Date
[ 1 British Date
[ 1 CR if Positive
[ 1 DB if Negatiuve
[ 1 Leading Zeros
[X]1 Currency
[ 1 Scientific
« 0K » < Cancel >

Figure 14: Format Dialog

Report Expression:

< Expr... > IR 0
< Format... > CEREEEREEEREEEREE] Width:

[ 1 Style... [ 1 Suppress...
[ 1 Calculate... [ 1 Stretch Uertically
[ 1 Comment... [ 1 Float as Band Stretches

« OK » < Cancel >

Figure 15: Report Expression Dialog

More Reporting
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The format that you specified for these two fields has two parts:

* @$ is entered automatically for you when you choose the Currency
check box. This represents the floating dollar sign so that the dollar
sign is printed just before the beginning of the number displayed in
the field. (For example, 4536292 is displayed $45,362.92)

* 999,999,999.99 determines how the number is displayed. Each nine
shows where the digits are displayed. The period shows where the
decimal point goes. The commas show where commas are placed, if
the number of digits requires their use.

This will become more clear when you see how the formatting affects the
output.

Practice on a few more fields.

Formatting Data in a Report

1. Choose the MIN_YTDP field. The report form shows
MIN_YTDP because of the width of the field.

2. Choose the Format... push button in the Report
Expression dialog.

3. Choose the Currency check box in the Format dialog, type
999,999.99 into the text box at the top of the dialog
then choose OK.

4. Type 10 in the Width text box in the Report Expression
dialog (Figure 16) then choose OK. Now the report
form shows MIN_YTDPUR because the field width has
been increased.

5. Repeat the steps above for the MAX_YTDPURCH field.

When specifying the last two formats, you needed to change the width of
the displayed field because you added a comma to the size of the output.
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Report Expression:

< Expr... >
< Format... > CEEEEEMEEEREE] Width:

[ 1 Style... [ 1 Suppress...
[ 1 Calculate... [ 1 Stretch Vertically
L 1 Comment... [ 1 Float as Band Stretches

« 0K » < Cancel >

More Reporting

Figure 16: Report Expression Dialog
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Run the report and take a look at how the formatting affected the
numbers.

Generating a Report
1. Choose RQBE - UNTITLED from the Window menu.

2. Choose Do Query. The Page Preview window appears.

(Figure 17)
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85/081/91 Page

State Aug Sum Min Max

AK $14,820.12
W $9,558.62
HI $7,29. 1@
AL $6,271.24
KY $5,638.50
MN $5,276.38
NM $5,019.53
ID $4,399.12
PA $4,185.73
uA $4,132.30
ur $4,033.53

$14,820.12 $14,820.12 $14,8286.
$19,117.23 $4,323.57 $14,793.
$21,888.29 $2,982.70 $9,829.
$12,542.48 $2,244.58 $18,297.
$5,638.50 $5,638.58 $5,638.
$31,658.29 $1,123.43 $11,707.
$5,019.53 $5,019.53 $5,019.
$4,399.12 $4,399.12 $4,399.
$58,600. 16 $595.46 $11,606.
$28,926.07 $1,218.92 $11,433.
$24,201.20 $1,187.86 $12,485.
Az $3,9108.37 $31,282.95 $348.34 $17,777.
LA $3,838.72 $15,354.89 $926.39 $18,974.
cA $3,713.22 $456, 726. 45 $18.16 $17,623.
OH $3,628.33 $58,853. 23 $136.77 $11,174.
NY $3,628.19 $166,896. 89 $32.50 $17,548.
« Done » < More > Column:

-
DOONDFRRORNWNR

Figure 17: Page Preview of GSCHAP8 with Formatted
Currency Fields
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There are two special bands that you haven’t seen yet. They are the
Title and Summary bands. These optional bands are used to create a
title and summary for your report.

Switch back to the report form and you’ll find out how to create an end-
of-report summary.

Creating a Summary Band
1. Choose Done in the Page Preview window.
2. Choose GSCHAP8.FRX from the Window menu.

3. Choose Title/Summary... from the Report menu. The
Title/Summary dialog appears.

4. Choose the Summary Band check box (Figure 18) then
choose OK. A Summary band is added. (Figure 19)

5. You may want to change the size of the PgFoot band so
that it’s only one line wide (Figure 19):

e With the keyboard: Position the cursor on the Pg-
Foot band to be removed. Choose Remove Line
from the Report menu.

e With the mouse: Point to the PgFoot band label
(far left) below the band to be removed and drag

up.

As you experiment with sizing the PgFoot band, notice that it is not
possible to remove a band that contains an object. You must first move
the object out of the band, or delete the object. This rule applies to any
of the report bands.
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Report Title:

[ 1 Title Band
[ 1 Neu Page

« OK »

Report Summary: < Cancel >

[X1 Summary Band
[ 1 Neu Page

Figure 18: Title/Summary Dialog

Summary Band

Rt 6C: 6] Summary
PgHead  YNX@]

PgHead
PgHead
PgHead

Detail e ord

PgFoot
Summaryl

Figure 19: GSCHAP8 Report Form with Summary Band
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Now that you have a Summary band, you need to decide what informa-
tion to put in it.

You've already computed a total field. Now you’ll place computed fields
in the Summary band.

1.
2.

10.

11.

G8-26

Placing Calculated Fields in a Summary Band

Add an extra line to the Summary band.

Copy all of the fields except STATE and paste them in the
appropriate spot on the bottom line of the Summary
band.

Draw a line above the fields in the Summary band.
(Figure 20)

Choose the AVG_YTDPUR field in the Summary band.

5. Choose Calculate....

In the Calculate Field dialog, choose the Average radio
button (Figure 21) then choose OK.

Choose OK in the Report Expression dialog.

Choose the CNT field and repeat steps 5-7 except choose
the Count radio button.

Choose the SUM_YTDPUR field and repeat steps 5-7 except
choose the Sum radio button.

Choose the MIN_YTDPUR field and repeat steps 5-7 except
choose the Lowest radio button.

Choose the MAX_YTDPUR field and repeat steps 5-7 except
choose the Highest radio button.
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GSCHAPS . FRX
Page Header

B
DATEO

PgHead |State Avg
PgHead

Detail U gtapur b uta

aug_ytdpur sum_ytdpur Mmin_ytdpur

Figure 20: GSCHAPS8 Report Form with Added
Summary Band and Copied Fields

Reset: End of Report H

Calculate: Nothing
Count « OK »
Sum
Average < Cancel >
Louest

Highest

Std. Deviation

Variance

AANAANAAAAAAN
.
W W N W W

Figure 21: Calculate Field Dialog
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You now have a Summary band with information calculated from the
data in the Detail band. Try it and see how it looks.

Doing the Query
1. Choose RQBE - UNTITLED from the Window menu.

2. Choose Do Query. The Page Preview window appears.

3. Choose More until you reach the bottom of the report
where you can see the Summary band. (Figure 22)
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$3,560.
$3,452.
$5, 297.
$1,885.
$1,688.
$1,612.
$2, 885.
$1,575.
$2,074.

$678.

$283.

$44.

500 $1,663,206. .16 $17,777.

« Done » < More > Column: 4]

Figure 22: Page Preview of GSCHAP8 Showing Summary Band

More Reporting G8-29



More Reporting

Now that you have the data right where it wants you, it’s time to go to
press. If you don’t have a printer, choose Done in the Page Preview
window and skip to the step box at the bottom of this page.

Sending the Report to the Printer

1. Choose Done in the Page Preview window to return to the
RQBE window. (Figure 23)

2. Choose the Options... check box.
3. Uncheck the Preview Report/Label check box.

4. Choose the To Printer check box in the Output Destina-
tions area.

5. Choose OK.
. Choose Do Query. The report is printed.

In a later session you will learn about commands. Right now, take a
look at the command that is behind the fantastic things you have been
doing with RQBE.

Looking at the SELECT Command

Choose the See SQL push button in the RQBE window.
The See SQL window appears as in Figure 24.

You've created a SQL SELECT command without programming.
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Databases Output Fields Output To

»CUSTOMER STATE [X]1 Select Fields... Report/Label
AUGCYTDPURCH

COUNT (> [X]1 Order By...
SUMCYTDPURCH [X1 Options...
MINCYTDPURCH] [X]1 Group By...
< Add > MAXCYTDPURCH] [ 1 Having... < See SQL >
< Clear > « Do Query »

Field Name NOT Example U~L Select
Criteria

<Insert>
<Remove>

< Or >

Figure 23: RQBE Window

UNTITLED. QPR [Read Onlyl
SELECT CUSTOMER.STATE, AUGCCUSTOMER.YTDPURCH>, COUNTGe,:
SUMCCUSTOMER. YTDPURCH>, MINCCUSTOMER.YTDPURCH>, MAXCCUSTOMER.YTDPURCH):
FROM CUSTOMER:
GROUP BY CUSTOMER.STATE;
ORDER BY 2 DESCENDING:

INTO CURSOR QUERY
CREATE REPORT SESSIONS.FRX FROM QUERY WIDTH 88 COLUMN NOOUERWRITE
REPORT FORM SESSIONS.FRX TO PRINTER NOCONSOLE

Figure 24: SELECT Command
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You have worked hard and created a wonderful report. Save your
report.

Saving the Report
1. Close the See SQL window.

2. Choose Save as... from the File menu popup and make
sure TUTORIAL appears on the Directory popup con-
trol. Type GSCHAP8 in the text box then choose Save.

3. Close the RQBE window.

4. Close the GSCHAPS report form and choose Yes when
FoxPro asks about saving changes.
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RQBE and the Report
Writer in Action
In this session, you'll see a five step example of

how RQBE and the Report Writer can be used as
analytical tools.

¢ Sample Databases . . ...... .. page 2
¢ Step 1 - Including Simple Totals . . . page 4
¢ Step 2 - Grouping and Totalling . . . . page 6
® Step3-UsingaReport........ page 8
® Step 4 - More Grouping . . . .. .. page 12
® Step 5 - Adding Details . . . . . .. page 16

eljeq buizAjeuy
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RQBE and the Report Writer in Action

G9-2

In this session you'll see RQBE and the Report Writer used to perform a
sales analysis. RQBE enables you to extract data from several databases
and the Report Writer allows even more refined reporting.

The examples in this session use the six databases shown in Figure 1.
Figure 1 also shows the fields that the six databases have in common.
Common fields are used to join databases.

The CUSTOMER database can be joined to the INVOICES database by the
customer number field, CNO. The INVOICES database can be joined to
the DETAIL database by the invoice number field, INO. The DETAIL
database can be joined to the PARTS database by the part number field,
PNO. The INVOICES database can also be joined to the SALESMAN
database by the SALESMAN field. The SALESMAN database can be joined
to the OFFICES database by the office number field, ONO.

Analyzing Data
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RQBE and the Report Writer in Action

CNO

INVOICES

DETAIL

INO

COMPANY

CONTACT

CNO

INO

ADDRESS

IDATE

LINE

CITY

ITOTAL

QTY

STATE

SALESMAN

PNO

ZIP

PHONE

PRICE

LTOTAL

ONO

YTDPURCH

SALESMAN

SALESMAN

LAT

ONO

PARTS

LONG

NAME

PNO

YTDSALES

DESCRIPT

OFFICES

ADDRESS

ONHAND

ONO

CITY

ONORDER

STATE

PRICE

YTDSALES

ZMIN

ZIP

COST

ZMAX

PHONE

YTDUNITS

YTDSALES

ADDRESS

NOTES

CITY

STATE

Z1P

PHONE

Analyzing Data

Figure 1: Six Databases and Their Common Fields
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Let’s begin with a query that shows the total sales for each salesman.

Note that FoxPro may ask you to locate one of the databases used in
these queries. If so, simply select the database that FoxPro is request-
ing.

Opening STEP1.QPR

1. Choose Open... from the File menu. Make sure that
TUTORIAL appears on the Directory popup control
and Query appears on the Type popup control.

2. Select STEP1.QPR and choose Open. The RQBE window
appears as in Figure 2.

Doing the Query

Choose Do Query. Query results appear in the Browse
window. (Figure 3)

The total sales for each salesman are extracted from the INVOICES
database. The output fields are the salesman number and the sum of
the invoice totals. The results are grouped by salesman so that a total
invoice amount is shown for each salesman.

Closing Browse and RQBE

1. Close the Browse window.

2. Close the RQBE window.
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RQBE - STEP1
Databases Output Fields Output To

»INUOICES SALESMAN [X] Select Fields... Brouse
SUMCITOTAL)

[ 1 Order By... STEP1
[ 1 Options...

[X] Group By...
< Add > [ 1 Having... < See SQL >
< Clear > « Do Query »

Field Name Example Options Select
Criteria

<Insert>
<Remove>

< Oor >

Figure 2: STEP1.QPR

Salesman|Sum_itotal

Figure 3: Step1 Query Results in
a Browse Window
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Suppose that you want to break this information down by the office in
which the salespeople work. To obtain this information, you need to use
the SALESMAN database. By joining the SALESMAN database with the
INVOICES database, you can extract specific information about each
salesman — in this case, the office number.

Opening STEP2.QPR

1. Choose Open... from the File menu.

2. Open STEP2.QPR. The RQBE window appears as in
Figure 4.

Besides being used to join SALESMAN and INVOICE, the office number
field, ONO, has been added to the Output Fields list. ONO is also being
used in addition to SALESMAN to group the query results.

Doing the Query

Choose Do Query. The Browse window appears as in
Figure 5.

Closing the Browse Window and RQBE

1. Close the Browse window.

2. Close the RQBE window.
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RQBE and the Report Writer in Action

ROBE - STEPZ
Output Fields Output To

»INUOICES
SALESMAN

< Add >
< Clear >

ONO [X] Select Fields... Brouse n
SALESMAN

SUMCITOTALY | [ 1 Order By... STEP2
[ 1o0ptions...

[X1 Group By...
[ 1 Having... < See SQL >

« Do Query »

Field Name

NOT Example Options Select
Criteria

$] SALESMAN. SALESHAN [ 1Like INUOICES. SALESMAN [1

{Insert>

<Remove>

< Or >

Ono| Salesman|Sum_itotal

Figure 4: STEP2.QPR

|

1508
175
180
240
271
281
294
322
328
353
360
366
391
410
423

1
1
1
2
2
2
2
3
3
3
3
3
3
4
4

282, 22|
1919,
3822.
2952.
3855.

11110.
11447.
5748.
7216.
7567.
5721.
8898.
1749.
11681.
4721.
8814.

Figure 5: STEP2 Query Results in Browse Window

Analyzing Data
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In STEP3.QPR, the OFFICES database is joined to the SALESMAN database
in order to extract the city where each office is located.

Opening STEP3.QPR

1. Choose Open... from the File menu.

2. Open STEP3.QPR. The RQBE window appears as in
Figure 6.

In addition, the report STEP3.FRX is used to enhance the appearance of
the output. Using a report also allows the secondary grouping of the
information by the office number field, ONO. A report allows you to get
many levels of group totals as well as totals for an entire report.

Opening STEP3.FRX

1. Choose Open... from the File menu. Make sure Report
is showing on the Type popup control.

2. Select STEP3.FRX and choose Open. The Report Layout
window appears as in Figure 7.

3. Take a few moments to examine STEP3.FRX.

4. Close STEP3.FRX.
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Databases Output Fields Output To

»INUOICES CITY [X]1 Select Fields... Report/Label
SALESMAN ONO

OFFICES SALESMAN [ 1 Order By...
NAME [X] Options...
SUMCITOTAL> | [X1 Group By...
< Add > [ 1 Having... < See SQL >
< Clear > « Do Query »

Field Name Example Options Select
Criteria

%] SALESHMAN. SALESMAN INUOICES. SALESMAN [1]
[1

3] OFFICES. ONO SALESMAN. ONO <Insert>

<Remouve>

< Or >

Figure 6: STEP3.QPR

R: 8C: @ Page Header
PgHead Office Salesman Total Sales

ity Wlalfare

Total Sales All Offices

Figure 7: STEP3 Report in Report Layout Window
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G9-10

Doing the Query

1. Choose Do Query. The Page Preview window appears as
in Figure 8.

2. Choose More to view the entire report.

Notice that the Report Writer allows you to:

Change the headings to be more informative
Provide totals for each office

Provide a grand total for all offices

Put spaces between office groups

Use the box drawing facility to provide the line between the office
figures and the office total

Closing the RQBE Window

1. Choose Done to return to the RQBE window.

2. Close the RQBE window.
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Office

Boston
Boston
Boston
Boston

Neu York
Neu York
Neuw York
Neu York

Atlanta
Atlanta
Atlanta
Atlanta
« Done »

Figure 8: STEP3 Report in Page Preview Window

Analyzing Data

< More >

Salesman

Janet A. McCarthy
Robert UWatters
Doris Dupuy

T Staziola Tounsend

John Hodge
Houward Schneider
Jay Kennedy

Tom Caravello

322 E. Faulkner

328 Keith Sutherland

353 Jim Surbrook

368 Ned Hicks
Column: *]

Total Sales

282.
1,918.
3,822.
2,952.

8,176.

3,855.
11,118,
11,447.

5,748.

32, 161.

7,216.
7,567.
5,721.
8,898.

22
39
40
55

56

19
85
51
28
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RQBE and the Report Writer in Action

In STEP4.QPR, the CUSTOMER database joins the party so that the report
can show a breakdown of data by company for each salesman.

Opening STEP4.QPR

1. Choose Open... from the File menu. Make sure Query
appears on the Type popup control.

2. Select STEP4.QPR and choose Open. The RQBE window
appears as in Figure 9.
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RQBE - STEP4
Databases Output Fields Output To

»INUOICES CITY [X]1 Select Fields... Report/Label
SALESMAN ONO

OFFICES SALESMAN [ 1 Order By..
CUSTOMER NAME [X] Options...
COMPANY [X] Group By...
< fAdd > SUMCITOTALD [ 1 Having... < See SQL >
< Clear > « Do Query »

Field Name NOT Example Options Select
Criteria

%] SALESMAN. SALESMAN [ 1 Like INUOICES. SALESMAN [1
%] OFFICES. ONO [ 1 Like SALESMAN. ONO [ 1] <Insert>
%] CUSTOMER. CNO [ 1 Like INUOICES. CNO [1
<Remove>

< Or >

Figure 9: STEP4.QPR
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RQBE and the Report Writer in Action

Opening STEP4.FRX

1. Choose Open... from the File menu. Make sure Report
is showing on the Type popup control.

2. Open STEP4.FRX. The Report Layout window appears as
in Figure 10.

3. Examine STEP4.FRX.

4. Close STEP4.FRX to return to the RQBE window.

Doing STEP4.QPR

1. Choose Do Query. The Page Preview window appears
as in Figure 11.

2. Choose More to view the entire report.

Notice how the Suppress... option clarifies the report by eliminating
duplicates of cities and salesmen names.

Closing the RQBE Window

1. Choose Done to return to the RQBE window.

2. Close the RQBE window.
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RQBE and the Report Writer in Action

STEP4. FRX

Customer

Total Sales All Offices

Figure 10: STEP4 Report in Report Layout Window

Office Salesman
1 Boston 117 Janet A. McCarthy
158 Robert Uatters

175 Doris Dupuy

188 T Staziola Tounsend

2 Neu York 248 John Hodge

2?71 Houard Schneider

« Done » < More > Column: a

Customer

Snou Aerial Realtors
Balance Computing Systems
Posna Associates

Silicon Computer Calgary
Auard Ammonia Greenhouses
A. Arts Computers

Print Mayo Consultation
Boehringer PCA

Ross & Associates Products

Systems Poetics and

The Circle Distributing
Wilson Solutions
Business State Computers
Bob Produce

Clover Office Shooters

Figure 11: STEP4 Report in Page Preview Window

Analyzing Data
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RQBE and the Report Writer in Action

STEP5.QPR concludes the analysis process by adding the DETAILS and
PARTS databases. These databases are added to display more detailed
information for each invoice.

Opening STEP5.QPR

1. Choose Open... from the File menu. Make sure Query
is showing on the Type popup control.

2. Open STEP5.QPR. The RQBE window appears as in
Figure 12.
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RQBE and the Report Writer in Action

Databases Output Fields Output To

»SALESMAN CITY [X] Select Fields... Report/Labelﬂ
OFFICES NAME

INVOICES CNO [X1 Order By...
CUSTOMER COMPANY [X]1 Options...
INO [ 1 Group By...
< Add > DESCRIPT [ 1 Having... < See SQL >
< Clear > « Do Query »

Field Name NOT Example Options Select
Criteria

$] OFFICES. ONO [ 1 Like SALESMAN. ONO
3] INVOICES. SALESMAN [ 1 Like SALESMAN. SALESMAN <Insert>
3] CUSTOMER. CNO [ 1 Like INVOICES. CNO

DETAIL. INO [ 1 Like INUOICES. INO <Remove>
$] PARTS. PNO [ 1 Like DETAIL. PNO
< Or >

Figure 12: STEP5.QPR
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RQBE and the Report Writer in Action

G9-18

Opening STEP5.FRX

1. Choose Open... from the File menu. Make sure Report
is showing on the Type popup control.

2. Open STEP5.FRX. The Report Layout window appears as
in Figure 13.

3. Examine STEP5.FRX.

4. Close STEP5.FRX.

Doing the Query

1. Choose Do Query. The Page Preview window appears
as in Figure 14.

2. Choose More to view the entire report.

The final result is a report that organizes the information by sales office.
Within each sales office, the information is broken down by salesman.
For each salesman, the information is broken down by company. For
each company, the information is broken down by invoice. For each in-
voice, information is given on the parts contained in that invoice.

The report also lists overall totals as well as totals by invoice, company,
and salesman.

Notice how boxes can be used to further clarify the data being presented
in the report.

This should give you an idea about how to use RQBE and the Report
Writer to analyze your data and quickly extract the data that you want
to see.

Closing the RQBE Window and Databases

1. Choose Done to return to the RQBE window.
2. Close the RQBE window.

3. Hold down the Shift key and choose Close All from the
File menu to close all open databases.
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RQBE and the Report Writer in Action

SALES OFFICE:

Company Name Inu#t Item Description

SALES ACTIVITY FOR (NI

r3fcor1paigff§
4—ino

ToTAL FOR

Figure 13: STEP5 Report in Report Layout Window

SALES OFFICE: Atlanta

Company Name Inult Item Description Qty Price

SALES ACTIVITY FOR E. Faulkner

First Computer 1142 Cursive initial
Defeat card
Holst rain
Runty river
Skimpy armchair
Soiree ink
Suit bead
Sulfate images
Woodyard lizard

R ENANOOUTD

« Done » < More > Column: a

Figure 14: STEP5 Report in Page Preview Window
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Working With Your Own
Database

In this session you’ll learn to create your own
database and add, delete and modify records.

¢ Creating a Database Structure . . . . page 2
¢ Defining a Database Structure . . . . page 4
¢ Entering Data in a Database . . . . . page 6
® Modifying a Database Structure . . . page 10
¢ Marking Records for Deletion . . . . page 16
® Packing a Database . . . ... ... page 20
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Working With Your Own Database

Working With Your Own Database

G10-2

So far, you've been using databases that we've provided. Now, it’s time
to create and manipulate your own database.

The first step in creating a database is to decide what information you
want to store in the database. Suppose you want to keep track of infor-
mation about wine. You must decide what information about your wines
you want to save.

You decide that winery, type, flavor, origin, date of purchase, date of
corking, cost and present value are important. Each of these pieces of
information will be one field in your database. You may also want a
field for comments about your wine.

Go ahead and start building a database called CELLAR.

Creating a Database Structure

1. Choose New... from the File menu. The New File dialog
appears. (Figure 1)

2. The Database radio button is chosen by default, so choose
OK. The Structure dialog appears. (Figure 2)
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Working With Your Own Database

Neu:

W W W W W W W W W W

Database
Program
File
Index « OK »
Report
Label < Cancel >
Screen
Menu
Query
Pro ject

AAAAAAAAAAN

Figure 1: New File Dialog

Structure: Untitled
Name Type Width Dec

Field

<{Insert>

<Delete>

« QK »

<Cancel>

Fields: 2 Length: 1 Available: 3999

Figure 2: Structure Dialog
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G10-4

Each row in the Structure dialog represents information for one field.
The cursor appears in the Name text box for the first row so you can
define the first field. You can add the name, type and width of each of
the fields shown in Figure 3. For more information on field types, see
the File Menu chapter in the FoxPro User’s Guide.

As you define your fields, the Structure dialog’s status line displays how
many fields you have defined, the total length of all defined fields and
how much space is still available for more field definitions.

Defining a Database Structure

1. Type Winery in the Name text box; press Tab to move to
the Type popup (Character appears on the Type
popup control by default); Tab to the Width text box
and type 20; skip the Dec text box.

The Dec text box determines how many spaces after the
decimal are required. Since COST and PVALUE are cur-
rency fields, a Dec value of 2 should be used.

2. Using Figure 3 as a guide, define the remaining fields.
To move to each field, press Tab or point to the field
and click. To display the Type popup, Tab to the
Type popup control and press Enter or point to the
field with the mouse and click.

3. When the Structure dialog appears as in Figure 3, choose
OK. The Save As dialog appears.

Naming a Database and Preparing to Add Records

1. Make sure TUTORIAL shows on the Directory popup
control. Type CELLAR in the Save As dialog text box
(Figure 4) then choose Save.

2. FoxPro asks if you want to input records now (Figure 5).
Choose Yes.
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Working With Your Own Database

Structure: Untitled

Name Type Width Dec
Field
: 2
k2 <Insert>
E 2
E 2 {Delete>
k2
2
:
3 2l « OK »
2
<Cancel>
Fields: 9 Length: 112 Available: 3888 Status Line

Figure 3: Structure Dialog with Field Information

Name the neu database:

»L..1] Drive C “
CUSTOMER. DBF

DETAIL. DBF
INUOICES. DBF

OFFICES. DBF Directory | TUTORIAL “
PARTS. DBF |

SALESMAN. DBF

« Save »

[ 1 All Files < Cancel >

CELLAR

Figure 4: Save As Dialog

Input data records nou?

« VYes » < No >

Figure 5: Input Records Alert
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Working With Your Own Database

A Browse window appears, in Change mode, with the cursor in the first
field of the first record. In Figures 6 and 7, the COMMENTS memo field
has been opened, resized and moved to the location shown.

Go ahead and add the following information.

G10-6

oo b

© © N o

10.

11.

12.

13.

Entering Data in a Database Structure

Type Mogen David and press Enter.
Type Generic and press Enter.
Type Concord and press Enter.
Type ? and press Enter.

Type 02 12 91. You do not need to type the /. This is
entered automatically.

Press Enter to skip the DCORK field.
Type 3.59. The cursor moves to the next field.
Type 3.59. The cursor moves to the next field.

Open the memo window by pressing Ctrl+PgDn or double-
clicking with the mouse. Type This was a gift
from Bert. Close the memo window.

Press Enter to position the cursor in the first field of the
second record.

Using Figure 7 as a guide, add the following information
to the next record: MD 20/20, Generic, Grape, ?,

03 23 91, skip the DCORK field, 3.25, 3.25, This

was a gift from Ellen. Close the memo win-

dow.

Figures 6 and 7 show how the Browse windows and as-
sociated memo windows appear after you add informa-
tion. We've rearranged the windows on the screen so
they appear side by side.

Close the Browse window.
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Working With Your Own Database

CELLAR CELLAR. COMMENTS
Winery Mogen David This was a gift from Bert.
Type
Flavor
Origin
Dpurch
Dcork
Cost
Pvalue
Comments

Winery MD 286/28

Type Generic
Flavor Grape
Origin 7
Dpurch 83723791
Dcork / 7/
Cost

Puvalue

Comments

CELLAR. COMMENTS
Uinery  Mogen David This was a gift from Ellen.
Type Generic
Flavor Concord
Origin 7
Dpurch 82/12/91
Dcork /7
Cost

Pualue

Comments

Winery

Type

Flavor
Origin
Dpurch

Dcork

Cost

Pvalue
Comments [y[=IF1)

Figure 7: CELLAR.DBF
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Working With Your Own Database

You have just added records to your database during the creation
process. You can also append records to a database that already exists
through the Record menu.

Adding Records to a Database

1. Choose Append from the Record menu. The Browse
window appears in Append mode.

2. Using Figure 8 as a guide, add the following data to
record three: Boone’s, Generic, Wild Mountain,
California, 03 24 91, skip the DCORK field,
2.39,2.39, Present from Mom and Dad.

3. Using Figure 9 as a guide, add the following data to
record four: Barton & Guestier, Chablis,
White, France, 08 22 89,01 01 87,11.36,
17.95,My first real investment.

Figures 8 and 9 show how information in your Browse window and as-
sociated memo windows appear.
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CELLAR. COMMENTS

Winery
Type
Flavor
Origin
Dpurch
Dcork
Cost
Puvalue
Comments

Present from Mom and Dad.

Winery
Type
Flavor
Origin
Dpurch
Dcork
Cost
Puvalue
Comments

Barton & Guestier
Chablis
White
France
088/22/89
01/081/87
11.36
17.95
Memo

Figure 8: CELLAR.DBF

CELLAR CELLAR. COMMENTS

Winery
Type
Flauor
Origin
Dpurch
Dcork
Cost
Pualue
CommMents

My first real investment.
Boone’ s
Generic
Wild Mountain
California
83/24/91

/7 7/

Winery
Type
Flavor
Origin
Dpurch
Dcork
Cost

Comments

Memo

Figure 9: CELLAR.DBF
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Working With Your Own Database

FoxPro gives you the flexibility to change the structure of your database
as your needs change. Suppose that you want to use this database not
only for wines that you are collecting but also for wines that you have
tasted.

To do this, you need to add a consumption date and a rating field. Be-
cause you've learned at a recent wine-tasting that wines are categorized
by class, not flavor, you also decide to change the FLAVOR field to CLASS.

Let’s make these modifications.

Modifying a Database Structure
1. Close the Browse window.

2. Choose Setup... from the Database menu. The Setup
dialog appears as in Figure 10.

3. Choose the Modify push button in the upper left corner of
the Setup dialog. The Structure dialog appears.

4. Position the cursor on the FLAVOR field and change it to
CLASS as shown in Figure 11.

5. Position the cursor on the COST field:

e With the keyboard choose Insert Field from the
Structure menu.

e With the mouse, choose the Insert push button.

NEWFIELD appears above the COST field. (Figure 11)
Change NEWFIELD to DCONSUM, then choose Date
from the Type popup.

6. Position the cursor on COST and choose Insert. Change
NEWFIELD to RATING, choose Numeric from the Type
popup then change the Width field to 1; skip the Dec
text box.
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Working With Your Own Database

Modify Push Button

llhtﬂmse:C:\FOXPROZS\TUTORIﬁL\CELLﬂR.DBF

Structure: <Modify> Indexes: Index
»WINERY c 20 2
TYPE c 1@ 2} < Add... >
FLAUOR C 15 2}
ORIGIN c 20 4] {Modify...>
DPURCH D 8 e
DCORK D 8 %} < Remouve >
COST N 18 2
PUALUE N 18 2 <No Order >
COMMENTS M 10 4]
Fields: 9 Length: 112 Index expr:
Index filter:

[X]1 Set Fields...

C > On () Off « OK »
[ 1 Filter...
[ 1 Format...

Figure 10: Setup Dialog with CELLAR.DBF Information

Structure: C:NFOXPROZ5M\TUTORIALMCELLAR . DBF
Name Type Width Dec
Field

Changed Field Character
Character {Insert>
<Delete>
New Field
« QK »
{Cancel>
Fields: 1@ Length: 122 Available: 3878

Figure 11: Structure Dialog Showing Initial Changes
to CELLAR.DBF
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Working With Your Own Database

Now you have a database that meets your needs. If not, you can easily
change it.

Making Database Structure Changes Permanent

1. When the Structure dialog appears as in Figure 12,
choose OK.

2. FoxPro asks if you want to make the structure changes
permanent. (Figure 13) Choose Yes.

3. The Setup dialog now reflects the changes you’ve made.
(Figure 14)
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Structure: CINFOXPROZS5\TUTORIALNCELLAR .DBF
Name Type Width Dec
Field

E 2 Character

k2 Character <{Insert>

k2 Character

E Character <{Deleted>

: Date

$ Date

$ Date

k3 Numeric « QOK »

t

<Cancel>

Fields: 11 Length: 130 Available: 3870

Figure 12: Structure Dialog with Changes

Make structure changes permanent?

« Ves » < No >

Figure 13: Structure Changes Alert

Database: C:\FOXPROZ5N\TUTORIALN\CELLAR .DBF

Structure: <Modifyd> Indexes: Index
»UWINERY C 20 4]
TYPE > 18 4] < Add... >
CLASS c 15 4]
ORIGIN c 20 a <{Modify...>
DPURCH D 8 %]
DCORK D 8 %] < Remove >
DCONSUM D 8 4]
RATING N 1 %] <{No Order >
COST N 18 2
Fields: 11 Length: 121 Index expr:
Index filter:
[X]1 Set Fields...
C D> On (> Off « OK »
[ 1 Filter...
[ 1 Format...

Figure 14: Setup Dialog with Changes

Custom Database G10-13



Working With Your Own Database

You’ve seen that adding records is a simple matter of typing in data
while in Append mode. Deleting records is just as easy. First, browse
the database in question.

G10-14

Browsing CELLAR.DBF
1. Choose OK to exit the Setup dialog.

2. Choose Browse from the Database menu.

An alert may appear (Figure 15) to tell you that the
default browse setup will be used. Your next keystroke
or mouse movement will remove the alert from your
screen.

3. Size the Browse window so it stretches across your screen
as shown in Figure 16.
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Invalid BROWSE setup —- default setup used

Figure 15: Default Browse Setup Alert

Winery

Type Class

Mogen David

MD 28/208

Boone’ s

Barton & Guestier

Custom Database

Concord ;

Generic Grape 7
Generic Wild Mountain |California
Chablis White France

Figure 16: CELLAR.DBF
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Working With Your Own Database

Notice the column between the fields and the window border. (Figure 17)
A bullet ( » ) appears in this delete/recall column when you mark a
record for deletion.

Go ahead and mark two of records for deletion.

Marking Records for Deletion
With the keyboard:

1. Use the Up and Down Arrows to select the record with
the name “MD 20/20.”

2. Choose Toggle Delete from the Browse menu. A bullet
appears in the delete/recall column. (Figure 17)

3. Repeat steps 1 and 2 but mark “Boone’s” for deletion.
With the mouse:

1. Position the pointer on the delete/recall column next to
“MD 20/20” and click. A bullet appears in the
column. (Figure 17)

2. Repeat the step above but mark “Boone’s” for deletion.

These records are only marked for deletion. They have not yet been
deleted. FoxPro is waiting for you to give the word to delete these
records. That word is pack.

Packing a database permanently removes all of the marked records. This
process is irreversible, so you must be very sure that only those records
that you really want to get rid of are marked for deletion.
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Delete/Recall Column

Flogen Davia

MD 28/20 Generic Grape

*Boone’s Generic Wild Mountain éalifornia
Barton & Guestier Chablis White France

Figure 17: CELLAR.DBF with Records Marked for Deletion

Two records marked for deletion
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Suppose you change your mind about deleting one of the records you
have marked. Let’s go in and unmark it.

Recalling a Record Marked for Deletion
With the keyboard:
1. Press the Up Arrow or Down Arrow to select the record

J »

with the winery name “Boone’s.

2. Choose Toggle Delete from the Browse menu. The bullet
in the delete/recall column disappears. (Figure 18)

With the mouse:

Point to the bullet next to “Boone’s” in the delete/recall
column and click. The bullet disappears. (Figure 18)
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Winery Type Class

Fogen David .

MD 26/208 Generic Grape

Boone’ s Generic Wild Mountain California
Barton & Guestier Chablis White France

Figure 18: CELLAR.DBF with One Record Marked for Deletion
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Now it’s time to permanently remove the record marked for deletion.

Packing the Database

1. Choose Pack from the Database menu. An alert appears
asking if you want to pack the database. (Figure 19)

2. Choose Yes.

Verify that the record marked for deletion is indeed gone.

Browsing the Database

1. Choose Browse from the Database menu.

2. Look for the record for MD 20/20. It is gone. (Figure 20)
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Pack C:N\FOXPROZ5\TUTORIALNCELLAR.DBF?

« Yes » < No >

Figure 19: Pack Alert

CELLAR
Winery Type Class Origin

Mogen David Generic Concord ?
Boone’ s Generic Wild Mountain California

Barton & Guestier |[Chablis |[hite — |fFrance

Figure 20: CELLAR.DBF Packed
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Editing the data in your database is easy, too.

Editing Data in the Database

1. Position the cursor after “Concord” in the CLASS field of
the first record and add “Grape” so the record appears
as in Figure 21.

2. Close the Browse window.

You now know how to create and manipulate a database so that it meets
your specific needs.

G10-22
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Field changed from Concord to Concord Grape

CELL/R
Winery Type Origin

Mogen David —|[Generic . |[Concord Grape |2

Boone’ s Generic Wild Mountain California
Barton & Guestier Chablis White France

Figure 21: CELLAR.DBF with Edited Field
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Designing a Custom
Input Screen

In this session, you will use the Screen Builder to
design your own custom input screen.

® (Creating a Quick Screen . . . . . .. page 2
® Placing Fields in a User Window . . . page 4
® Creating a Scrollable List . . . . . . page 12
® Generating Screen Code . . . . . . page 14
® Creating a Calculated Field . . . . . page 20
® CreatingaPopup . ... ... ... page 24
®* Adding a Control Panel . . . . . .. page 26
® Creatinga ScreenSet . ... ... page 26
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Designing a Custom Input Screen

G11-2

So far, you've looked at data in several ways. You’ve used the Browse
window to view data in tabular form. Change mode allowed you to look
at fields in each record one below the other. With reports, you placed
data exactly where you wanted it for display and printing purposes.

The Screen Builder lets you include your data in a screen that you
design — not only for display but for input and modification as well. In
this session you’ll create and use a screen for your CELLAR database.

Let’s begin by creating a Quick Screen.

Creating a Quick Screen
1. Make sure CELLAR.DBF is open.

2. Choose New... from the File menu, choose the Screen
radio button, then choose OK. An untitled Screen
Design window appears. (Figure 1)

3. Choose Quick Screen... from the Screen menu. The
Quick Screen dialog appears. (Figure 2)

4. Choose OK in the Quick Screen dialog. The fields from
CELLAR.DBF are placed in the Screen Design window.
(Figure 3)
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UNTITLED. SCX

Figure 1: Screen Design Window

Quick Screen:

C > By Column Layout

(+> By Rou Layout Fieldl xxxxxx
FieldZ xxxxxx

[X]1 Titles Field3 xxxxxx

[ 1 Fields... Field4 xxxxxx

[X]1 Add Alias

[ 1 Memory variables
Maximum field width:

« OK » < Cancel >

Figure 2: Quick Screen Dialog

UNTITLED. SCX

Figure 3: Screen Design Window with CELLAR.DBF Fields
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With the Screen Builder, you can place fields in a window that you
design.

Placing Fields in a User Window

1. Choose Screen Layout... from the Screen menu. The
Screen Layout dialog appears.

2. Choose the Window radio button at the top of the Screen
Layout dialog. (Figure 4)

3. Type Wine Collecting Is My Hobby in the Title text
box. (Figure 4)

4. Type 15 in the Height text box and 64 in the Width text
box to specify the size of the window you’re creating
(Figure 4)

5. Choose the Type... push button. The Window Type
dialog appears as in Figure 5.

6. Choose Dialog from the Type popup then choose OK.

Choosing the Window radio button gives your screen the same features
as any FoxPro window including sizing and moving. The Window Type
dialog from steps 5 and 6 displays all available window options.

The Desktop option creates a static screen without borders, title, name
or any window type options.

The Height and Width text boxes allow you to define the size of your
screen. The unit of measurement equals one character.
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Window Radio Button

. <> D <> Wind
Title Text eskTop < naou
Box Name: <Type...>
g (B33 A:HENine Collecting Is My Hobby
Footer:
Size: Screen Code:
Height/Width Height: [ [ 1 Setup...
Text Boxes Width: 64 [ 1 Cleanup & Procs... « OK »
—_—
Position: READ Clauses: < Cancel >
Rou: [ 1 Activate... [ 1 Shou...
Column: [ 1 valid... [ 1 When...
[X] Center [ 1 Deactivate...
Environment: [X]1 Add alias
[45 Save > < Restore > < Clear >

Figure 4: Screen Layout Dialog

Type Popup

Type: L User n
System

Dialog

Attribut] Alert |order
[ 1 Close C > None
[ 1 Float (+> Single
[X1 Shadouw C > Double « OK »
[ 1 Minimize C ) Panel
C > System < Cancel >

Color Schemes:

Primary: Popup:

User Uindsﬂ User Henusn

Figure 5: Window Type Dialog
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Returning to the Screen Design Window

Choose OK in the Screen Layout dialog. The Screen
Design window appears as in Figure 6.

Now you can move the fields and field titles. Figure 7 shows one possible
outcome.

Moving Fields and Field Titles
Move the fields and field titles to match Figure 7.

e With the keyboard, move the cursor to each field
and field title, press the Spacebar, then use the
arrow keys to move the field or field title to the
desired location. Press Enter to confirm the
move.

e With the mouse, click on each field and field title
and drag it to the desired location.
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CH Move ||

| Wine Collecting Is My Hobby

HiWinery Cuinery....oooe...

iType : type...

fiClass ¢ class.......

lI0rigin Coorigin..........,
Dpurch :

liDcork

fiDconsum

liComments S COMMENES. it e

Figure 6: Screen Design Window

R: acC @] Move ||
ine Collecting Is My Hobby

Type

Pvalue IHEYEINT
Cost SHEIS SR

Figure 7: Screen Design Window with Moved Fields
and Field Titles
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It might look better if a few of the field titles were changed.

Editing Field Titles

1. Edit the following field titles to match Figure 8: Change
DPURCH to PURCHASED, DCORK to CORKED, DCONSUM
to CONSUMED and PVALUE to VALUE.

To edit a title, select the field title and choose Text from
the Screen menu. Type the desired title. Press Enter
when you’re finished editing each title.

2. Using Figure 8 as a guide, position the cursor where you
want the text “Date” to appear, type Date then press
Enter.
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R 4C 34 Hove ]|
Wine Collecting Is My Hobb

@«
L3

Winery /HEGRHEEY

Type

Value jUHEIZINE Date
Cost I SN

liComments  [RRSITTHAS

Figure 8: Screen Design Window with Edited Field Titles
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Draw a line beneath “Date.”

Drawing a Line

Add a line beneath “Date,” as shown in Figure 9, by
positioning the cursor in the location you want the
line to appear and choosing Box from the Screen
menu:

e With the keyboard, use the arrow keys to shrink
the blinking box to a line then press the Right
Arrow key until the line is the desired length.
Press Enter to confirm the action.

e With the mouse, click on the blinking box and
drag until the line has no depth and is the
desired length, then release the mouse button.
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WINE. SCX

(P tupe. . QTR class.......

[INER10: pualue Date
Cost SHEIS NN

Corked [‘H(e1g3
Purchased SHEJIUYe
Consumed [EEN(Is

(ML A1 comments

Figure 9: Screen Design Window with Line
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The COMMENTS field is a memo field and can contain a variable amount
of information. Let’s change how this field is displayed to reflect its
unique structure.

Changing the Display of the Memo Field

1. Choose the COMMENTS field. The Screen Field dialog
appears:

e With the keyboard, place the cursor on COMMENTS
and double-click with the Spacebar.

o With the mouse, point to COMMENTS and double-
click.

2. Choose the Edit radio button at the top of the Screen
Field dialog and choose the Scroll bar check box. The
dialog should appear as in Figure 10. Choose OK.

3. Size the COMMENTS field to match Figure 11:

e With the keyboard, Ctrl+Spacebar on the field so
that it blinks. Use the arrow keys to size the field
then press Enter.

e With the mouse, Ctrl+click and hold on the field so
that it blinks. Drag until the field is the desired
size.

G11-12 Creating a Screen



Designing a Custom Input Screen

Edit Radio Button

Field:

C > Say C ) Get (+> Edit

< Eait... >

<« OK »
< Format... >
< Cancel >
Range:
[ 1 Upper... [ 1 Lower...
[ 1 When... [ 1 Error... [X1 Scroll bar 2(;:‘0111{%31‘
[ 1 Valid... [ 1Comment... [ 1 Allou tabs eck box
[ 1 Message... [ 1 Disabled [ 1 Refresh
Figure 10: Screen Field Dialog
WINE. SCX
R: 12 C: 58 Move
Wine Collecting Is My Hobby
UNETR: winery........... [ EVOCIVN4: origin........
Type
CINER16: pualue
(WiI3M3: cost...
Sized
Memo Field

Figure 11: Screen Design Window with Sized Memo Field A
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To use this screen, you need to tell FoxPro to generate a program. Don’t
worry about the whys and hows of programs right now — you will learn
about those in a little while. As your screen is generated, you will see a
thermometer that indicates the progress of the generation.

Go ahead and generate your first screen.

Generating Screen Code

1. Choose Generate... from the Program menu. FoxPro asks
if you want to save changes to your untitled screen.
Choose Yes.

2. In the Save As dialog, type CELLAR as shown in Figure 12
then choose Save.

3. FoxPro asks if you want to save environment information.
Choose Yes.

4. The Generate dialog appears as in Figure 13. Choose
Generate.
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Save Screen fs:

»[..1 Drive c ﬂ
CONTROL3. SCX
Directory |TUTORIAL ﬂ

« Save »

[ 1 All Files < Cancel >

Figure 12: Save As Dialog

- Screens - Code Options
[X]1 Open Files
I < Edit > [X1 Close Files
k3 [X]1 Define Windous
k2 < Add > [X]1 Release Windous
ks [X1 READ CYCLE
k2 < Remove > [ 1 Multiple READs
ks [ 1 READ NOLOCK
3 < Arrange > [ 1 Modal
[ 1 Assoc. Windous...

- Screen Code
< Output File... > < Comment O
C :NFOXPROZ5\TUTOR IALNCELLAR . SPR

tions... >

Generate
Push
Button

« Generate » < Cancel >

Figure 13: Generate Dialog
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To see the results of your screen, close the Screen Design window and
execute the program CELLAR.SPR.

Doing CELLAR.SPR
1. Close CELLAR.SCX.

2. Choose Do... from the Program menu. The Do dialog
appears. (Figure 14)

3. Select CELLAR.SPR and choose Do.

Figure 15 shows the screen you designed. The screen contains informa-
tion from the current record in CELLAR.DBF.
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Do Program File:

[..1
CELLAR. SPR
SESSIONZ. QPR
SESSION3. QPR
SESSION4. QPR
SESSIONS. QPR
STEP1. QPR
STEPZ. QPR
STEP3. QPR

[ 1All Files

Drive

| < ]
TUTORIAL ﬂ

<« Do »

Directory

< Cancel >

Figure 14: Do Dialog

Wine Collecting Is My Hobby

Winery OFEEGL Origin
Type (MEXSWConcord Grape Rating
Value 3.59 Date

Cost 3.59

Comments This was a gift from Bert.

Corked IRZG
Purchased (Yg¥ig}l
Consumed RZENY

Figure 15: Screen with Fields from CELLAR.DBF
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As it stands, you can only use the screen to look at one record. Let’s
modify the screen so that it is more flexible.

Opening an Existing Screen
1. Press Escape to remove the screen from your monitor.

2. Choose Open... from the File menu and make sure
Screen is showing on the Type popup control.

3. Select CELLAR.SCX then choose Open. CELLAR.SCX ap-
pears as in Figure 16.
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CELLAR. SCX
Move
ine Collecting Is My Hobby

Type

-V :R10: pualue)
Cost EHEIS SN

Comments 11! commMents.........oovvvvnnevnennnnn. [

R

Figure 16: CELLAR.SCX
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It might be useful to have your screen display the amount of money that
you would make if you sold a bottle of wine. This amount can be calcu-
lated by subtracting the cost from the present value.

Create a calculated field to do this arithmetic for you.

Creating a Calculated Field in a Screen

1. Draw a line on the screen under the COST field as shown
in Figure 17.

2. Position the cursor where you want the text “Net” to ap-
pear as shown in Figure 17. Type Net then press
Enter.

3. Using Figure 17 as a guide, position the cursor next to
“Net” where your calculated field will appear.

4. Choose Field... from the Screen menu. The Screen Field
dialog appears.

5. Choose the Say radio button at the top of the Screen
Field dialog.

6. Type CELLAR.PVALUE-CELLAR.COST in the text box
next to Say....

Instead of typing in an expression, you can choose

the Say... push button. This will bring up the Expres-
sion Builder dialog. A detailed discussion of the Ex-
pression Builder can be found in the File Menu chap-
ter of the FoxPro User’s Guide.

7. Choose the Refresh check box (see below).

8. When the dialog appears as in Figure 18, choose OK.

Choosing the Refresh check box will make the calculation field update
itself to show the correct answer. In our example, Refresh is activated
when the database is opened or when you move into that record.
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bbt

DDY

Type

Value [CHIFICIOE
Cost SHECIIS SN

Net [EEEGEINET

£

Figure 17: CELLAR.SCX with Calculated Field

. Field:
Say Radio
Button — [ I ¢ Say > Get <> Edit |

< Say... > OEETNIVINERGIRITNOSE «—— Say Text Box

« OK »
< Forrat.... >
< Cancel >
Range:
[ 1 Upper... [ 1 Lower... |
[ 1 When... [ 1 Error... [ 1 Scroll bar
[ 1 Valid... [ 1 Comment... [ 1 Allou tabs
[ 1 Message... [ 1 Disabled [X] Refresh <———nu-— Refresh

[ Check Box

Figure 18: Screen Field Dialog
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Another useful piece of information is the age of the wine. The age can
be computed by subtracting the date the wine was corked from today’s
date.

When this calculation is performed, FoxPro returns the number of days
between the corked date and today’s date. If you divide this number by
365, you will get the age of the wine in years.

Create this calculated field.

Creating Another Calculated Field

1. Position the cursor where the text “Age (years)” is to ap-
pear on the screen as shown in Figure 19, type Age
(yvears) and press Enter.

2. Position the cursor directly beneath the “Age (years)”
text.

3. Choose Field... from the Screen menu.
4. Choose the Say radio button.

5. Type (DATE () -cellar.dcork) /365 in the Say text box
to determine the age of the wine.

6. Choose the Refresh check box.

7. When the Screen Field dialog appears as shown in
Figure 20, choose OK.
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CELLAR. SCX

ine Collecting Is My Hobby

JU Y type...

[IEAER16: pualue) Date
X3 M3: cost...

Net [VARTIVETSS Purchased S3ilgy

Figure 19: CELLAR.SCX with Another
Calculated Field

Field:
[Aff) Say ¢ > Get C > Edit l
< Say... PA(DATE(> —cellar. dcork) 7365
<« OK »
< Format.... > [
< Cancel >
Range:
[ [ 1 Upper... [ 1 Louwer... I
[ 1 UWhen... [ 1 Error... [ 1 Scroll bar
[ 1 Valid... [ 1Comment... [ 1 Allou tabs
[ ] Message... [ 1 Disabled [X1 Refresh

Figure 20: Screen Field Dialog
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The rating system that you devised for your wines is based on a scale of
1 to 5. It would be easier to remember and rate your wines if these
values were displayed as descriptive text.

Create a popup to accomplish this.

Creating a Popup

1. Delete the RATING field but leave the “Rating” field
title:

e With the keyboard, position the cursor on the
RATING field, press the Spacebar to select it, then
press Delete.

e With the mouse, point to the RATING field and
click then press Delete.

2. Position the cursor directly beneath the “Rating” field
title.

3. Choose Popup... from the Screen menu. The Popup
dialog appears.

4. Choose the Choose... push button. The Choose
Field/Variable dialog appears.

5. Choose Rating from the Database Fields list so that the
Choose a Field or Variable text box appears as in
Figure 21, then choose OK.

6. Type Fatal Septic Nauseating So-so Sublime
Tntense Awesome in the list on the left side of the
Popup dialog as shown in Figure 22.

7. Choose So-so from the Initial popup.

8. When the Popup dialog appears as shown in Figure 22,
choose OK. CELLAR.SCX now contains a popup as
shown in Figure 23.
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Choose a Field or Variable: <varN>
cellar.rating

Database Fields: Memory Variables:
Database:
WINERY c | »_ALIGNMENT | C
TYPE c CELLAR " _BOX L
CLASS C _INDENT N
ORIGIN c _LMARGIN N
DPURCH D _PADUANCE c
DCORK D « OK » _PAGENO N
DCONSUM D _PBPAGE N
»RATING N < Cancel > _PCOLNO N

Figure 21: Choose Field/Variable Dialog

(<> List Popup C D> Array Popup
Choose...
i Variable: | Push Button
¥
: | < choose.”. > EoVETATTSTrI. |
3 |
3 Options: A
t Variable
k3 [ 1 When... [ 1 Comment...
[ 1 Valid... [ 1 Disabled Text Box
143 [ 1 Message... [ 1 1ist Element...
Initial [ 1 # Elements...
Popup
Control
Initial: « OK » < Cancel >

Figure 22: Popup Dialog

CELLAR. SCX

ine Collecting Is My Hobby

U2 type... Rating

'-30NS: pualue. Date | So-so "
[« M8 cost. ..

— Corked HIRINISY
Net Purchased HETITEe fAge (years)

Consumed [N

lIComments 18: comments

Figure 23: CELLAR.SCX with Rating Popup
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To use this new screen, FoxPro must regenerate the program.

We've also provided a screen called CONTROL3.SCX that you can combine
with your screen to allow you to navigate through your database.

Let’s use the screen generator to combine two screens and create a pro-
gram.

Combining Two Screens

1. Choose Generate... from the Program menu. An alert
appears asking if you want to save changes to
CELLAR.SCX. Choose Yes.

2. Choose the Add push button in the Generate dialog. The
Open File dialog appears. (Figure 24)

3. Select CONTROL3.SCX then choose Add. The Generate
dialog appears as in Figure 25.

4. Choose Arrange from the Generate dialog.

5. Using Figure 26 as a guide, arrange the screens on your
monitor.

6. Choose Save from the Arrange menu. The Generate
dialog reappears.

7. Choose Generate. An alert tells you that CELLAR.SPR
already exists and asks if you want to overwrite it.
Choose Yes.
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Select screen file name:
[..1 Drive C H
CELLAR. SCX |
[ CONTROL3_ScX |
Directory | TUTORIAL H

« Add »

< Cancel >
[ 1 All Files

Figure 24: Open File Dialog

r Screens - Code Options
[X]1 Open Files
< Edit > [X] Close Files
[X]1 Define Windous
< Add > [X]1 Release Windous
[X1 READ CYCLE
< Remove > [ 1 Multiple READs
[ 1 READ NOLOCK
< Arrange > [ 1 Modal
[ 1 Assoc. UWindous...

$ CELLAR

k: CONTROL3

LR X R R

- Screen Code

< Output File... > < Comment Options... >
C :\NFOXPROZ5M\TUTOR IALNCELLAR . SPR
« Generate » < Cancel >

Figure 25: Generate Dialog

—Control

'

ine Collecting Is My Hobby

Figure 26: Screen Arrangement

Creating a Screen G11-27



Designing a Custom Input Screen

To use these screens, commonly called a screen set, do the program
CELLAR.SPR.

Doing CELLAR.SPR
1. Close the Screen Design window.

2. Choose Do... from the Program menu.

3. Select CELLAR.SPR and choose Do. The screen set you've
designed appears as in Figure 27.

Note that the windows in Figures 27 and 28 are in slightly different
positions. You can move these windows just like the other windows you
have encountered.

Navigating Through Your Database

1. Choose any of the following push buttons from the
Controls screen to move through CELLAR.DBF: Top,
Prior, Next or Bottom.

2. Choose Append from the Controls screen. A blank input
screen appears so you can add another record to
CELLAR.DBF.

3. Type in the information as shown in Figure 28.

4. To see the effect of this information, use your controls to
move to another record then come back to this record.
Now you can see the calculated results. Choose Quit
from the Controls screen.
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—Controls:

< Top >

{Prior >
ine Collecting Is My Hobby
<hext > |l winery Origin
{Bottom> Type Class Rating
{fippend> Value 3.59 Date
Cost 3.59

< Quit >

_— Corked A4
Net 8.00 Purchased (ZigWigll Age (years)
Consumed [RAENY 0.9
4

Comments This was a gift from Bert.

Figure 27: Screen Set

Controls Screen

Moved Down
—Controls
CTop > Wine Collecting Is My Hobby
Hinery Origin
{Prior >
Type Class Rating
< Next >
Value -5.00 Date Fatal "
{Bottom> Cost 0.00 =
_ Corked (EXEIEE
{fAppend> Net -5.80 Purchased [[LYgalg:t fAge (years)
Consumed RZENZ 3.7
< Quit > 4
Comments This is one of Wilma's best!

Figure 28: Appended Record
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Generating an
Application with FoxApp

In this session, you’ll generate an application using
FoxApp. You'll also learn more about the
Command window.

suoleol|
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Generating an Application with FoxApp

G12-2

In Chapter 10, you created and modified your own database. In the last
chapter you designed an attractive custom screen for your database. In
this chapter you are going to “pull it all together” using FoxApp, the
FoxPro Application Generator.

FoxApp takes a database and a screen and creates an application, or
program, that allows you to manage your database more efficiently. By
using FoxApp to build an application from your database and screen, you
ge(ti a host of added functionality without having to write a single word of
code.

For example, when you execute the CELLAR.SPR program you created in
the last session, your custom screen and a control screen appears. While
you can append new records and navigate through the records via the
control screen, your program lacks functionality such as searching for,
indexing, and deleting records, querying, generating reports, and so on.

When you use FoxApp to generate your application, it automatically
adds a menu system that provides these capabilities and more.

FoxApp is not really part of FoxPro — it’s one of the sample programs
provided to illustrate the flexibility and power of FoxPro. Feel free to
look at and change FoxApp if you desire.

Starting FoxApp

1. Choose Do... from the Program menu. The Do dialog
appears. (Figure 1)

2. Make sure that C shows on the Drive popup control and
FOXPRO25 shows on the Directory popup control.
Select FOXAPP.APP and choose Do. The FoxApp
dialog appears. (Figure 2)
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Do Program File:

[..1] Drive C "
[GOODIES]

[TUTORIAL1]
ADDUSER. APP
DEMO. APP Directory | FOXPROZS ||
FOX. EXE
FOXAPP. APP
FOXL. EXE « Do »
FOXPROL. EXE
< Cancel >

[ 1 All Files

Figure 1: Do Dialog

FoxPro fipplication Generator

Step 1: Create or modify a database

Database name: (Related... >

(Create >  {( Modify > ¢ File List >

Step 2 : Design a screen

Screen name:

(Create > < Modify > < File List >

« Generate »
¢ Advanced >
¢ Cancel >

Figure 2: FoxApp Dialog
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The first step when using FoxApp is to select a database. If the
database does not exist, FoxApp allows you to create it. FoxApp also
allows you to change the structure of a database.

Because the database CELLAR already exists, tell FoxApp to use it.

Using CELLAR.DBF with FoxApp

1. Choose the File List push button in the Step 1 area of the
FoxApp dialog. The Open File dialog appears.
(Figure 3)

2. Make sure TUTORIAL shows on the Directory popup
control. Select CELLAR.DBF then choose Open. The
FoxApp dialog appears as in Figure 4.

When you select your database, FoxApp finds the screen with the same
name and automatically places it in the Screen Name text box in the
FoxApp dialog.

FoxApp is flexible — if an appropriate screen is not available, it allows
you to access the FoxPro Screen Builder so you can design or modify a
screen to use in your application.

Now that you have a database and a screen to work with, tell FoxApp to
generate your application.
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Database name

[..1] Drive C
| ]
CUSTOMER. DBF
DETAIL. DBF
INUOICES. DBF Directory |TUTORIAL "
OFFICES. DBF
PARTS. DBF
SALESMAN. DBF « QOpen »
< Cancel >

[ 1 All Files

Figure 3: Open File Dialog

FoxPro Application Generator

Step 1 Create or modify a database

Database nawe: {Related... >
C: \FOXPROZS\TUTORTALNCELLAR. DEF
(Create )  (Modify > {File List >

Step 2 : Design a screen

Screen name:
C: \FOXPROZS\TUTORIAL\CELLAR. SCX
(Create > (Modify > (File List )

« (enerate »
( Advanced >
¢ Cancel >

Figure 4: FoxApp Dialog with
CELLAR.DBF and CELLAR.SCX
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FoxApp asks you to name your application. In your case, the default is
the name you've already given to your database and screen plus an .APP
extension. This would make an ideal name for the application.

When FoxApp finishes generating your application, a message appears
on your screen telling you to press any key to start your application.

Generating an Application with FoxApp

1. Choose the Generate push button at the bottom of the
FoxApp dialog. The Save As dialog appears with
CELLAR.APP entered in the text box. (Figure 5)

2. Choose Save. FoxApp begins generating your applica-
tion and displays a thermometer indicating its
progress. (Figure 6)
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Name your application:

»L..1] Drive C “
Directory | TUTORIAL “

« Save »

[ 1 All Files < Cancel >

CELLAR. APP

Figure 5: Save As Dialog

System File Edit Database Record Program MWindow

LGenerating application Cellar—l

Generating Screen Code... “

Figure 6: FoxApp’s Message and Thermometer
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Your application consists of an input screen, a control screen and a
menu bar.

Starting Your Application

Press any key. Your application appears as in Figure 7.

The input screen and control screen help you to navigate easily through
your database file.

The System and Edit menus in your application are shortened versions
of FoxPro’s System and Edit menus.
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System Edit Application Utilities

Wine Collecting Is My Hobby
u

inery Aunt Wilma’s Origin grapes?

Type Generic Class Grape Rating

Value -5.080 Date | Fatal ﬂ
Cost a.00
Corked 84-89-/88

Net -5.00 Purchased 85-21/83 Age C(years)
Consumed s 7 3.81

Comments This is one of Aunt Wilma'’s best!

ﬂi( Top > < Prior > < Next > < Bottom > < Search > < Quit )“

Figure 7: Generated Application
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The Application and Utilities menus contain a variety of options, as
shown in Figure 8. These options enable you to perform additional
operations on your database file. You're already familiar with the ac-
tions of many of the options on these menus. The Top, Bottom, Next
and Prior options correspond to the push buttons on the control screen.
Notice that your application allows you to add, copy and delete records
as well as browse your database. You can even create a report or a
query. Your application places all these options at your fingertips!

You’re probably anxious to try your application. Go ahead and use it for
a while. When you're done, follow the steps below.

Applications are simply a series of FoxPro commands that have been
entered into a file. Commands are statements that tell FoxPro what to
do. When FoxApp generated your application, it placed many FoxPro
commands into several files.

Exiting FoxApp

1. Choose the Quit push button on the control screen. An
Application to Run dialog appears.

2. Choose Cancel.

Information about other features of FoxApp is available in the online
help.
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4 o IR
Utilities
Top F2 Construct index
Bottom F3 Pack
Next F4 Status Bar
Prior F5 Clock
Extended video
Add record #Sticky

Copy record
Delete record "D

Brouse "B
Search. .. S
Filter... “F
Order... ~0
Query. .. ~Q
Report... “R
\_ %

Figure 8: Application and Utilities Menu
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Let’s look at one of these files.

If you’re new to FoxPro and its programming language, you’ll probably
find that you don’t understand all the statements in the program file.
That’s normal. With time and practice, you'll become familiar with the
language.

Opening an Application File

1. Choose Open... from the File menu. Make sure
TUTORIAL is showing on the Directory popup control
and Program is showing on the Type popup control.
Select SCAFFOLD.PRG then choose Open. A program
editing window, as shown in Figure 9, appears with
FoxPro code in it.

2. Look at some of the commands.

3. Close the program editing window.
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SELECT @
USE C:N\FOXPROZ5\TUTORIALNCELLAR .DBF
SET ORDER TO 1
ENDIF
IF RECCOUNTO =8
APPEND BLANK
ENDIF
GOTO TOP
CLEAR
DO WHILE ?tbailout
* Display the screen control panel
DO appctrl WITH 22,3
* Display the main screen file
DO cellar. spr
ENDDO
% Clean up after the application
RELEASE ALL LIKE x.x
SET PROCEDURE TO
CLOSE DATABASES
CLEAR ALL

Figure 9: SCAFFOLD.PRG
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A good way to start learning about FoxPro’s programming language is to
observe and try out commands in the Command window.

The Command window keeps track of all the commands you use from
the time you start FoxPro. When you choose a menu option, the
equivalent command is logged in the Command window. You can scroll
through these commands to look at them, or even re-execute them.
Figure 10 shows the Command window as it may appear during a
FoxPro session.

In addition to viewing commands in the Command window, you can also
type commands in it. Everything that you do when you use FoxPro’s
interface can be accomplished by entering commands into the Command
window. For example, typing Quit in the Command window has the
same result as choosing Quit from the File menu.

You can learn more about FoxPro commands by reading the FoxPro
Language Reference. The commands are organized alphabetically and
explained in detail. Each command is also explained in FoxPro’s online
help system.
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Command
SET DEFAULT TO C:\FOXPROZS\FOXAPP
DO C:\FOXPROZ5\FOXAPP\FOXAPP. APP
§ USE C:\FOXPROZ5\TUTORIALN\CUSTOMER. DBF
BROWSE LAST
CHANGE

GO BOTTOM
RECALL ALL

Figure 10: Command Window
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If the Command window isn’t visible, activate it and try out some com-
mands.

Typing Commands in the Command Window

1. If the Command window isn’t visible, choose Command
from the Window menu.

2. Type CLOSE ALL in the Command window then press
Enter.

3. Type CLEAR in the Command window then press Enter.

4. Type USE C:\FOXPRO25\TUTORIAL\CUSTOMER .DBF in
the Command window then press Enter.

5. Type BROWSE in the Command window then press Enter.

At this point, things should look familiar. You issued the USE command
which opened the CUSTOMER database. The BROWSE command you
entered activated the Browse window.

Taking a Look at the Command Window

Close the Browse window. The Command window
appears as shown in Figure 11.

By observing what happens in the Command window when you select
menu options and by trying out commands, you can easily learn many
FoxPro commands.
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Command
CLOSE ALL
CLEAR

USE C:\FOXPROZS\TUTORIAL\CUSTOMER. DBF
BROWSE

Figure 11: Command Window with
Commands You Typed
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Now What?

This session reviews what you've learned and
directs you to other sources so you can continue
to learn about FoxPro.

¢1EYM MON
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Congratulations! You've just been introduced to one of the most power-
ful relational database management systems available. You've learned

to:

Create databases and fill them with data

View data in a Browse window

Extract specific data using RQBE

Create professional reports with the Report Writer
Design custom screens with the Screen Builder

Create a simple application

You can now use FoxPro’s powerful tools to quickly and efficiently
manage your data. But this is just the beginning. FoxPro is a dynamic
and multi-faceted database management system. You can continue your
studies and develop your own custom applications that use all of
FoxPro’s functionality.

There are many places to learn more about FoxPro. The first place to
look is in the remaining FoxPro manuals:

The FoxPro User’s Guide teaches you more about FoxPro’s interface,
including FoxPro’s menus, Report Writer, Label Designer, Screen
Builder, Menu Builder, RQBE and Project Manager.

The FoxPro Language Reference contains FoxPro’s commands, func-
tions and system memory variables, listed alphabetically for easy ac-
cess. It includes examples to demonstrate how to use the language.

The FoxPro Developer’s Guide covers topics of particular interest to
those who develop applications. Topics include tips for using projects,
screens, menus, SQL SELECT, arrays, low-level file I/O, text merge,
FoxDoc and more.

The following additional sources are available:

Classes on FoxPro in your area offered by trainers and local univer-
sities.

Microsoft FoxPro Resource Directory. This book can assist you in
finding consultants and third party FoxPro applications.

FOXFORUM on CompuServe®. Refer to the Product Support chapter
in the FoxPro Installation and Configuration manual for more infor-
mation.

The Microsoft FoxPro Developer Conference. Contact Microsoft for
more information.

Third party FoxPro books.
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* FoxPro user groups.
¢ Database oriented magazines.

As you can see, many options are available for learning more about
FoxPro. You can choose the option that meets your needs.

Good luck!
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MS-DOS and FoxPro

This appendix discusses how to use MS-DOS® to
create and organize FoxPro files on your com-
puter. It is not intended to be an MS-DOS tutorial
— if you are not familiar with MS-DOS, consult
your MS-DOS manual or an MS-DOS book.

® WhatisMS-DOS? .. ... ..... page 2
¢ How Does MS-DOS Organize Files? page 4

DOS and FoxPro
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What is MS-DOS?

A-2

MS-DOS is an acronym for Microsoft Disk Operating System. MS-DOS con-
trols your computer and the devices connected to it (the keyboard,
printers, disk drives and so on).

Your computer uses MS-DOS to create and organize information in the
form of files — all information on your computer is contained in files. A
file can contain a program (like FoxPro), data (like a FoxPro database),
text (created with the FoxPro text editor) and so on.

MS-DOS File Names

When you create a file in FoxPro, you are asked to supply a file name.
Certain MS-DOS rules apply to the file name.

A file name can be from one to eight characters long, and cannot contain
spaces. MS-DOS reserves certain characters for its own use, and these
characters cannot be included in a file name. Reserved characters are:

MS-DOS Reserved Characters

" ? \ /
* + = I
[ ] < >

Any combination of letters, numbers and symbols other than the
reserved characters above can be used in a file name.

MS-DOS File Extensions

In addition to the file name, you can include an optional extension when
naming a file. A file extension is a period followed by one to three char-
acters. The characters you can include in a file extension are the same
as those allowed in a file name. The file extension usually indicates the
file type. For example, FoxPro database files have a .DBF extension and
program files have a .PRG extension.
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The following table lists some of the default file extensions used for
FoxPro files and the corresponding file type.

Extension File Type
.CDX Compound Index
.DBF Database
.FRX Report
.LBX Label
.MNX Menu
PJIX Project
.PRG Program
.QPR Query
.SCX Screen

Special Files

Three special text files affect the operation and performance of FoxPro.
Two of these files, CONFIG.SYS and AUTOEXEC.BAT, are used to configure
your computer. The third, CONFIG.FP, is a file that configures FoxPro
when FoxPro is started. These files and their use by FoxPro are dis-
cussed in greater detail in the FoxPro Installation and Configuration
manual.

The CONFIG.SYS system configuration file is a special file that is read
whenever you turn on your computer. It initializes your computer and
can contain settings that affect FoxPro.

Two settings in your CONFIG.SYS file affect FoxPro: FILES and BUFFERS.
The FILES setting determines how many files can be opened in FoxPro,
and the BUFFERS setting can be adjusted to optimize FoxPro’s perfor-
mance.

The AUTOEXEC.BAT file contains a set of MS-DOS commands that are ex-
ecuted when you turn on your computer. An MS-DOS PATH command can
be included in your AUTOEXEC.BAT file to tell MS-DOS and FoxPro where
to look for files. An MS-DOS SET command can be included to tell FoxPro
where to look for its configuration file.

CONFIG.FP, the FoxPro configuration file, can include a long list of com-
mands that adjust FoxPro to your liking. You can also specify where the
temporary files that FoxPro creates are located. Proper placement of
these temporary files can greatly improve FoxPro’s performance.
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How Does MS-DOS Organize Files?

A4

MS-DOS organizes files by drive and directory.

Disk Drives

Files are stored by your computer on disk. There are two types of disks
— external floppy disks that you insert into your computer, and fixed
disks permanently installed in your computer. During the FoxPro in-
stallation process, FoxPro files contained on a set of floppy disks are
copied onto your computer’s fixed disk. FoxPro then uses the files on
your fixed disk.

Floppy and fixed disks reside in a disk drive. A disk drive is the
mechanical device that writes and reads information to and from a disk.
Disks drives are referenced by a drive letter — a single alphabetic char-
acter used to identify the drive. A and B are usually used to identify
floppy disk drives, and the letters C through Z identify fixed disk drives.
Fixed disks are usually called hard drives.

Specifying the Current Disk Drive

During the installation of FoxPro you may have to specify a current disk
drive. MS-DOS commands act on the current disk drive (when a different
disk drive isn’t specified with the command). You can specify the cur-
rent disk drive from the MS-DOS prompt.

To make a disk drive the current drive, type the drive letter followed by
a colon (:) at the MS-DOS prompt, then press Enter. For example, to
make the A drive the current drive, at the MS-DOS prompt type

A:

and press Enter.

To make the C drive the current drive, at the DOS prompt type
C:

and press Enter.

Disk Drive Directories

A large number of files can be stored on a disk. To organize these files,
a directory can be created to group files together. For example, FoxPro
program files are usually placed in a directory named FOXPRO25.

A directory can contain files and additional directories called
subdirectories. FoxPro tutorial files are placed in a subdirectory named
TUTORIAL.
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Subdirectories can, in turn, contain more subdirectories. This organiza-
tion of directories in other directories creates a tree-like structure. The
main directory is called the root directory, with all other directories
branching from the root directory.

Changing Directories

You can move from directory to directory with the DOS change directory
command, CD. When you move to a directory, it becomes the current
working directory. MS-DOS commands act on the current directory (when
a directory path isn’t included with the command).

To move to the root directory, you can use the MS-DOS command
CD\

To move to another directory, place the directory name immediately
after the CD\ command. For example, to move to the FOXPRO25 direc-
tory, use the command

CD\FOXPRO25

To move to a subdirectory in a directory, place a backslash between the
directory and subdirectory names. For example, to move to the
TUTORIAL subdirectory in the FOXPRO25 directory, use the command

CD\FOXPRO25\TUTORIAL

Creating New Directories

To create a new directory or a subdirectory, use the MS-DOS make direc-
tory command, MD. Before installing FoxPro you can create a directory
to place the FoxPro program files in.

Use CD to move to the directory where you create the new directory or
subdirectory. Issue the command MD followed by the name of the new
directory or subdirectory. The following MS-DOS commands make the
FOXPRO25 directory the current directory, and then create a subdirectory
named EXAMPLES:

CD\FOXPRO25
MD EXAMPLES

When naming directories and subdirectories, you must follow the same
rules that apply when creating file names.
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This glossary includes basic definitions as well as
more technical information.
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acronym - arithmetic operation

B-2

acronym — A word formed from the initial letters of a name or phrase,
such as ROM (from read-only memory).

active window — The frontmost window on the screen, where the next
action will take place. The controls on an active window are visible.

address — (n) A number that specifies the location of a single byte of
memory. Addresses can be given as decimal integers or as hexadecimal
integers. (v) The act of referring to a specific storage location.

aggregate function — In SQL, SUM( ), AVG( ), MIN( ), MAX( ), COUNT( ), NPV(),
STD( ), VAR().

alert — A warning or report of an error in the form of an alert, a sound
from the computer’s speaker, or both.

algorithm — A step-by-step procedure for solving a problem or accomplish-
ing a task.

alias — An additional name assigned to a database. A database can be
referenced by its alias and the work area it is opened in.

AND — A logical operator that produces a true result if both of its
operands are true, and a false result if either or both of its operands are
false. See also: OR, NOT.

APl — An acronym for Application Program Interface. FoxPro’s API al-
lows your C and assembly language routines to interact with FoxPro.

application program — A program written for some specific purpose such
as word processing, database management, graphics, telecommunication
or accounting.

argument — A value on which a function or statement operates. It can be
a number or a variable. For example, in the FoxPro statement
SPACE(10), the number 10 is the argument. See also: operand.

arithmetic expression — A combination of numbers and arithmetic
operators (such as 3 + 5) that indicates an operation to be carried out.

arithmetic operation — One of the five actions computers can perform
with numbers: addition, subtraction, multiplication, division and ex-
ponentiation.
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arithmetic operator — An operator, such as +, that manipulates numeric
values to produce a numeric result. See also: logical operator, relational
operator.

array — An ordered collection of data. Each element of the array can be
referenced by a numerical subscript.

ASCIl — Acronym for American Standard Code for Information Inter-
change, pronounced “ASK-ee”. It’s a code in which the numbers from 0
to 127 stand for text characters. ASCII code is used for representing text
inside a computer and for transmitting text between computers or be-
tween a computer and a peripheral device.

assembly language — A low-level programming language in which in-
dividual machine language instructions are written in a symbolic form
that’s easier to understand than machine language itself. Each assembly
language instruction produces one machine language instruction. See
also: machine language.

auto indent — A choice in the Preferences dialog which automatically in-
dents a line by the same amount as the previous line.

average — An internal computation that returns the arithmetic mean for
the name field or expression.

back up — (v) To make a spare copy of a disk or of a file, on a disk.
Backing up your files and disks ensures that you won’t lose information
if the original is lost or damaged. (n) A copy of a disk or of a file on a
disk. It’s a good idea to back up all of your important disks and to use
the copies for everyday work, keeping the originals in a safe place.

band — An area in report that can contain text, database fields, calcu-
lated values, or user-defined functions as well as lines and boxes.
Several different types of bands appear in a report.

basic optimizable expression — A basic optimizable expression can form
an entire expression or can appear as part of an expression. The rules for
combining basic optimizable expressions appear in the FoxPro Language
Reference.

batch file — A batch file contains commands that control the operation of
the computer. These commands take the place of input from the key-
board. Batch files have the extension “.BAT”.
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body — The statements or instructions that make up a part of a program,
such as a loop or a subroutine.

Boolean operator — An operator, such as AND, that combines logical
values to produce a logical result, such as true or false. It is also known
as a logical operator. See also: arithmetic operator, operator, relational
operator.

branch — (v) To pass program control to a line or statement other than
the next in sequence. (n) A statement that performs a branch. See also:
conditional branch, unconditional branch.

breakpoint — A breakpoint causes execution to pause and returns control
temporarily to you.

browse — To display data in a Browse window.

buffer — A holding area of the computer’s memory where information can
be stored by one program or device and then read at a different rate by
another. In editing, it is an area in memory where cut or copied data is
held, sometimes called the clipboard. See also: clipboard, type-ahead
buffer.

bug — An error in a program that causes it not to work as intended.

byte — A unit of information consisting of a fixed number of bits. On
many systems, one byte consists of a series of eight bits, and a byte can
represent any value between 0 and 255. The bit sequence represents an
instruction, letter, number, punctuation mark, or other character. See
also: kilobyte, megabyte.

calculated value — A value that is the result of an expression or calcula-
tion. A formula can consist of database fields, constants, and/or functions
connected by operators.

called program — A routine, UDF or procedure that is executed.

calling program — A program that executes the called routine, UDF or
procedure.

cancel — To stop execution of a command file and return control to
FoxPro.

Glossary



case-sensitive - cleanup code

case-sensitive — Able to distinguish between upper-case characters and
lower-case characters. Programming languages are case-sensitive if they
require all upper-case letters, all lower-case letters, or proper use of
upper-case and lower-case letters.

character — Any symbol that has a widely understood meaning. Letters,
numbers and punctuation are characters that can be displayed on the
monitor and printed on a printer. See also: control character.

character code — A number used to represent a character for processing
by a computer system.

character expression — A collection of character data that’s treated as a
unit.

character field — A field, with a maximum width of 254, that may include
all keyboard characters (letters, numbers and punctuation symbols) and
any graphic (box-drawing), foreign alphabet and special symbol charac-
ters.

character limit — The maximum number of characters allowed in a single
command.

character pitch — The number of characters per inch printed along a
horizontal line.

character set — The entire set of characters that can be either shown on
a monitor or used in printed output. With a printer, it’s the entire set of
characters that the printer is capable of printing.

character style — A set of attributes, such as bold, italic and underline,
which can be applied to a character set.

check box — A pair of square brackets followed by text. Settings can be
turned on and off by choosing the check box. If a check box has an X in
it, the setting is on.

choose — To select a command or an option from a menu, or a control in
a dialog.

clause — An additional statement that follows a command or function key
word.

cleanup code — Code that is executed after the menu definition code and
may contain code snippets for procedures.
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click — Press and release the mouse button once.

click on — To position the mouse pointer on something, then press and
release the mouse button.

clipboard — The holding place for what you last cut or copied; a buffer
area in memory. Information contained on the clipboard can be inserted
(pasted) into other documents.

close — To make a window or file disappear from the screen so that it
can’t be accessed until reopened.

code — (1) A number or symbol used to represent some piece of informa-
tion. (2) The statements or instructions that make up a program.

code snippets — A code snippet is a procedure or an expression as-
sociated with a specific menu pad, menu or menu option. You can also
define code snippets that perform actions on the entire menu system.

color pair — A foreground and background color combination. A variety
of these combinations are available for you to choose from the color
palette of the Color Picker dialog.

color palette — The color palette is part of the Color Picker dialog and
contains color pairs — background and foreground color combinations —
which you can choose for each radio button.

color scheme — A defined group of color pairs that can be specified using
the radio buttons in the Color Picker dialog.

color set — A group of color schemes that determines how FoxPro will
assign colors to objects. Different color sets can be defined for
monochrome, CGA and VGA monitors. Users may also want to define
color sets to make the interface more aesthetically pleasing.

column — The vertical arrangement of character cells on the display
screen.

command — An instruction that causes the computer to perform some
action. A command can be typed from a keyboard, selected from a menu
with a hand-held device (such as a mouse), or embedded in a program.

command condition — Specifies the set of database records to which a
For or While clause applies.
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command key word — A portion of a command that is English-like and
describes the action that will occur.

command scope — A condition that specifies the general set of database
records to which a command applies.

compact single entry index — An index file limited to one index entry.
This index file must be explicitly opened and be active to be updated
with a database. The compact single entry index has an “.IDX” file exten-
sion.

compiler — A language translator that converts a program written
in a high-level programming language (source code) into an equivalent
program in some lower-level language such as machine language (object
code) for later execution.

compiler directive — One or more commands used in a program to alter
the action of a compiler.

compound index file — An index file containing multiple index entries,
called tags. This file has a “.CDX” file extension.

concatenate — Means literally, to chain together. It involves combining
two or more strings into a single, longer string by joining the beginning
of one to the end of the other. It also refers to combining two or more
files.

conditional branch — A branch whose execution depends on the truth of
a condition or the value of an expression. See also: unconditional branch.

configuration — (1) The total combination of hardware components —
central processing unit, video display device, keyboard, and peripheral
devices — that makes up a computer system. (2) The software settings
that allow various hardware components of a computer system to com-
municate with each other. (3) Software settings used to customize an
application. :

constant — In a program, a symbol that represents a fixed, unchanging
value. See also: variable.

context-sensitive — Able to perceive the situation in which an event oc-
curs. For example, an application program might present help informa-
tion specific to the particular task youre performing, rather than a
general list of commands; such help would be context-sensitive.
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control — A push button, check box, radio button, popup control, list or
text box in a dialog that is used to designate, confirm or cancel actions.

control break — (1) An expression that defines the contents of a group in
a report. (2) A term used to stop the execution of a program or routine.

control character — A nonprinting character that controls or modifies the
way information is printed or displayed. Control characters have ASCII
values between 0 and 31. Typically, control characters are typed from a
keyboard by holding down the Ctrl key while pressing some other key.

control code — One or more nonprinting characters included in a text file
whose function is to change the way a printer prints the text. For ex-
ample, a program may use certain control codes to turn boldface printing
on and off.

control key — A general term for a key that controls the operation of
other keys (e.g., Alt, Capslock, Ctrl and Shift). When you hold down or
engage a control key while pressing another key, the combination makes
the other key behave differently.

Control key — A specific key that produces control characters when used
in combination with character keys, usually abbreviated Ctrl.

control key shortcuts — The keystroke combinations that you can use in-
stead of choosing menu options.

controlling database — When databases are related, the controlling
database controls the order in which the records in other databases are
accessed.

coordinate — One of a pair of numbers that designates a position on the
screen. The numbers correspond to the columns (vertical placement) and
rows (horizontal placement) of the screen display.

copy — To make a copy of selected text or objects and place it on the
clipboard, leaving the original selection intact.

count — An internal computation that returns the number of records dis-
played in a given portion of a report.

cursor — A symbol on the screen that marks where the user’s next action
will occur or where the next character typed from the keyboard will ap-
pear.
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cut — To delete selected text or objects but place a copy of the selection on
the clipboard.

data — Facts, figures, values, and other materials that are used or
operated on by a program. The smallest unit of data that a computer can
understand is a bit.

database — A collection of information that is organized into records and
fields so that it can be readily manipulated and sorted by a computer
user.

database management system (DBMS) — A software system for organiz-
ing, storing, retrieving, analyzing and modifying information in a
database.

database field — Any data item contained in a database record. One or
more fields make up a database record, and one or more records make up
a database file.

data format — The form in which data is stored, manipulated or trans-
ferred.

data grouping — Categorizing data in groups in a report corresponding to
a specified order. Headers and footers can be defined to print every time
the value for a group changes.

data type — One of the six different types of data in FoxPro including
character, numeric, float, logical, date and memo.

date field — A field, with a length of eight, used for dates in the format of
month (MM), day (DD) and year (YY) and two separators.

debug — To locate and correct an error, problem or malfunction in a com-
puter program. Usually synonymous with troubleshoot. See also: bug.

default — A preset response to a question or prompt. The default is auto-
matically used by the computer if you don’t supply a different response.
Default values prevent a program from stalling or crashing if no value is
supplied by the user.

default button — The push button in dialogs, enclosed by double angle
brackets, that is chosen when you press Ctrl+Enter.
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delete — To remove a character or word from a file, or a file from a disk.
Keys such as the Backspace key and the Delete key erase one character
at a time.

Delete key — A key that erases the character on which the cursor is pos-
tioned.

delimiter — A character that marks the beginning or end of a sequence of
characters and is not considered part of the sequence itself. For example,
the double quotation mark (") is one delimiter for string constants — the
string “DOG” consists of the three characters D, O, and G, and does not
include the quotation marks.

deselect — To remove the highlighting.

desk accessories — Generally useful items such as a calculator, calen-
dar, ASCII chart, file and directory manager, etc., that are listed on the
System menu.

desktop — The screen that underlies all system and user-defined win-
dows is sometimes called the desktop.

destination — When you are making a copy of a file, the destination is
the location you are copying to. See also: source.

detail band — An area of the report that typically contains one or more
lines for each record that is printed from the database.

dialog — A box that contains a message requesting more information to
complete a command or an expression.

dimension — The maximum size of an array.

directory — A list of the contents of a directory, subdirectory or a disk.
It’s a file that contains a list of all the names and locations of other files
stored on a disk. These other files may themselves be directories (called
subdirectories).

disable — To make a control (or part of it) unavailable for use, you can
disable it. Disabled items appear dimmed and cannot be chosen.

Disk Operating System (DOS) — The software system that enables the
computer to control and communicate with disk drives and other
peripherals.
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disk space — The amount of space available on a disk for storing or
processing a document or an application.

dock — The act of minimizing a window and placing it in the lower right
corner of the screen.

double-click — To position the mouse cursor where you want an action to
take place, and then to press and release the mouse button twice in quick
succession without moving the mouse.

double-click drag — To double-click without releasing the mouse button
on the second click, and continue holding down the mouse button while
you drag.

drag — To position the pointer, press and hold down the mouse button,
move the mouse and then release the mouse button.

edit — To change or modify. Editing includes inserting, removing, replac-
ing or changing text.

editor — A program that helps you create and edit a particular form of
information. FoxPro has a built-in text editor.

element — A member of a set or collection; specifically, one of the in-
dividual cells or elements that make-up an array.

embedded — Contained within. For example, the string “WEST COAST” is
said to contain one embedded space.

emulate — To operate in a way identical to a different system.
enabled — Available to be acted upon (a control).

end-of-line character — A control character indicating that the preceding
text constitutes a complete line.

error code — A number or other symbol representing a type of error.

error message — A message displayed or printed to tell you about an
error or problem in the execution of a program or in your communication
with the system. An error message is often accompanied by a beep.
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escape character — An ASCII character that, with many programs and
devices, allows you to perform special functions when used in combina-
tion with other keys.

Escape key — A key that generates the escape character. The Escape
key is labeled Esc on the keyboard. In many applications, pressing Esc
allows you to return to a previous menu or to stop a procedure.

event-driven — Instead of having to follow a rigid sequence determined by
a program, the sequence of actions is determined by the user, for the
most part. The computer responds to you instead of making you respond
to it.

execute — To perform the actions specified by a program command or
sequence of commands.

expression — A number, variable, word or group of words that can be
evaluated using operators and functions to form a new value (of charac-
ter, numeric, logical, float or date type).

expression list — One or more expressions separated by commas.

Expression Builder — The Expression Builder is a dialog that contains
menus, field names and variables from the active database(s), and an
area where an expression appears as you are building it.

field — A particular type or category of information in a database file.
One or more fields make a record.

field object — An object in a report or screen that draws its definition
from a database field or memory variable.

file — Any named, ordered collection of information stored on a disk. Ap-
plication programs and operating systems on disks are examples of files.
You make a file when you create text or other data, give the material a
name, and save it to disk.

file name — The name that identifies a filee. The maximum character
length of a file name and the rules for naming a file vary under different
operating systems. See also: path name.

file type — The categories of files specified by FoxPro extensions: .APP,
.DBF, .PRG, .CDX, .FRX, etc.
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flag — A variable whose value (usually 1 or 0, standing for true or false)
indicates whether some condition holds or whether some event has oc-
curred. A flag is used to control the program’s actions at some later
time.

floating-point notation — A method of representing numbers inside the
computer in which the decimal point (more correctly, the binary point) is
permitted to float to different positions within the number. Some of the
bits within the number itself are used to keep track of the point’s posi-
tion.

font — (1) In typography, a complete set of type in one size and style of
character. (2) In computer usage, a collection of letters, numbers,
punctuation marks, and other typographical symbols with a consistent
appearance; the size can be changed readily.

font size — The size of a font of characters in points. Examples of font
size are 12 point and 18 point.

format — (1) The form in which information is organized or presented. (2)
The general shape and appearance of a printed page, including page size,
character width and spacing, line spacing, and so on.

form feed — An ASCII control character (decimal 12) that causes a printer
or other paper handling device to advance to the top of the next page.

function — A preprogrammed calculation that can be carried out on re-
quest from any point in a FoxPro program. Because a function takes in
one or more arguments and returns a single value, it can be embedded in
an expression.

generated code — Code created by GENSCRN, the FoxPro screen gener-
ator or GENMENU, the FoxPro menu generator. Generated screen
programs have an .SPR extension and generated menu programs have an
.MPR extension. These programs are for debugging purposes and should
not be directly edited.

generated name — A unique name generated by SYS(2015). These names
are inserted in generated programs with corresponding clauses and code
snippets.

generator directive — A command that communicates solely with
GENSCRN, the FoxPro screen generator.

graphic object — Lines and boxes used in reports and screens.
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group band — A group consists of fields that appear together based on
some criteria that you specify by choosing the Data Grouping... option on
the Report menu.

group footer — Report band in which objects can be defined to print each
time a group expression changes. Group footers usually contain calcu-
lated values for data in the group.

group header — Report band in which objects can be defined to print
each time a group expression changes. Group headers usually contain
information to preface the data that will follow.

group objects — Combining two or more objects in a report or screen so
that they act as one object to be moved, copied and pasted.

hide — To make a window invisible without closing it.

high bit ASCII characters — These ASCII characters have decimal values
of 128 to 255. They are called high ASCII because their high bit (first
binary digit) is set to 1 (for on) rather than 0 (for off).

high-level language — A programming language that is relatively easy
for people to understand. A single statement in a high-level language
typically corresponds to several instructions of machine language. See
also: low-level language.

highlight — To make something visually distinct. For example, when you
select a block of text, the selected text is highlighted.

hot key — A highlighted letter that you can type to immediately choose
the desired control in a dialog, display a menu when the menu bar is
activated, or choose a menu option from a displayed menu.

independent IDX — Index files containing one index entry. An inde-
pendent compound index file never has the same name as the database
and will not automatically open with a database.

index — A file containing a list or table of entries that identifies the se-
quence or record ordering of a database file, based on key fields.

indexed database — A database whose entries have been ordered in a
logical sequence.

index key — A file whose entries identify the logical position of data in a
database.
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index variable — A variable whose value changes on each pass through a
loop. It is often called a control variable or a loop variable.

infinite loop — A section of a program that will repeat the same sequence
of actions indefinitely.

initialize — To set to an initial state or value in preparation for some
computation.

input — Information transferred into a computer from some external
source, such as the keyboard, a disk drive or a modem. See also: output.

input/output (//0) — The process by which information is transferred be-
tween the computer’s memory and its keyboard or peripheral devices.

insert — To add a character or portion of text at the cursor position,
shifting the text at the right of the cursor to the right.

insert mode — The default text editing mode in which any character you
type is inserted at the cursor position and the text at the right of the
cursor is shifted to the right.

insertion point — The place in a document where something will be
added.

integer — A whole number in fixed-point form.

interface — The point at which independent systems or diverse groups in-
teract. It consists of the devices, rules or conventions by which one com-
ponent of a system communicates with another. It is also the point of
communication between a person and a computer.

interrupt — A temporary suspension in the execution of a program that
allows the computer to perform some other task, typically in response to
a signal from a peripheral device or another external source.

invisible buttons — Screen controls that are invisible. The behavior of
invisible buttons can be defined in object level clauses for the buttons.

I/0 — See input/output.

join condition — A join condition specifies the relationship between two
databases and is often a field common to both databases, such as a cus-
tomer number or a transaction number.
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K — See kilobyte.
keyboard shortcut — See control key shortcut, hot key.
key field — A field that is used in an index; part of the index key.

key word — A special word or sequence of characters that identifies a
particular type of statement or command, such as RUN, USE, or PRINT.
Key words are sometimes called reserved words because FoxPro reserves
these special words for internal use.

kilobyte (K) — A unit of measurement consisting of 1024 29 bytes. In
this usage, kilo (from the Greek, meaning a thousand) stands for 1024.
Thus, 64K memory equals 65,536 bytes. See also: megabyte.

leading zero — A zero occurring at the beginning of a decimal number. It
is deleted by most computing programs.

line feed — An ASCII control character (decimal 10) that ordinarily causes
a printer or video display to advance to the next line.

line feed pitch — The number of lines printed per vertical inch.

line length — The number of characters that fit on a line, screen or
printed page.

list — To display on a monitor or print on a printer the contents of
memory or of a file.

literal — A character that is entered as a constant part of a format. For
example, the /’s in a date field (8/11/89) are literals.

local — Within the current program module.

local alias — In the SQL SELECT command, the local alias is a temporary
name for a database specified in the FROM clause.

lock — To prevent documents, files or entire disks from being altered.
Files can be locked with software commands. Entire disks can be physi-
cally locked by using a write-protect tab on the disk jacket; in this sense
lock is synonymous with write-protect. See also: unlock.

logical field — A field that accepts only true or false conditions.
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logical operator — An operator, such as AND, that combines logical values
to produce a logical result (true or false); sometimes called a Boolean
operator. See also: arithmetic operator, relational operator.

loop — A section of a program that is executed repeatedly until a limit or
condition is met, such as a variable reaching a specified ending value.

low-level language — A programming language that is relatively close to
the form the computer’s processor can execute directly. One statement in
a low-level language corresponds to a single machine language instruc-
tion. See also: high-level language.

macro substitution — Macro substitution allows memory variables to
replace names. Macro substitution places an ampersand (&) before the
memory variable to tell FoxPro to use the value of the memory variable
as a name. A command or function containing a name expression ex-
ecutes faster than one containing macro substitution; always use a name
expression instead of macro substitution.

main report — The main report follows the report title and consists of the
page header, report body and page footer.

megabyte (MB) — A unit of measurement equal to 1024 kilobytes, or
1,048,576 bytes. See also: kilobyte.

memo field — A memo field includes any letters, numbers and punctua-
tion symbols, any of the graphic (box-drawing), foreign alphabet and spe-
cial symbol characters plus binary image data. The default memo width
is 10 for the purpose of defining the database structure, but there is no
actual size limit other than disk space.

memory — A hardware component of a computer system that can store
information for later retrieval.

memory location — A unit of main memory that is identified by an ad-
dress and can hold a single item of information of a fixed size.

memory-resident — Held continually in memory even while not in use.
For example, DOS is a memory-resident program.
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memory variable — A location in the computer’s memory where data is
stored. You can change the contents of a memory variable but its name
and storage area are reserved for use until you end the FoxPro session or
release the memory variable. Memory variables and their values are lost
unless you save them to disk before exiting FoxPro or shutting off the
computer.

menu — A list of choices presented by a program, from which you can
select an option.

menu bar — A horizontal strip that appears at the top of the screen and
contains menu pads.

menu options — Commands, found on the menu, that perform specific ac-
tions.

menu pads — A word, phrase or icon on the menu bar that designates
one menu. Positioning the cursor on a menu title highlights the title and
display its options below it.

menu — List of related options. When you choose an option from a menu
popup, you are telling FoxPro what action to take.

menu title — The menu pads found on the menu bar.

menu system — The combination of the menu bar, menu pads, menus
and menu options.

microcomputer — A computer whose processor is a microprocessor.

minimize — The act of causing a window to become one line tall by 16
characters wide with the title of the window remaining visible.

modal — A window or dialog that does not allow another window or
dialog to be brought in front of it until that window or dialog is dis-
missed, for example, the Expression Builder dialog.

mouse — A small device you move around on a flat surface next to your
computer. The mouse controls a pointer on the screen. The pointer’s
movements correspond to those of the mouse. You use the pointer to
choose options, to move data, and to draw in graphics programs.
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mouse button — The button(s) on the top of the mouse. In general,
pressing a mouse button initiates some action on whatever is under the
pointer, and releasing the button confirms the action. In FoxPro the left
mouse button is used.

name expression — A name expression substitutes the value of a charac-
ter type memory variable or array element as the name. Name expres-
sions provide flexibility in FoxPro commands and functions.

nested loop — A loop contained within the body of another loop and ex-
ecuted repeatedly during each pass through the outer loop. See also:
loop.

network — A collection of interconnected, individually controlled com-
puters, together with the hardware and software used to connect them.
A network allows users to share data and peripheral devices (such as
printers and storage media), to exchange electronic mail, etc.

non-modal — A window or dialog that allows another window or dialog in
front of it while that window or dialog is opened, for example, the
Command window.

NOT — A unary logical operator that produces a true result if its operand
is false, and a false result if its operand is true. See also: AND, OR

non-procedural — You control the interface by manipulating objects. You
don’t need to type commands.

null — An undefined value. Null is different from zero; zero is a value
just like other numbers, whereas null means no value at all (of the ex-
pected type). A null string does not contain anything. For example, “ ” is
not a null string because it contains a space character; “” represents a
null string. Null is synomous with “empty”.

numeric field — A field for numbers used in calculations such as quan-
tities, prices and credit limits. It can include numbers, a decimal point
and a leading plus or minus sign.

numeric keypad — A calculator-style keypad, either built-in or peripheral,
which you can use to type numbers. The layout of numbers on the
keypad makes it easier and faster to use than the regular keyboard.

object level clause — An @ ... GET clause defined for a specified object in a
screen.
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online — Currently connected to and under the control of the computer.
Used to refer to equipment such as printers and disk drives, information
storage media such as disks, and the information they contain. See also:
off line.

online help — A mini-reference guide, accessible while using FoxPro,
that provides additional information about FoxPro commands and func-
tions.

open — To make available. You open files or documents so you can work
with them.

operand — A value to which an operator is applied; the value on which
an operation code operates. See also: argument.

operating system — A program that organizes the actions of the parts of
the computer and its peripheral devices. See also: Disk Operating Sys-
tem.

operator — A symbol or sequence of characters, such as + or AND, specify-
ing an operation to be performed on one or more values (the operands) to
produce a result. See also: arithmetic operator, logical operator, relation-
al operator.

optimize — To cause something to work as effectively as possible. For
example, optimizing an application means to use code that causes the
application to run as quickly as possible in a given environment.

option — (1) Something chosen or available as a choice; for instance, an
item on a menu. (2) An argument whose provision is optional.

OR - A logical operator that produces a true result if either or both of its
operands are true, and a false result if both of its operands are false. See
also: AND, NOT.

orphaned — Standing alone at the bottom of a page and separated from
information on the next page.

output — Information transferred from a computer to some external des-
tination such as the display screen, a disk drive, a printer, or a modem.
See also: input.

overflow — The condition that exists when an attempt is made to put
more data into a given memory area than it can hold; for example, a
computational result that exceeds the allowed range.
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override — To modify or cancel an instruction by issuing another one.

overwrite mode — A text editing mode in which any character you type
replaces the text under the cursor.

pack — To permanently remove the records in a database that have been
marked for deletion.

page — A window full of information.

page down region — The region on the scroll bar between the down
arrow and the thumb. Clicking in this area causes a window to scroll
through a full page of text at a time.

page footer (PgFoot) — An area that is printed at the bottom of every
page of a report.

page header (PgHead) — An area that is printed at the top of every page
of a report.

page layout — The Page Layout dialog contains all information about
how a report is printed on paper. Top, bottom and side margins, as well
as the number of rows per page, are all part of the page layout.

page up region — The region on the scroll bar between the up arrow and
the thumb. Clicking in this area causes a window to scroll through a full
page of text at a time.

parameter — An argument that determines the outcome of a command.
pass — A single execution of a loop.

pass by reference — When a variable is passed to a user-defined function
(UDF) by reference and the UDF changes the value of the passed variable,
the variable’s original value in the calling program is also changed.

pass by value — When a variable is passed to a user-defined function
(UDF) by value, the variable’s value may be changed by the procedure or
UDF, but the variable’s original value in the calling program is not
changed.

paste — To place the contents of the clipboard at the insertion point.
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path name — The full name by which an operating system identifies a
file. A path name is a sequence of file names, each preceded by a slash,
that specifies the path from device to directory to file that the operating
system takes to locate that file. See also: file name.

point — (1) A unit of measurement for type; 12 points equal 1 pica, and 6
picas equal 1 inch; thus, 1 point equals approximately 1/72 inch. (2) To
position the pointer at a location on the screen. Roll the mouse to place
the pointer on an object.

pointer — (1) A small solid box or arrow on the screen that follows the
movement of the mouse and shows where your next action will take
place. (2) An item of information consisting of the memory address of
some other item; for example, pointers to the most recently stored vari-
able, the most recently typed program line, and the most recently read
data item.

popup — The menu that appears when you choose a popup control in a
dialog.

popup control — A rectangle with double lines on the right and bottom
edges that you can choose to display the associated popup.

position — To place the cursor at a desired location in a window or dialog.

precedence — The prioritized order in which operators are applied
in evaluating an expression.

press — To strike a key and then release it; you hold a key down only if
you want to repeat a character or if you are using a modifier key with
another key.

procedure — A set of instructions that work as a unit. It is the same as a
subroutine.

processor — The hardware component of a computer that performs the
actual computation by directly executing instructions represented in
machine language and stored in main memory. See also: microprocessor.

program — (n) A set of instructions describing actions for a computer to
perform in order to accomplish some task, conforming to the rules and
conventions of a particular programming language. (v) To write a pro-
gram.
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programming language — A set of symbols and associated rules or con-
ventions for writing programs.

project — A project is a special database file that keeps track of all
programs, screens, menus, libraries, reports, labels, queries, format files
and other types of files that are needed to create an application.

projection list — In the SQL SELECT command, the projection list is the
list of database fields, constants and expressions to appear in the query
output.

prompt — A message on the screen that tells you of some need for
response or action. A prompt usually takes the form of a symbol, a mes-
sage, a dialog box or a menu of choices.

push buttons — Key words enclosed in angle brackets. The action as-
sociated with a push button occurs immediately when you choose a push
button unless the it contains an ellipsis (...). The ellipsis indicates that
another dialog will appear.

queue — A list in which entries are added at one end and removed at the
other, causing entries to be removed in first-in, first-out (FIFO) order.

query — A question posed to obtain information. In FoxPro, RQBE and
the SQL SELECT command can be used to query databases.

Rushmore technology — A data access technique that permits sets of
records to be accessed very efficiently, at speeds comparable to single-
record indexed access.

radio button — A set of parentheses followed by text. Radio buttons are
grouped so that only one can be chosen at a time, like the buttons on a
car radio. Choose a radio button to activate it. When a radio button is
chosen, a bullet appears in the parentheses and any previously chosen
radio button becomes deselected.

read — To transfer information into the computer’s memory from an ex-
ternal source (such as a disk drive or modem) or into the computer’s
processor from an external source (such as the keyboard or main
memory).

READ level clause — A READ clause defined for a specific screen.

record — A unit of storage in a database file. Every database file can
contain a large number of records; each record is comprised of fields.

Glossary B-23



related database - RQBE

B-24

related database — A database that is linked to the controlling database.

relation — The link between databases that allows data to be accessed
from more than the currently SELECTed database. The link is based on a
common field or a value (record number).

relational expression — An expression that describes a link between two
databases based on a common field or value.

relational operator — An operator, such as > (greater than), that manipu-
lates numeric and other types of values to produce a logical result. See
also: arithmetic operator, logical operator.

report detail band — The area between the page header and the page
footer, consisting of detail lines based on the records from the selected
database(s).

report footer band — A band in the Report Layout window that contains
the data that will appear at the bottom of a page (page numbers, section,
etc.).

report header band — A band in the Report Layout window that con-
tains information that appears once per page. Typically, items placed in
a page header include a report title, column headings and current date.

report object — Graphic, field or text object in the Report Layout window.
reserved word — A word or sequence of characters reserved by FoxPro for
some special use and therefore unavailable as a variable name in a pro-

gram.

return values — The value returned by a function to the calling program.
A function returns a value. The DATE( ) function returns the system date
from your computer. Functions contain a pair of parentheses that distin-
guish them from commands.

routine — A part of a program that accomplishes some task subordinate
to the overall task of the program. See also: procedure.

row — A horizontal arrangement of character cells on the screen or
printer. See also: column.

RQBE — An acronym for Relational Query By Example. See also: query.

Glossary



run - selection marquee

run — (1) To execute a program. When a program runs, the computer
performs the instructions. (2) To load a program into main memory from
a peripheral storage medium, such as a disk, and execute it.

RUN — A FoxPro command that brings an external program into memory
and runs it.

save — To store information by transferring the information from main
memory to a disk. Work that is not saved disappears when you turn off
the computer or when the power is interrupted.

scientific notation — A method of expressing numbers in terms of powers
of ten, useful for expressing very small or very large numbers. For ex-
ample, 6.02E23 means 6.02 times ten to the 23rd power. (The letter E
stands for exponent.) The number is easier to understand in this form.

screen set — Two or more screens in a file.

scroll — To move through the contents of a window or scrollable list (in a
dialog) so that a different part becomes visible.

scroll bars — The controls that are used to view text that extends beyond
the edge of a window. A window may have a vertical and/or horizontal
scroll bar.

scrollable list — A list of the subdirectories and files under a common
parent directory. The parent directory always appears at the top of the
list.

select — (1) To designate where the next action will take place. To select
using a mouse, you click on or drag across information. You can also
select menu items by typing a letter or number at a prompt, by using a
combination key press, or by using arrow keys. (2) To highlight. Select-
ing prepares something to be chosen.

selection — The information or items that will be affected by the next
command. A selection usually appears highlighted.

selection marquee — Multiple objects can also be selected with the selec-
tion marquee. The selection marquee appears as a dotted line in the
Screen Design window. All objects enclosed in the marquee are selected.
Objects that are partially contained in the marquee are selected as well.
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setup code — Setup code is executed before the menu system is defined
and may include code to open files, declare memory variables, or place
the previous menu system on a stack so it can be retrieved later without
redefining it.

Shift+click — A technique that allows you to extend or shorten a selec-
tion. Position the pointer at the end of what you want to select and hold
down the Shift key while clicking the mouse button.

shortcut — You can use a Control key combination as a shortcut to choose
a menu option without displaying the menu.

size control — Control found on windows that allows you to change the
window size a little at a time.

source — The original, as opposed to the duplicate. When you are
making a copy of a file, the source is the location you are copying from.
See also: destination.

SQL (Structured Query Language) — FoxPro supports Structured Query
Language (SQL) commands. FoxPro’s SQL commands make use of
Rushmore technology to optimize performance, and a single SQL com-
mand may be used to replace multiple FoxPro commands.

string — An item of information consisting of a sequence of text charac-
ters.

string literals — A string literal is a character string surrounded by single
or double quotation mark. For example, "Ohio" or ‘Ohio’.

structural compound index — A structural compound index file, is
created when you include TAG <tag name> without including the optional
OF <.cdx file> clause. Structural CDX files always have the same base
name as the database. A structural compound index file is automatically
opened every time the database is opened.

style — A variation of a font, such as italic, underline, shadow or outline.

subdirectory — A directory within a directory; a file containing the names
and locations of other files.

subroutine — A part of a program that can be executed on request from
another point in the program and that returns control, on completion, to
the point of the request.
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subscript — An index number used to identify a particular element of an
array.

substring — A string that is part of another string.

sum — An internal computation that returns the additive sum of the
values for the named field or expression.

summary band — An area of the report that appears once, at the end of a
report.

syntax — (1) The rules governing the structure of statements or instruc-
tions in a programming language. (2) A representation of a command
that specifies all the possible forms the command can take.

system messages — The boxes that appear in upper right corner of the
screen to present information.

tab — An ASCII character that commands a device such as a printer to
start printing at a preset location (called a tab stop). There are two such
characters: horizontal tab (hex 09) and vertical tab (hex 0B). The
horizontal tab character performs the same action as pressing the Tab
key on a typewriter.

tags — Any of the separate index entries contained in a compound index
file.

tagging — When you select the file(s) that an operation will affect, it is
called tagging. A tagged file appears in the list with a triangle to the left
of its name. You can tag files individually or in groups.

text editor — The part of FoxPro that allows you to create and modify text
and program files.

text file — A file which contains information expressed in text form and
whose contents are interpreted as characters encoded using the ASCII for-
mat. See also: binary file.

text object — Text in screens and reports. Text is usually used to convey
information making the screen or report easier to use.

text window — A window in which text is displayed and scrolled.
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thumb — A diamond shaped object in the scroll bar that indicates the
relative position in the text. If you want to move through the text rapid-
ly you can drag the thumb up and down.

title — The name that appears in the top portion of a window
title band — A report band that prints once at the beginning of the report.

title bar — A horizontal bar across the top of windows that displays the
window title.

Top-of-form command — A command causing a printer to feed paper
until the paper reaches a preset position relative to the top of a single
sheet.

trace — Watch your code as it executes

triple-click — Press and release the mouse button three times in quick
succession.

triple-click drag — To triple-click without releasing the mouse button on
the third click, and continue to hold the button down while you drag.

type-ahead buffer — A buffer that accepts and holds characters that are
typed faster than the computer can process them.

unconditional branch — A branch whose execution does not depend on
the truth of any condition. See also: conditional branch.

unindexed database — A database that does not have an index associated
with it.

unlock — To remove the restriction on the use of a disk or a file so that it
can once again be changed, deleted or renamed. See also: lock.

user — A person operating or controlling a computer system.

user interface — The rules and conventions by which a computer system
communicates with the person operating it.

utilities — Programs which allow you to rename, copy, format, delete and
otherwise manipulate files and volumes.
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utility screen — Screens designed to be used multiple times throughout
an application or in different applications. Utility screens are usually
designed to be independent of the structure and context of a particular
database.

value — An item of information, such as a number or a string, that can be
stored in a variable.

variable — (1) A location in the computer’s memory where a value can be
stored. (2) The symbol used in a program to represent such a location.
See also: constant.

wildcard character — A character that may be used to represent a se-
quence of characters in a pathname. A common wildcard character is the
asterisk (*). As an example, if you request a listing of * TXT files in a
particular appication, you would see a list of all files ending with the
extension TXT.

window — (1) The area that displays information on the screen. You can
open or close a window, move it around on the desktop, and sometimes
change its size, scroll through it, and edit its contents. (2) The portion of
a collection of information (such as a document, picture or worksheet)
that is visible in a viewing area on the display screen.

word wrap — The automatic continuation of text from the end of one line
to the beginning of the next, so that you don’t have to press the Enter
key at the end of each line as you type. If word wrap is set off, the text
you type may extend beyond the edge of the window.

wrap around — An option in the Find/Replace dialog that tells FoxPro to
search for a specified string from your present cursor postion to your
current postion, rather than stopping at the end of the file.

write — To transfer information from the computer to an external destina-
tion (such as a disk drive, printer or modem) or from the computer’s
processor to an external destination (such as main memory).

zoom — To enlarge a window until it fills the screen. When you zoom a
window that already fills the screen, FoxPro shrinks it to its original
size.

zoom control — A window control that you can use to make the window
as big as the screen and to change it back again.
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Generating reports from, 7-4, 9-2

(o)

Opening an application file, 12-12
Ordering query results (RQBE), 5-12

P

Packing a database, 10-16
Page Footer band (Reports), 6-10
Page Header band (Reports), 6-10
Page Preview (Reports), 6-4, 6-8, 8-13
Popup dialog (Screens), 11-25
Popups

Creating, 11-24
Printing a report, 8-30
Programs

Creating, 12-2

Q

Query By Example, Relational (RQBE), 5-2
Quick Report dialog (RQBE), 6-4

Quick Screen (Screens), 11-2

Quick Screen dialog, 11-3

R

Rearranging fields in a Report Form, 8-16
Removing records from a database, 10-16
Report Expression dialog, 8-20
Report Layout window, 7-14, 8-16, 9-8
Reports, 6-2, 9-2

Centering objects, 6-12

Creating, 6-4

Detail band, 6-10, 7-14

Group Footer band, 7-14

Group Header, 7-14

Group Info dialog, 7-12

Moving fields, 6-14, 6-16

Page Footer band, 6-10

Page Header band, 6-10, 7-10

Page Preview, 6-9
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RQBE (Relational Query By Example), 5-2
Display Options dialog, 6-4, 6-7, 7-8
Group By dialog, 8-8
Join Condition dialog, 7-5
Order By dialog, 5-12, 8-10
Quick Report dialog, 6-4, 6-7, 8-13
Select Fields Dialog, 5-6, 8-4
Window, 5-6, 7-4, 9-2
Generating reports with, 6-2, 6-6, 6-20

S

SALESMAN.DBF, 4-18
Saving reports, 8-32
SAY fields (Screens), 11-21
Screen Builder, 11-1
Combining screens, 11-26
Creating calculated fields, 11-20
Creating screens, 11-2
Drawing a line, 11-10
Generating code, 11-14
Popups, 11-24
Quick Screen, 11-2
SAY fields, 11-21
Screen Design window, 11-3, 11-7
Screen Field dialog, 11-13
Screen Layout dialog, 11-5
Screen Sets, 11-28
Window Type dialog, 11-5
Screen sets, 11-28
Scrollable lists, 11-1
Scrolling windows
With mouse or keyboard, 3-6
Searching in a database, 5-18, 5-22
Searching multiple databases
via common fields (RQBE), 7-1
SELECT command (SQL), 8-30
Selecting fields for query
results (RQBE), 5-22
Setup dialog, 10-10
Starting FoxPro, 3-3 - 3-4
Structure dialog, 10-3
SUM( ) function, 8-4
Summary band (Reports), 8-24

Index

T

Text editing, 3-12

Cursor movement, 3-12
Title band (Reports), 8-24
Title/Summary dialog, 8-24

U

Using dialogs (keyboard), 3-8
Using dialogs (mouse), 3-8

W

Window splitter, 4-14
Window Type dialog (Screen Builder), 11-5
Windows

Closing, 3-6

Moving, 3-6

Sizing, 3-6
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